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1 Introduction 

Welcome, and thank you for using Origin!  

Origin is a powerful data analysis and publication-quality graphing software, tailored to the needs of scientists 
and engineers. What sets Origin apart from other applications is the ease with which you can customize and 
automate your data import, analysis, graphing and reporting tasks.  

Customizations can range from simple modifications to a data plot, saved as a graph "template" for later use, 
to customized data analyses which produce publication-quality reports, saved as an Analysis Template. Batch 
plotting and analysis operations are also supported, wherein templates are used for repeat analysis of multiple 
files or datasets.  

We are confident that you will find Origin to be an effective tool for analyzing your data and presenting your 
findings. And to help you get the most from Origin, we offer first-class customer and technical support, 
training and consulting services.  

In this guide, unless otherwise noted, "Origin" will refer to both Origin and OriginPro. OriginPro offers all the 
features of Origin, plus extended analysis tools for Peak Fitting, Surface Fitting, Statistics, Signal Processing 
and Image Handling.  

The purpose of this guide is to try and present a broad overview of Origin's capabilities. We hope that new 
users will find this to be a valuable orientation to the Origin workspace and its primary features. For those who 
are already using Origin, we hope you will find useful information on new features and perhaps learn a thing or 
two about Origin that you had overlooked previously.  

More detailed information is provided in the Origin Help file (Help:Origin from your Origin software's main 
menu) and numerous other learning resources exist. For a complete listing of available resources, see the 
Origin Resources chapter of this guide.  

 
Some things to look for in this guide:  

 

We have added short tutorials to numerous topics throughout this guide. These short 
tutorials are intended to give you a quick introduction to a key Origin feature. These 
tutorials will be marked with this icon.  

 

Also, sprinkled throughout this guide, you'll find tips on using Origin. These tips are 
marked with this icon.  

 Features that are new to this version of Origin will be marked with this icon. 

We like to get feedback from our users on ways to improve and expand Origin's data analysis and graphing 
capabilities. We would love to hear from you. You can find contact information in the Origin Resources chapter 
of this guide.  

http://www.originlab.com/doc/User-Guide/OriginPro
http://www.originlab.com/doc/User-Guide/Resources
http://www.originlab.com/doc/User-Guide/Resources
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2 Installing and Updating Origin 

2.1 Notes for Upgrade Users 

       

The Origin upgrade installs into a new program folder - it does not update a previous version. It is therefore 
not necessary to install or uninstall a previous version of Origin before upgrading.  

After installing your Origin upgrade, you must complete the license management process. When your upgrade 
is launched for the first time, a license dialog will display asking for activation.  

 

Beginning with Origin 2018, the OPJ project file is replaced by the Unicode-compliant 
OPJU project file. The latest version of Origin will still read and write the older OPJ 
format. Origin project files (OPJ files) created in earlier versions of Origin can be 
opened, updated, and saved in your new Origin software as OPJU files. We do not 
recommend opening and working with new project files (either OPJ or OPJU) in older 
versions of Origin, as you may suffer some loss of information or data if a feature is not 
supported in the older version. For more information, see Origin File Types. 

If you have custom Origin files from your previous version, such as graph templates, themes, fitting functions, 
LabTalk Script, or Origin C files, you can transfer them to your new User Files Folder. From the Tools menu, 
select Transfer User Files.  

Lastly, we want to point out that your Origin software has some great new features. For more information on 
key features by version, see the originlab.com/VersionComparison page on our website.  

2.2 Notes for Administrators of Multi-user Packages 

 Instructions for getting started with the multi-seat node-locked and concurrent network packages are 
available on the OriginLab website (originlab.com/GetStarted).  

In addition to the InstallShield setup that runs from the Product DVD, an MSI installer and sample transform 
are available. The MSI installer is ideal for use at multi-user sites, as it can be used to build an Origin 
installation package for distribution. Information on the MSI installer and alternate deployment techniques can 
be found on our website:  

• MSI Installation 

• Silent Install 

• Building an Installation Package 

• Installing Origin on a Remote Access Server such as Windows Terminal Server or Citrix. 

2.3 Installing Origin 

Origin is a Windows application. You can run Origin on an Intel-based Mac if you have installed virtualization 
software and set up a virtual computer running Microsoft Windows. For more information, see the Run Origin 
on a Mac page in the Help Center on the OriginLab website (originlab.com/HelpCenter).  

There are three steps that must be completed to prepare Origin for use:  

• Installation 

• Selecting a User Files Folder 

• License management 

http://www.originlab.com/doc/User-Guide/Origin-File-Types
http://www.originlab.com/doc/Origin-Help/UserFilesFolder
http://www.originlab.com/doc/Origin-Help/FileShare-UserFileTransfer
http://www.originlab.com/VersionComparison
http://www.originlab.com/getstarted
http://originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/Multi-userDeployment/MSIInstall
http://originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/Multi-userDeployment/SilentInstall
http://originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/Multi-userDeployment/BuildanInstallPackage
http://originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/Multi-userDeployment/RemoteAccessServer
http://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter
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Both the Origin upgrade and the newly purchased product install into a new program folder. Origin does not 
overwrite previous versions when upgrading, so your old version continues to function. Likewise, your original 
version does not have to be installed when running the upgrade.  

The startup program that launches when you insert the Origin DVD includes an Origin installation button. If the 
startup program does not automatically run, you can browse the DVD to launch the setup.exe.  

2.3.1 Installing on a 64-bit Computer 

 When installing on a 64-bit computer, you have the option to install 32-bit or 64-bit Origin, or both. The 64-
bit version has much more memory at its disposal, so it will handle larger data sets. See the Support area of 
the OriginLab website (originlab.com/Support) for more information about 32-bit versus 64-bit installations.  

If you install 32-bit only (or 64-bit only), and you later want to install 64-bit (or 32-bit), run the Origin Add or 
Remove Files program located in the Origin program icon folder, or rerun the Origin installer (both require a 
log in account with administrator permissions). When the Origin setup program starts, select the Modify 
option.  

2.3.2 How to Proceed if You Already Have the Origin Evaluation Installed 

If you already have the evaluation version of Origin installed on your computer, you can convert it to the full 
product or upgrade.  

• If you have purchased the Origin package with node-locked license management, open Origin and then 

select Convert Evaluation to Product... from the Help menu. 

• For all other license management packages, run the Origin Add or Remove Files program located in the 

Origin program icon folder, or rerun the Origin installer (both require a log in account with administrator 

permissions). When the Origin setup program starts, select the Modify option and then select Install 

Product (requires serial number). 

2.3.3 How to Correct or Change your Serial Number After you Complete an 
Installation 

If you installed Origin with an incorrect serial number, you can correct it by running the Origin Add or 
Remove Files program located in your Origin program icon folder, or rerun the Origin installer (both require a 
log in account with administrator permissions). When the Origin setup program starts, select the Modify 
option and then click Yes to change your serial number.  

2.4 Selecting a User Files Folder 

After installing Origin, each Windows login user must select a User Files Folder (UFF) at the first Origin 
startup. The UFF is the default location for saving and opening files for that login user.  

Consider these points in selecting your UFF:  

• If you have a mobile computer, it is best to select a location on your computer rather than on your 

network. 

• For non-mobile computers, you can select a location on the computer or on the network, as long as you 

have stable access to the folder.   

• Do not select the same UFF as other Origin users. To learn how to share custom files with other Origin 

users, please see the chapter on Sharing Origin Files, later in this Guide. 

http://originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/DirectInstall
http://www.originlab.com/index.aspx?go=SUPPORT
http://www.originlab.com/doc/Origin-Help/UserFilesFolder
http://www.originlab.com/doc/User-Guide/Sharing-Files


Installing and Updating Origin 

5 

 

If you are upgrading from Origin 2017, you will be prompted to pick a location for a 
new UFF. You must choose a different path from your version 2017 UFF. You will also 
be prompted to transfer the contents of your 2017 UFF and your toolbar and workspace 
configurations. If you initially decline to copy your user files from 2017, you can do so 
by running the Origin software and selecting Tools: Transfer User Files. For more 
information, see Transfer User Files. 

At each Origin startup, Origin will check that your UFF is accessible. If Origin cannot connect to the UFF, you 
will be prompted to select a new folder at startup. Note that you can change your UFF when you are running 
Origin. From the Tools menu, select Options and then click the System Path tab.  

2.5 Licensing Origin 

All Origin packages include license management. The type of license management provided with your package 
is determined at the time of your Origin purchase.  

2.5.1 Node-locked 

 Each Origin computer requires a license to run Origin. The license is obtained from the OriginLab website by 
entering a Product Key in the License Activation dialog when you start Origin. Instructions are provided for 
computers with no internet access.  

2.5.2 Concurrent Network 

Each Origin computer must connect to a FLEXnet license service to run Origin. Your IT department or Origin 
administrator installs a FLEXnet license server provided by OriginLab (available from the Origin DVD), obtains 
a license for this server from the OriginLab website, and then sets up a license service. The license service 
counts and restricts the number of Origin computers that can run concurrently. For more information, see the 
Help Center on the OriginLab website (originlab.com/HelpCenter).  

2.5.3 Dongle 

 A dongle (USB hardware key) is provided with the Origin package and must be present in the computer's USB 
port to run Origin. Dongles are version-specific. The dongle license is installed by Origin.  

2.6 Registering Origin 

 Registering Origin is required to obtain product support from OriginLab and the team of Origin distributors. 
Registration also activates Origin's Check for Updates menu command (Help: Check for Updates), allowing 
you to obtain patch and help file updates directly from your Origin software. In addition, Origin's App Center 
dialog, which provides direct access to Apps and App updates from your Origin software, requires that your 
installation be registered.  

For Node-locked licenses, registration is completed automatically when you enter a Product Key into the 
License Activation dialog box that opens when you start Origin. To verify that you are registered, select About 
Origin from the Help menu. The dialog should display the Registration ID that is assigned to your Origin 
installation.  

http://www.originlab.com/doc/Origin-Help/FileShare-UserFileTransfer
http://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter
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For all other license management packages, open Origin, and then select Register on-line... from the Help 
menu to open the Registration dialog box. Use the Registration dialog to register your Origin installation on 
the Origin website. During this process, a Registration ID is issued. Enter or copy and paste this Registration 
ID into the Registration dialog to complete the process. The About Origin dialog should now display your 
Registration ID.  

2.7 Maintenance 

 Most Origin packages are sold with the first year of maintenance included. Maintenance provides you with free 
Origin upgrades, and may also include priority technical support, discounts on Origin training and consulting 
services, and a home-use license.  

• To check if your Origin package includes maintenance, select the Help menu and then select About 

Origin. If your package includes maintenance, the About Origin dialog will show your maintenance 

expiration date.  

• To learn about the benefits of your maintenance, contact OriginLab or your local Origin distributor. 

• As your maintenance expiration date approaches, Origin will display a maintenance expiration message 

with a link to the OriginLab website to learn how to renew your maintenance. This reminder message 

provides a check box to prevent showing in the future. 

2.8 Service Releases 

 Within an Origin version, OriginLab publishes free service releases (patches). A service release provides bug 
fixes for the current version. All customers are encouraged to apply the service releases. To check if a patch is 
available, select the Check for Updates command from the Help menu. Patches are also available from the 
Support area of the OriginLab website (originlab.com/Support).  

2.9 Upgrading your Origin Version 

OriginLab regularly releases new versions of Origin, adding features and feature improvements based on 
customer input. Customers with maintenance are entitled - and encouraged - to use the most recent Origin 
version. After a new version release, OriginLab and the team of Origin distributors notify maintenance 
customers by email. However, to make sure you receive notification of a new version release, please create an 
account on the OriginLab website (originlab.com) and select the check box in your user profile to receive 
"product updates".  

http://www.originlab.com/index.aspx?go=SUPPORT
http://www.originlab.com/
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2.10 Setting the Origin Display Language 

 Origin packages sold to organizations in a limited number of countries, including Japan, Germany, 
Switzerland, Austria, and Liechtenstein, may support running Origin with English display, or with Japanese or 
German display. To access this language control, select Change Language from the Help menu.  

2.11 System Transfers - Deactivating a License 

    

2.11.1 Node-locked Licenses (Computer ID-based) 

A system transfer is required if you plan to replace your licensed Origin computer with a different computer.  

• If Origin can still be used on your computer: 

Open Origin and then select Deactivate License from the Help menu. After successful deactivation, your 
Computer ID will be removed from OriginLab’s server so that you can install and activate on another 
computer.  

• If your licensed Origin computer is no longer available: 

Complete the "System Transfer Request Form" available from the Support area of the OriginLab website.   

2.11.2 Concurrent Networks 

A system transfer is only required if you need to replace the FLEXnet license server. A system transfer is not 
required when replacing an Origin computer.  

To obtain a replacement FLEXnet server license file, complete the "System Transfer Request Form" available 
from the Support area of the OriginLab website.  

2.11.3 Dongles 

A system transfer is not required when replacing a dongle-managed Origin computer.  

2.12 Uninstalling Origin 

 To uninstall Origin, run the Origin Add or Remove Files program located in the Origin program icon folder, 
or use the Windows Uninstall or change a program tool. In both cases, the Origin Setup program displays 
providing options to Modify, Remove, or Repair. Select the Remove option and complete the wizard as 
prompted.  

The Remove program deletes all folders and files that were installed by the Origin setup program. It also 
deletes folders and keys created by the installer in the Windows registry.  

http://www.originlab.com/restricted/Login.aspx?ReturnUrl=%2frestricted%2fSystem_Transfer.aspx
http://www.originlab.com/restricted/Login.aspx?ReturnUrl=%2frestricted%2fSystem_Transfer.aspx
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3 Origin Resources 

The following tables list key Origin resources available to you. If you purchased Origin from a local distributor, 
your Origin distributor may provide additional resources. Please contact your distributor to learn more.  

3.1 Direct Support Resources for Origin 

 For Information On ...  Go Here  

Technical Support  

• Contact information for OriginLab 

or your Origin Distributor  

• Report a bug 

• Suggest a feature 

originlab.com/Support  

Chat Online  
• Chat online with an OriginLab 

representative 

originlab.com  
 
... and click the Chat icon in the 
upper-right corner  

User Forum  

• Share information with and get 

help from the Origin user 

community 
originlab.com/Forum  

Training and 
Consulting  

• Making optimal use of OriginLab 

products  

• Help in developing custom tools 

for your particular application 

originlab.com/Support  

3.2 Resources Installed with your Origin Software 

    

 For Information On ...  Go Here  

Origin Central  

• Load graphing and analysis 

samples 

• Open recent and autosaved files 

• Find Origin Apps 

• Learning Center for access to 

tutorials, videos, blog and forum 

Help: Origin Central (or press F11)  
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Help Files  
• Online or local (CHM) Help for 

Origin (GUI, Programming) Help: Check for Updates (to 
update Help files)  

Context-sensitive 
Help  

• Control-by-control explanation of 

Origin dialog boxes 

• The dialog box must be open 

• Some dialogs have multiple 

sections/tabs and you may have 

to click on that section/tab to set 

the focus 

Press F1  
 
or  
 

Click in the upper-right corner of 
the dialog box  

Quick Help  
• Problems or questions that arise 

while using Origin 

View: Quick Help 
 
or  
 
Help: Origin: Quick Help  

Tutorials  

• Step-by-step instructions on 

performing many Origin 

operations, from the simple to 

the complex 

Help: Origin : Tutorials  

3.3 Online Resources for Origin 

  

 For Information On ...  Go Here  

Online 
Documentation  

• Product documentation 
originlab.com/Doc  

Help Center  

• Resources list 

• Installation and License 

Documentation 

• Contact Info 

originlab.com/HelpCenter  



Origin Resources 

11 

 For Information On ...  Go Here  

Video Tutorials  
• Help with a wide range of 

Origin's key features originlab.com/Videos  

Webinars  
• Live and recorded webinars 

highlighting key features originlab.com/Webinars  

Origin Blog  
• Blog posts with plenty of 

software tips and tricks blog.originlab.com  

Case Studies  
• How others are using Origin in 

their work originlab.com/CaseStudies  

Graph Gallery  

• Outstanding examples of Origin 

graphs, many of them submitted 

by the Origin community 
originlab.com/GraphGallery  

 

Information on key Origin features often can be found by just doing a quick web 
search. Open a browser and search on phrases such as... "Origin shortcut keys", 
"LabTalk graph legend", or "OriginC NAG functions".  
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4 OriginPro 

  

OriginPro, the professional version of Origin, provides all of the features of Origin, plus additional analysis 
tools and capabilities.  

 

If you don't know which product you have -- Origin or OriginPro -- look to the title 
bar.  

 

If you have already purchased the standard version of Origin, you can upgrade to OriginPro by contacting your 
Origin representative.  

4.1.1 Curve Fitting 

 In addition to Origin's linear and nonlinear curve fitting capabilities, OriginPro includes support for the 
following:  

• Linear fitting with X error. 

• Nonlinear fitting with X and Y errors (orthogonal regression). 

• Fitting with implicit functions (orthogonal distance regression). 

• Fitting Comparison: Fit and rank all functions in a category, compare two models to one dataset or two 

datasets to one model. 

• Global fitting of multiple curves using different functions, with the option of sharing parameters. 

 
For more information, see these web pages: Linear and Polynomial Fitting and Nonlinear Fitting.  

4.1.2 Surface Fitting 

  With OriginPro, you can perform 3D Surface Fitting. Choose from 21 built-in surface fitting models including 
Gauss2D, DoseResponse2D, Exponential2D, and Polynomial2D; or define your own function.  

• Fit worksheet data (XYZ) or matrix data (Z values). 

• Locate and fit multiple peaks using one of several peak identification methods. 

• Automatic peak parameter initialization. 

• Apply constraints and bounds to parameters and fix parameter values.  

• Output parameter and statistical results plus residual curves. 

• Find specific Z values along the fit surface and include them in your output. 

• Option for automatic recalculation of results and saving tool settings to a Theme file for repeat use. 

 
For more information, see this web page: Surface Fitting.  

http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/CurveFitting/LinearAndPolynomialFitting
http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/CurveFitting/NonlinearFitting
http://www.originlab.com/doc/Origin-Help/Fitting-2DSurf
http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/CurveFitting#Surface_Fitting_PRO
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4.1.3 Peak Fitting 

 OriginPro includes the Peak Analyzer tool with support for the following:  

• Peak finding (Local Max, Window Search, 1st Derivative, 2nd Derivative, Residual after 1st Derivative). 

• Detect and subtract baseline (Constant, Dataset, XPS, End Points Weighted, Straight Line, User-Defined, 

None). 

• Fit Peaks with built-in or user-defined functions.  

• Fit individual peaks with different fitting functions. 

• Fit Baseline as part of the peak fitting process (user-defined or built-in functions). 

• Control fit parameters (fix, share, set bounds). 

• Batch peak analysis using a predefined Theme file. 

 
For more information, see this web page: Peak Fitting.  

4.1.4 Statistics 

 OriginPro includes support for advanced statistical analyses in these areas:    

• Descriptive statistics (cross-tabulation, distribution fit, correlation coefficient). 

• ANOVA (one-/two-way repeated measures). 

• Multivariate analysis (principal components, cluster, discriminant/canonical discriminant analyses; partial 

least squares). 

• Survival analysis (Kaplan-Meier, Cox Proportional Hazards, Weibull Fit, test of equality of survival 

functions)  

• Parametric hypothesis tests (two-/pair-sample t-Test on rows, one-/two-sample test for variance, one-

/two-sample proportion test). 

• Nonparametric tests (one-/paired-sample Wilcoxon signed rank, paired-sample sign test, Mann-Whitney, 

two-sample Kolmogorov-Smirnov, Kruskal-Wallis ANOVA, Mood's median test, Friedman ANOVA, support 

for simultaneous tests). 

• Power and sample size (one-/two-/paired-sample t-test, one-/two-proportion test, one-/two-variance test, 

one-way ANOVA). 

• ROC curve analysis. 

 
For more information, see this web page: Statistics.  

4.1.5 Signal Processing 

 In addition to Origin's standard suite of signal processing tools, the following are available in OriginPro:  

• Signal transforms (short-time Fourier analysis, Hilbert transform, 2D FFT/2D IFFT). 

• Filtering (IIR filter design, 2D FFT filter). 

http://www.originlab.com/doc/Origin-Help/PeakAnalyzer
http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/PeakAnalysis#Peak_Fitting_PRO
http://www.originlab.com/index.aspx?go=Products/Origin/Statistics
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• Correlation (2D correlation). 

• Wavelet Analysis (continuous wavelet transform, discrete wavelet transform, inverse discrete wavelet 

transform, multi-scale wavelet decomposition, smoothing, noise removal, 2D wavelet decomposition, 2D 

wavelet reconstruction). 

• Rise-time Gadget (linear search, histogram, largest triangle). 

• Decimation (moving average, finite impulse response). 

• Coherence. 

• Envelope curves (upper and/or lower, smooth during envelope detection). 

 
For more information, see this web page: Signal Processing.  

4.1.6 Gadgets 

 Origin Gadgets provide a quick and easy way to perform exploratory analysis on plotted data. While there are 
specific Gadgets for each analysis, all work by allowing you to graphically and interactively position a region-
of-interest (ROI) object around the data that you wish to analyze. OriginPro includes these additional Gadgets:  

• Cluster Gadget (stats on points inside/outside the ROI; with support for masking, editing, copying and 

deleting points). 

• 2D Integration Gadget (integration on image plot or contour plot from matrix or worksheet data). 

• Rise-time Gadget (analyze rise/fall time of stepped signals). 

 
For more information, see this web page: Exploratory Analysis.  

4.1.7 Image Processing 

 Origin and OriginPro include a collection of easy-to-use image processing tools. OriginPro includes additional 
tools in the following areas:  

• Image adjustments (function lookup table, leveling). 

• Image conversion (dynamic binary, threshold, RGB merge/split, image scale). 

• Spatial filters (user filter). 

• Arithmetic transforms (alpha blend, extract to XYZ, image simple math, math function, morphological 

filter, pixel logic, replace background, subtract background, subtract interpolated background). 

 
For more information, see this web page: Image Processing.  

http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/SignalProcessing
http://www.originlab.com/index.aspx?go=PRODUCTS/Origin#Exploratory_Analysis
http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/ImageProcessing
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4.1.8 Apps 

Many add-on Apps require an OriginPro license to run. Some of these Apps are listed below. OriginPro-only 

Apps will be listed in the Origin File Exchange with a red  symbol beside them.  

• Allan Variance 

• Cyclic Voltammetry 

• Logistic Regression 

• Piecewise Fit 

• Simple pCLAMP Analyzer 

• Advanced pCLAMP Analyzer 

• Piecewise Smooth 

• Chi-Square Test 

• Equivalence Test 

• Sequential Fit 

• Redundancy Analysis 

• 2D Confidence Ellipse 

• 3D Confidence Ellipsoid 

 
For general information on Apps visit www.originlab.com/apps.  

http://www.originlab.com/fileexchange/index.aspx
http://originlab.com/fileExchange/details.aspx?fid=231
http://originlab.com/fileExchange/details.aspx?fid=383
http://www.originlab.com/fileExchange/details.aspx?fid=329
http://www.originlab.com/fileExchange/details.aspx?fid=325
http://www.originlab.com/fileExchange/details.aspx?fid=315
http://originlab.com/fileExchange/details.aspx?fid=357
http://originlab.com/fileExchange/details.aspx?fid=369
http://originlab.com/fileExchange/details.aspx?fid=339
http://originlab.com/fileExchange/details.aspx?fid=375
http://www.originlab.com/fileExchange/details.aspx?fid=321
http://www.originlab.com/fileExchange/details.aspx?fid=372
http://www.originlab.com/fileExchange/details.aspx?fid=365
http://originlab.com/fileExchange/details.aspx?fid=280
http://www.originlab.com/apps
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5 What's New in 2018 

 

5.1 Origin 2018 New Feature Highlights 

1. App Center: Popup window for browsing, adding, updating and requesting or submitting an App. 

Launched from the Add Apps button in the Apps Gallery.  

2. Windows Explorer Previews: Explorer Large or Extra Large icon views display image of graph active 

when file was saved. Windows Explorer Preview pane scrolling of all graphs in the project file. You can now 

view graph windows in your Origin project file in the Windows Explorer preview pane. 

3. Worksheet Cell Formula: Support for cell-level formulas in data rows and User-parameter rows. 

Formulas can include cell references to other sheets/books, operators, built-in functions, variables and 

constants. Responsive to data updates or filter conditions. 

4. New Graph Types: Bridge Charts (MS Excel's "Waterfall"), plus 4D XYZ Surface Plots with Custom 

Boundary, Double-Y Box Charts and Colormapped Line Series graphs.  

5. Graph Annotation and Axis Improvements: Statistics reference lines, Arrowhead option for axis 

begin/end in 2D graphs, easier legend symbol customization, more options for tick label wrapping, buttons 

for for evenly distribute layers/objects horizontally or vertically, total label on stacked column/bar plots, 

proportional scale control across axis breaks, skipping filtered worksheet rows for text-labelled axis, allow 

number of major ticks = 0, no extra space after "/" or "-" when using /(<U>) or -<U> as axis unit, gap 

control for double-Y column plots, leader lines for 3D pie charts labels, lighting effects for 3D wall charts. 

6. Export User-defined Area of Graph Page: Interactively manipulate a rectangular area to define the 

portion of the graph page that you want to export. 

7. Unicode Support: Unicode (UTF-8) and new file formats for project (*.OPJU) and child window and 

template files. Added benefit of reduced file size for Origin projects. 

8. Batch Processing Improvements: Embedded graphs can be pasted or paste-linked to a cell in a 

summary report, generate intermediate book for row in summary sheet, batch process for existing xyz 

data, etc. 

9. Automatic Transfer of User Files on Upgrade: If you are upgrading from Origin 2017, you can opt for 

automatic transfer of User Files from 2017 to 2018. 

10. Miscellaneous Improvements: Default digits control for different analysis, data analysis skip hidden 

columns and plots, auto bound setting for positive-only and negative-only peaks, grouping for stats on 

rows, set Origin as default program to open data files, skip cols on CSV import, new toolbar buttons for 

re-import and clone import, autosave unsaved files. 
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5.2 New Features by Category 

5.2.1 Ease of Use 

Origin Project  

• Support for Unicode (UTF-8) with a new, more efficient project file structure. 

• Support for Windows Explorer previews of graphs contained in new Unicode project files. 

• Increase the maximum number of worksheets, matrix sheets or graph layers from 255 to 

1024. More than 255 sheets/layers requires saving project in new .OPJU format. 

Origin Central  

• Search the Graph Sample tab of Origin Central, using keywords. 

• Load Autosaved project files from Origin Central, even if you have chosen not to save the 

project. The autosaved project will be kept for 7 days (controlled by system variable 

@USKT). Disable/Enable this option from Tools:Options > Open/Close tab. 

Origin Menus  

• File: Export as PDF File menu item added for worksheets. 

• Export: Export Graphs menu item for exporting worksheet-embedded graphs. 

Apps  

• A small collection of pre-installed Apps useful for general scientific work is included with 

your Origin 2018 software. 

• Click the Apps Gallery Add Apps button to open App Center where you can browse, search, 

download, install, or update Origin Apps. 

Graphing  

• Improvement to data point labeling at specified indices only. 

• Color Lists and Palettes: Delete from list or restore via shortcut menu commands. 

• Toolbar buttons for distributing selected objects evenly in the X or Y dimensions. 

Upgrade  

• Option to carry over 2017 workspace layout on first launch. 

• Option to transfer User Files Folder (UFF) contents to new UFF. 

http://www.originlab.com/doc/LabTalk/ref/sys-var-list
http://www.originlab.com/doc/LabTalk/ref/sys-var-list
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5.2.2 Graphing 

New Graph Types  

• Bridge Charts (aka "Waterfall Charts" in Excel) are a type of floating column chart used to 

plot a running total. 

• 4D XYZ with Custom Boundary uses designated color and boundary datasets to modify 3D 

XYZ surface plots.  

• Double-Y Box Charts 

• Colormapped Line Series plots with colors mapped to a palette, color-scale legend. 

Legend Improvements  

• GUI tools add independent symbols 

• Adjust the display properties of line, symbol, color block part of legend. 

Axis  

• Place reference lines on your plot by statistic (mean, median, etc.) for 2D plots or by 

formula for function plots. 

• Arrowheads at axis Begin and End for 2D graph types. 

• More options for wrapping of tick labels. 

• Dataset labeling of axis ticks at specified indices. 

• Plot support for skipping rows of filtered axis label data. 

• Allow number of Major Ticks to be zero. 

• No extra space after "/" or "-" when using "/<U>" or "-<U>" as Unit Display for Axis Title. 

• Proportional scale control across axis breaks. 

Plot Manipulation  

• Toggle the legend's Active Dataset Indicator by legend context menu command or from 

the legendupdate dialog. 

• Scale In tool now remains active until you press the ESC key. 

Graph Customization  

• Leader lines for Pie Chart labels. 

• Gap control between grouped bars (same X) for Double Y column plots. 

• Show "total" label for Stacked Column/Bar Charts. 

• Increment symbol size for each plot in a plot group. 

• Page-level control of decimal separator; useful when publishing to journals with different 

standards. 

http://www.originlab.com/doc/Origin-Help/Options-Dialog-Axis-Tab
http://www.originlab.com/doc/Origin-Help/PD-Dialog-LegendTitles-Tab
http://www.originlab.com/doc/Origin-Help/legendupdate-dlg
http://www.originlab.com/doc/Origin-Help/Axis-DisplayRange-Control
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3D Graphing  

• 3D XYZ surface support for colormapping by a fourth worksheet column. 

• 3D XYZ surface support for custom XY boundary, with or without smoothing. 

• 3D Walls Lighting support. 

5.2.3 Analysis 

• Set default digits for different analysis. 

• Ignore hidden worksheet columns and hidden plots in the graph for Analysis dialogs 

that support choosing all columns or all plots. System variable @AIP has been added to 

restore old behavior. 

• Automatically set Area/Amplitude boundary based on Peak Finding Direction (if + only, 

then boundary is >= 0; if - only, then boundary is <= 0). 

• Improvement to graphic export to include embedded graphs and graph sheets (worksheets 

containing a graph; often used in analysis templates). 

• Grouping by column label row support for Statistics on Rows. 

5.2.4 Import and Export 

• New Reimport and Clone Import toolbar buttons. 

• Set Origin as default program to open data files. 

• More renaming options when importing Excel files. 

• Import dialogs now have a check box for creating a file name User Parameters row on 

import. 

• Support skipping columns in CSV files on import. 

• Partial Import for Excel and CSV files. This feature includes a flexible syntax for including 

or excluding column and row ranges. 

5.2.5 Programming 

• New X-Function wcellfmt added to get or set properties of selected cells. 

• LabTalk string and text functions now operate based on characters and character offsets 

rather than bytes and byte offset. Necessitated by variable length of characters in UTF-8 

encoding. 
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5.2.6 Worksheet 

• Worksheet cell formulas with support for dragging to extend formula to other cells. 

• Renaming of sheet from the Navigate Worksheets dialog. 

• New system variable @WTT allows disabling of worksheet tab tooltip. 

• Increase UNDO operation from 10 to 100. 

5.2.7 New Apps for 2018 

Apps for Origin 2018 Release:  

• New Simple Fit 

• Paired Comparison Plot 

• OPJ Searcher 

• Kernel Density for Polar and Ternary 

• Equation Solver (Pro Only) 

• Global Peak Fit (Pro Only) 

• Composite Spectrum Regression (Pro Only) 

• FFT Examiner (Pro Only) 

• Gage Study (Pro Only) 
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6 The Origin Interface 

6.1 The Origin Workspace 

This chapter contains basic information on navigating the Origin workspace. Long-time Origin users can skim 
this chapter.  
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6.1.1 Windows File Explorer Previews 

 

While not part of the Origin interface, you can use Windows File Explorer (previously 
"Windows Explorer") to preview graphs in a project file.  

 

• Windows Explorer's Large or Extra large icons views (right-click in File Explorer and choose View: 

Large Icons or Extra Large Icons or select from the Explorer View menu) will show an image of the 

last active graph before the project file was saved. 

• Open the Preview Pane (ALT + P) and scroll through all graphs in the project file. 

6.1.2 Origin Menus and Menu Commands 

  

• Context-sensitivity of menu bar and menus: The menu bar and menu commands are context-

sensitive; they change as you change window type (from worksheet to graph to matrix, for instance). 

Only menus pertinent to the active window will display.  

• Menu bitmaps, toolbar buttons and shortcut keys: Some menu commands also have bitmaps that 

display to the left of the command. Additionally, you may see a shortcut key combination listed to the 

right of a menu command. The button bitmap and the shortcut keys indicate alternate ways to access the 

same functionality. 
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• Shortcut menu commands: Many commands are available from shortcut menus. To open a shortcut 

menu, right-click on an Origin object (worksheet window, graph axis, text object, etc.). Only pertinent 

menu commands will show. 

• Collapsible menus: By default, main and shortcut menus in Origin are "collapsed", meaning they display 

an abbreviated set of commands. When you use a menu item which isn't included, it is added to the 

menu. 

• Most frequently used analysis menu commands: Most-recently used menu commands will appear at 

the bottom of the analysis menus (Worksheet, Analysis, Statistics, Image, etc.). This gives you quick 

access to tools when performing repeat operations. 

• Custom Menu Organizer: Since Origin 8.1, Origin users have been able to use the Custom Menu 

Organizer  to add or remove menu items. To learn more, see the chapter Customizing Origin, later in this 

Guide. 

6.1.3 Origin Toolbars 

 Use the Customize Toolbar dialog box (View: Toolbars) to control toolbar display and reset or reinitialize 
toolbars.  

• Customize toolbar button appearance: Use controls on the Options tab of the Customize Toolbars 

dialog box to modify button and toolbar appearance. 

• Dock/Float a toolbar: Toolbars can be undocked and made to float on the workspace. To float a toolbar, 

hover over the left-end of the toolbar. When the pointer becomes a four-headed arrow, drag the toolbar 

off of the toolbar space. To return the toolbar to its former docked position, double-click the toolbar title 

bar.  

• Hide/Show a toolbar: Clicking the Close button on a toolbar removes the toolbar from view. To restore 

a hidden toolbar, open the Customize Toolbars dialog box and select the toolbar. 

• Hide/Show a button: Clicking the tiny arrow at the end of toolbar to turn on/off some buttons on a 

toolbar.  

• Move button location: Alt+drag a button to move it to a new location within or among toolbars. 

Alt+drag to blank workspace to create a new toolbar. Alt+drag a button to child window till X shows to 

remove a button. 

http://www.originlab.com/doc/User-Guide/Customizing-Origin
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6.1.4 Origin Central 

Origin Central is a "startup" dialog intended to give you quick access to key files and support information. 
Origin Central was introduced in Origin 2017 and has been updated for 2018.  

To open the dialog, choose Help: Origin Central or press F11.  

 

• Create a new workbook or matrix book. 

• View and load sample graphs, including sample data and notes on re-creating the graph. 

• Load analysis samples and templates. 

• Quick links to recent Origin files, including Autosaved files†. 

• Browse the Learning Center tab for tutorials and videos. 

• Move files from your previous User Files Folder to your new Folder. 

 

† If you have closed a project without saving your changes, you may be able to recover 
your work if you have Autosave Unsaved Project enabled (default setting in Tools: 
Options > Open/Close tab). Open Origin Central and click on the Projects tab and 
look for your file under Auto Saved Projects. By default, projects are kept for 7 days. 

http://www.originlab.com/doc/Origin-Help/FileShare-UserFileTransfer
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6.1.5 Project Explorer 

Project Explorer (PE) is a tool to help you organize the contents of your Origin project files (OPJ).  

 

Project Explorer is split into two panels. The primary panel shows the OPJ folder structure. The sub-panel 
shows folders and windows in the folder highlighted in the primary panel.  

• Right-lick the PE title bar to display the panels stacked (Vertical Alignment) or side-by-side (Horizontal 

Alignment). 

• Context menus in both panels provide options to delete, hide, print, etc. Menu options vary depending on 

what is selected or where you have right-clicked. 

• Multiple-selection of windows in the sub-panel is supported (press Shift or Ctrl while clicking with your 

mouse). 

• The sub-panel supports differing views of windows: Details (default), List, Small Icons, Large Icons, 

Extra Large Icons.  

• In any view (except "Extra Large Icons"), mousing over a graph window icon shows a preview of the 

graph. Mousing over a matrix or worksheet window shows an optional PE comment:  
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• When displaying windows as Extra Large Icons, the PE sub-panel displays a preview of graph and 

layout windows.  

 

 

To disable PE previews, open the Script Window (Window: Script Window) and type 
one or both of the following, then highlight the text and press Enter:  

@PESS=-1; //turn off graph preview in PE 

@PESH=0; //turn off comments preview in PE 

When you set the value of a system variable using the Script Window, you are altering 
Origin's behavior for the current session only. To set the value of a system variable 
across sessions, see this FAQ.  

 

1. By default, Project Explorer is docked to the left side of the Origin workspace in auto-

hide mode. Mouse over the Project Explorer tab to show the PE window. 

 
2. Click on the "push pin" icon on the PE title bar to pin the window in the docked position.  

3. By default the sub-panel is in Details view. In this view, window metadata such as 

Name, Size and Comments show below these column headings. Right click the 

column header and check Modified. A new column shows. Now, drag column headers 

to reorder them. 

 
4. Select Help: Open Folder: Program Data Folder to open the Program Data folder. 

Browse to \Origin\Central\Graphing folder. Select the file Contour.opj, drag and drop it 

to Origin workspace to open it.  

5. At left side, click Project Explorer tab to expand its two panels. The root folder is 

http://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
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selected in primary panel. The sub-panel shows folders and windows in the root folder. 

Also, in the Origin workspace, you can now see windows in the selected folder.  

 
6. In the primary panel, click the Contour Plot with Vector Overlay folder. All windows 

in this folder now show in the sub-panel and in the Origin workspace. Note that the 

window that is active in the workspace appears in bold type in the PE sub-panel. 

7. Mouse over each window in the PE sub-panel. Different tooltips show for different 

window type: Graph windows show a preview of the graph; Notes windows show the 

contents of the note; Workbook windows show workbook comments if it has. 

8. Single-click the Vector XYAM window in the sub-panel and click in the corresponding 

cell in the Comments column. You can modify the comments by in-place edit. You can 

also right-click on a window or folder and choose Properties... to edit names and 

comments. 

9. Double-click the Contour Data window in the sub-panel to make it the active window. 

Active window is bold in Project Explorer. Double-clicking an active window will hide it 

in the Origin workspace. 

10. Right-click on the Contour Plot with Vector Overlay folder in the primary panel or 

right-click below the window list in the sub-panel and choose New Folder to create a 

new folder. Rename the folder Graphs. Select the graph window Contour Plot with 

Vector Overlay and drag it into the new Graphs folder. 
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11. Right-click the Contour Plot with Vector Overlay graph window in the sub-panel and 

choose Add Shortcut to Favorites from the context menu. The folder Favorites will 

show under the root folder, and the graph window will be listed under it as a shortcut 

item.  

 
12. Click the Contour Plot with Vector Overlay folder again in the primary panel and 

choose Save as Project to save the folder and windows under it as a project on your 

computer.  

13. Choose File: Recent Projects: to load the saved OPJ file. The new project file is 

opened and PE displays the project's folder structure. 
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6.1.6 Apps Gallery and App Center 

 Apps are add-on applications for Origin that perform specific graphing and/or analysis tasks. For Origin 2018, 
we have pre-installed a small set of Apps broadly applicable to science and engineering fields. Many more Apps 
are available. Users can browse for Apps and download and install them from the File Exchange area of the 
OriginLab website. The Apps Gallery displays installed Apps and is docked to the right side of the workspace, 
by default.  

 

 

For Origin 2018, there is a new App Center dialog for browsing, updating or downloading 
new Apps. This new dialog gives you direct acess to all of the Apps on the OriginLab File 
Exchange without you having to open a browser and navigate there. 

 

 
To launch the App Center, click the Add Apps button that appears on all tabs of the Apps 
Gallery, docked at the right-side of your Origin workspace.  

• Installed and up-to-date Apps will appear in the App Center with a green 

check mark beside them.  

http://www.originlab.com/fileexchange
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• Those not installed will appear with a clickable Download and Install icon 

beside them. 

You can also see a list of installed Apps by browsing the Apps Gallery. Click View: Apps to open the Gallery 
if it is not open.  

For more information on Apps, please visit www.originlab.com/apps.  

6.1.7 Object Manager 

 The Object Manager is a dockable panel that opens to the right side of the workspace, by default. Use the 
Object Manager for quick manipulation of graph layers and data plots in the active graph window:  

• Select an element (layer, plot group, data plot or special point) in the Object Manager to select the 

corresponding element in the graph window and vice versa.  

• Hide or show plot elements by clearing or selecting the corresponding check box in the Object Manager. 

 

For additional actions, right-click on an element in the Object Manager panel and choose from the shortcut 
menu:  

• Show or hide plots of the same Long Name. 

• Within a plot group, re-order plots by dragging or by shortcut menu command. 

• Toggle Edit Mode for grouped plots between Dependent and Independent 

• Change plot type. 

• Remove a plot from the graph window (not the same as hiding). 

• Access the Plot Details, Layer Contents and Plot Setup dialog boxes. 

http://originlab.com/index.aspx?go=PRODUCTS&PID=3236
http://www.originlab.com/doc/User-Guide/Graphing
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6.1.8 Origin Child Windows 

• Origin Workbooks: The Origin workbook provides a framework for importing, organizing, analyzing, 

transforming, and plotting your data. The tabbed workbook contains between 1 and 1,024 sheets. Each 

sheet may contain more than 1 million rows and up to 10,000 columns of data. Workbook windows may 

also store annotations, column-based functions, scripts and programmable button objects, LabTalk 

variables and import filters.  

• Origin Matrix Books: Like the worksheet, a matrix sheet is a grid of cells, arranged in rows and 

columns. The primary difference is that in the worksheet, each column is a dataset and each dataset can 

be configured to contain various types of data (text, text & numeric, numeric (double), numeric (int), etc). 

In contrast, the matrix is a single, numerical dataset of Z values, related in the XY plane by row (Y) and 

column (X) index numbers.  

• Graphs: The graph window is the primary container for your data plots. Origin supports over 100 chart 

types, chosen specifically for their applications in various technical fields. Each chart is created using a 

built-in, user-modifiable graph template that can be saved with your custom settings. In addition to data 

plots, the graph may also contain annotations (text and drawing objects) or button objects that, when 

triggered, perform some custom graphing or analysis task. Graph windows can be inserted into worksheet 

cells or "floated" on worksheets (outside the grid) in a workbook window.  

• Function Graphs: The function graph is a specialized graph window that displays a curve described by a 

function. The function graph differs from other Origin graphs in that it is not produced from a dataset of 

discreet values (though you can generate data after plotting).  

• Layout Pages: The layout window allows you to combine and arrange graph and worksheet windows and 

various annotations onto a single "display panel." It is used primarily for creating presentations.  

• Excel workbooks. Excel workbooks can be opened or created in Origin. Workbooks can be saved 

separately or as part of your Origin project file.  

• Notes: The Notes window is a text-only window used for recording analysis procedures, making notes to 

students and colleagues, and cutting and pasting text from other applications. 

Note: For more information on Origin's child windows, see  

Help: Origin: Origin Help > Origin Basics > Elements of the Origin Workspace > Creating a 
Child Window  

Help: Origin: Origin Help > Origin Basics > Elements of the Origin Workspace > Basic Child 
Window Operations  

 
 
To save an Origin child window independently of the Origin project file:  

• Select File: Save Window As... to save active window. File extensions OGW(U), OGG(U), OGM(U) are for 

Origin Workbook, Graph and Matrix windows, respectively. 

• Right click any window title bar and choose Save as... context menu.  

http://www.originlab.com/doc/Origin-Help/Create-ChildWindow
http://www.originlab.com/doc/Origin-Help/Create-ChildWindow
http://www.originlab.com/doc/Origin-Help/Operate-ChildWindow-Basic
http://www.originlab.com/doc/Origin-Help/Operate-ChildWindow-Basic
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Note: To save an Excel window as an external Excel file, right click the Excel window title in Origin and choose 
Save Workbook as... context menu.  

 

Origin 2018 adds Unicode (UTF-8) support for Origin projects, child windows and 
templates. When you save a window file, you will have the option of saving a file with 
or without a "u" appended to the file type (*.opj or *.opju). If you intend to use the file 
only in the latest version of Origin, you should choose the Unicode (appended "u") 
option as it offers some performance advantages. 

 
To open a worksheet, graph, matrix, or notes window that was saved to a file:  

• Select File: Open or click the Open button  on the Standard toolbar to open window files.  

• Select File: Recent Books, File: Recent Graphs to open recently saved workbook and graph window 

files.  

Note: Origin supports window short name, long name and comments and short name must be unique in an 
Origin session. So your window short name will be renamed if such name has already been used. After opening 
a window file, if you then save the project, the window will become part of the current project.  

 
To open an Excel workbook file:  

• Select File: Open Excel menu to open a external Excel file. Or, you can click Import Excel button in the 

Standard toolbar or select File: Import: Excel (XLS, XLSX, XLSM)... from the main menu to import 

the excel file.  

Note: If you choose Open Excel, the Excel file is opened as an Excel workbook, in an Excel session that runs 
inside Origin. It can't access all features of Origin. If you choose Import Excel, the Excel file is imported into 
Origin workbook so all Origin features are available.  

6.1.9 The Command Window and Script Window 

The Command Window can be used to issue LabTalk commands to Origin, to do simple mathematical 
calculations, or to check the value of LabTalk variables. The Command Window maintains a time-stamped 
command history that can be carried over from session to session, and intellisense which provides auto-
completion features when writing x-function command.  

The Command Window is dockable and has two panels. The left-hand panel displays the command history, 
while the right-hand panel provides the command line.  

The Script Window provides some of the same functionality as the Command Window. It lacks some of the 
Command Window's features (no intellisense, no command prompt, no command history) but it is handy for 
issuing LabTalk commands and running Python scripts. The window's Tools menu also opens the LabTalk 
Variables and Functions dialog box where you can view a list of Origin variables, functions, macros, loose 
datasets, etc.  

 
To open the Command Window:  

• Click the Command Window button  on the Standard toolbar. Alternately, select Window: 

Command Window menu or press ALT+3. 
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To open the Script Window:  

• Select Window: Script Window menu or press SHIFT+ALT+3. 

6.1.10 The Status Bar 

 

The  Status Bar is located at the bottom of the Origin workspace. It reports multiple parameters, including:  

• Help messages and tool descriptions.  

• Statistics on the current workbook, matrix or graph selection.  

• Whether the AutoUpdate analysis feature is turned on.  

• The name of the System Theme, if any.  

• Information pertinent to the active window. 

• Angular unit (radians, degrees, or gradians). 

• Tool tips for functions listed in the Set Values F(x) menu. 

Note: You can select what shows in the Status Bar by right-clicking on the Bar and selecting (or clearing) 
items from the context menu. You can copy displayed statistical values by selecting Copy Statistics from 

the context menu. The copied data are TAB separated between quantity and values, with each key value 
pair separated by a CRLF delimiter.  

6.1.11 Smart Hints and the Smart Hint Log 

  

Smart Hints give the user focused advice, pertinent to the task at hand. It's triggered by actions you have 
done. These hints may appear briefly inside a dialog box, as in this example.  
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Alternately, Smart Hints may appear in the lower left corner of the Origin workspace, as in this example.  

 

 
Unless you hover over a Hint, it will quickly fade. You can prevent display of individual Smart Hints by checking 
the "Do not show this message in the future" box.  

Hints are logged for the current Origin session and can be reviewed by clicking the Smart Hint Log tab, 
docked at the edge of the Origin workspace (Note that in-dialog Hints are not logged).  

 

To open (and close) the Smart Hint Log window:  

1. From the Origin menu, select View: Smart Hint Log or press ALT+7. 

To prevent a particular Smart Hint from displaying again in the current session, right-click on the hint in the 
Smart Hint Log window and check Do not show this hint again from the context menu. A message asks you 
to confirm that you do not want to show or log this message.  

To turn off all Smart Hint display in the session, open the Script Window and type the following:  

@SHS = 0; 

To turn on Smart Hint display (including those were individually hidden), type @SHS = 1, and click Help: 
Reactivate All Hints.  

 

You can customize general properties of Smart Hints by setting system variables @SHG 
and @SHO. See the system variable list for details.  

 

When you set the value of a system variable using the Script Window, you are altering 
Origin's behavior for the current session only. To set the value of a system variable 
across sessions, see this FAQ.  

http://www.originlab.com/doc/LabTalk/ref/sys-var-list
http://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
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6.1.12 Code Builder 

Origin's programming language is called Origin C. Origin C's integrated development environment (IDE) is 
called Code Builder. Code Builder provides tools for writing, compiling, and debugging your Origin C 
functions.Origin C, IDE  

To open Code Builder:  

1. From the Origin menu, select View: Code Builder. Alternately, click the Code Builder button on the 

Standard toolbar or press ALT+4. 

6.1.13 Quick Help 

As the name implies, the Quick Help window is intended to provide help with specific Origin tasks.  

To open (and close) the Quick Help window:  

1. From the Origin menu, select View: Quick Help or press ALT+5.  

To use the Quick Help window, start typing in the Find box. Generally speaking, typing in a few keywords 
works best. Like several other Origin tools, the Quick Help window can be floated, docked or set to auto-hide.  

6.1.14 Messages Log 

The Messages Log window shows messages about operations including Output Information, Results and 
Errors. It displays messages that are not sent to the Script Window or the Command Window.  

To open (and close) the Messages Log window:  

1. From the Origin menu, select View: Messages Log or press ALT+6. 

6.1.15 Results Log 

Origin automatically types many analysis and fitting results to the Results Log. Each entry in the Results Log 
includes a date/time stamp, a window name, a numeric stamp which is the Julian day (see Dates below), the 
type of analysis performed, and the results.  

In most cases, when results are reported to the Results Log, it opens automatically. Manually open (or close) 
the Results Log by doing one of the following:  

1. Click the Results Log button on the Standard toolbar. Alternately, from the Origin menu, select 

View: Results Log or press ALT+2.  

 
Right-click in the Results Log to open a shortcut menu with commands to Copy, Print, Clear..., and View 
Results.  

6.1.16 Float, Dock and Auto-Hide Windows 

 There are several Origin windows, which can be floated, docked, auto-hidden, or hidden. These windows 
include Project Explorer, Results Log, Command Window, Messages Log, and Quick Help. This allows 
you to customize your Origin workspace so as to maximize utility and save screen space.  
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6.2 Numbers in Origin 

• Displayed vs. Actual Cell Value: When you import or type your data into a workbook or matrix book, 

Origin uses a combination of user-specified settings to determine how to display the data in each cell. 

What displays is a visual representation of the data value. The actual data values are stored with the full 

precision allowed by the dataset's Data Type (see table below). When you perform calculations, it is the 

actual data values that are used and not the displayed values. 

• Display of Numbers that Exceed Cell Width: If a workbook or matrix book contains data that exceed 

the cell (column) width, Origin displays values as series of pound signs (######). This avoids confusion 

caused by a truncated display of cell values. Pound signs ###### will revert to numbers when you enter 

cell editing mode. 

• Missing Values in the Worksheet: When spreadsheet programs first appeared it was recognized that 

there was a need for a special number that was "not a number" which would - when used in a calculation - 

generate itself. Origin has such a number and its internal value is -1.23456789E-300. Because Origin 

recognizes this value as a special value, it can be used to enter a missing value into a worksheet or matrix 

and it can be used in calculations or scripts (for instance, to return a missing value unless some condition 

is met). Origin displays missing values in a worksheet or matrix sheet as "--". However, you shouldn't 

confuse this display (output) with what you enter as a missing value (input). 

• Decimal, Scientific and Engineering Notation: You can display workbook or matrix book data in 

Decimal:1000, Scientific:1E3, Engineering:1k, and Decimal:1,000 notations. You can manually 

choose from these data display options but you can also pre-define thresholds for automatic display of 

scientific notation. By default, these thresholds are set to 6 (upper) and -3 (lower). 

• Dates and Times in Origin: Origin interprets dates based on the Gregorian Calendar. Origin's 

mathematical system for dates and time is based on Astronomical Julian Day Numbers. This defines 

January 1, -4712 (January 1, 4713 BCE), 12 hours Greenwich Mean Time as zero.  

Note: For more information on numbers, see  

Help: Origin: Origin Help > Origin Basics > Elements of the Origin Workspace > Numbers in 
Origin  

 
Origin workbooks and matrix books support the following Data Types:  

Workbook  Matrix Book  Bytes  Range of Values  

double  double  8  ±1.7E±308 (15 digits)  

real  float  4  ±3.4E±38 (7 digits)  

short  short  2  -32,768 to 32,767  

long  int  4  -2,147,483,648 to 2,147,483,647  
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Workbook  Matrix Book  Bytes  Range of Values  

char  char  1  -128 to 127  

byte  char, unsigned  1  0 to 255  

ushort  short, unsigned  2  0 to 65,535  

ulong  int, unsigned  4  0 to 4,294,967,295  

complex  complex  16  ±1.7E±308 (15 digits), each 8 bytes  

6.3 Topics for Further Reading 

• Project Explorer 

• The Object Manager 

• Finding Data in your Origin Project 

• Basic Child Window Operations 

• Numbers in Origin 

• Dates and Times in Origin 

• FAQ: How do I turn off the collapsible menus and show full menus? 

• Customizing Toolbars 

• Setting Your Preferences 

• The Numeric Format Tab of Tools: Options 

http://www.originlab.com/doc/Origin-Help/Project-Explorer
http://www.originlab.com/doc/Origin-Help/Object-Manager
http://www.originlab.com/doc/Origin-Help/Finding-Project
http://www.originlab.com/doc/Origin-Help/Operate-ChildWindow-Basic
http://www.originlab.com/doc/Origin-Help/Number-in-Origin
http://www.originlab.com/doc/Origin-Help/DateTime-in-Origin
http://www.originlab.com/doc/Quick-Help/collapsible-menu
http://www.originlab.com/doc/Origin-Help/Customize-Toolbars
http://www.originlab.com/doc/Origin-Help/Tool-Option-DIalog
http://www.originlab.com/doc/Origin-Help/Options-Dialog-NumFormat-Tab
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7 Origin File Types 

7.1 Roundup of Origin File Types 

  

 

A series of Unicode-compliant (UTF-8) file types has been added for Origin 2018. Long-
time users will recognize that some of the old familiar file types now have a Unicode 
counterpart, denoted by an appended 'u' (e.g. *.opj => *.opju). Origin 2018 will read 
and write the older, non-Unicode file types. As the default is to save to Unicode-type 
files, be sure to set the Save as type drop-down when saving to the older file types. 

  

File Type  File Extension  Used As  

Origin Project 
Files  *.opj(u)  A container for all data.  

Child Window 
Files  *.ogw(u);*.ogg(u);*.ogm(u);*.txt  The child windows for workbooks (.ogw(u)), graph 

(.ogg(u)), matrix(.ogm(u)), notes (.txt).  

Template 
Files  *.otp(u);*.otw(u);*.otm(u)  

A stored customizable suite of data-handling and 
format options: graphs(.otp(u)), worksheets (.otw(u)), 
matrix(.otm(u)).  

Theme Files  *.oth;*.ois;*.odt;*.ofp;  

A saved suite of user-defined settings with multiple 
applications in Origin. A *.oth file applies to a 
graph/worksheet/matrix sheet/report table; A *.ois 
applies to analyses and dialogs; A *.odt applies to 
dialogs; A *.ofp applies to function plots.  

Import Filter 
Files  *.oif  An external file which handles basic import file 

parsing and data extraction.  

Fitting 
Function Files  *.fdf  A fitting function definition file.  

LabTalk Script 
Files  *.ogs  A text file organized in sections of LabTalk script.  

Origin C Files  *.c;*.cpp;*.h;.etc  A file used for developing Origin C programs.  

X-Function 
Files  *.oxf;*.xfc;  An Origin tool with a flexible mechanism for 

performing a wide variety of data manipulation tasks.  
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File Type  File Extension  Used As  

Origin 
Package Files  *.opx  A package file created for distributing custom 

applications.  

Origin Menu 
Files  *.xml;*omc;  

A file that contains Origin menu information. An *.xml 
can be edited outside of Origin for menu 
customization purposes. An *.omc file contains the 
configuration of customized menus.  

Initialization 
Files  *.ini  A file that controls the configuration of some Origin 

features on startup.  

Configuration 
Files  *.cnf  A text file that contains LabTalk script commands.  

Custom Plot 
Symbols  origin.uds  A binary file that holds the bitmap images of custom 

symbols.  

7.2 Topics for Further Reading 

• Opening, Closing and Backing Up the Origin Project File 

• Protecting Origin Projects 

• Origin Template Files 

• The Theme Organizer 

• System Themes 

• Import Wizard, Save Filters Page 

• Origin Fitting Functions, the Fitting Function Organizer and the Fitting Function Builder 

• OGS Files and Getting Started with LabTalk 

• Running LabTalk Script from OGS Files 

• Using X-Functions in LabTalk 

• Packaging Multiple Files as an OPX File 

http://www.originlab.com/doc/Origin-Help/OPJ-Open-Close-Backup
http://www.originlab.com/doc/Origin-Help/OPJ-Protect
http://www.originlab.com/doc/Origin-Help/OFileType-Template
http://www.originlab.com/doc/Origin-Help/ThemeRef-ThemeOrganizer
http://www.originlab.com/doc/Origin-Help/ThemeRef-System
http://www.originlab.com/doc/Origin-Help/ImpWiz-SaveFilterPage
http://www.originlab.com/doc/Origin-Help/FitFunc-Organizer-Builder
http://www.originlab.com/doc/LabTalk/Tutorials/Tutorial-Get-Started
http://www.originlab.com/doc/LabTalk/guide/From-Files
http://www.originlab.com/doc/LabTalk/Tutorials/Tutorial-XF
http://www.originlab.com/doc/Origin-Help/FileShare-Pack-OPX
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8 Import Data 

 

 

Origin imports many file types: ASCII, CSV, Excel, binary files, and many third-party formats, including 
Matlab, pClamp, NI TDM and NetCDF. When working with Excel files, you have the choice of importing Excel 
data into Origin workbook (recommended) or open Excel file inside Origin. Origin also supports importing 
database files.  

Data files can be directly drag-and-dropped into Origin workspace, workbook, matrix or graph window to 
import them or by File: Import menu which will open dialog for user to customize the import further. For 
many import routines, multiple data files can be imported at once.  

If data are changed inside Origin or data file is changed, use the File: Re-Import Directly menu to reload the 
data, or use File: Re-Import... menu to change the import settings and reload the data. Starting with Origin 
2015, reimport also supports Excel files with multiple sheets.  

Import settings can be saved inside the window to speed up the import process of data files with similar 
structure or saved as a dialog theme file (*.oth) for future use or share with others. When imported via the 
Import Wizard, settings can be saved to an Origin Import Filter file (*.oif) along with post-import processing 
instructions (in the form of LabTalk script).  

Finally the File: Import menu can be customized to show only the data types or saved import Themes that 
you use.  
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Import dialogs now have a check box to Add Filename User Parameters Row 
allowing you to tag each column of data with the source file name. Additionally, there is 
a new Import toolbar that groups together some of the most used import-related 
buttons. 

 

8.1 ASCII Import 

The File: Import: Single ASCII... and File: Import: Multiple ASCII... methods are generally satisfactory 

for importing text files having a simple structure. These methods are also accessible from the  and  
buttons located in the Standard toolbar. These methods will typically handle files with commonly-used 
delimiters and a simple header structure, without adjustments.  

If a file imports with only minor complications, select the Show Options Dialog checkbox when selecting your 
files in the ASCII dialog (File: Import: Single ASCII... and File: Import: Multiple ASCII...). This will open 
the impASC dialog box prior to file import, allowing you to tweak the way that the files are handled.  

 

Once you've adjusted import settings, you can save them in one of two ways: (1) with the worksheet template 
or (2) as a Theme file from within the impASC dialog box. Saving import settings with the worksheet template 
offers portability. Saving import settings as a Theme offers the option of adding your import routine to the 
Import menu (File: Import).  

For more information on Themes and templates, see the Customizing Origin chapter later in this User Guide. 
Additionally, see topics listed under "Topics for Further Reading", below.  

Note: For a more in-depth discussion of simple ASCII import, see the help topic: Help: Origin: Origin 
Help > Importing and Exporting Data > Importing Simple ASCII Data Files  

 
For import of complex ASCII files -- those not satisfactorily handled by the methods previously mentioned -- 

http://www.originlab.com/doc/User-Guide/Customizing-Origin
http://www.originlab.com/doc/Origin-Help/Import-Single-ASCII
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you can use the Origin Import Wizard (File: Import: Import Wizard...). The Wizard is also accessible from 

the  button located in the Standard toolbar. Apart from its advantages for import of complex files, the 
Wizard also offers the following:  

• Using wild cards, you can create filename-specific filters that are targeted to a group of similarly-named 

files. This is especially useful for drag-and-drop import operations because all you do is drop the files onto 

the workspace. Origin looks at the file name, matches it with the correct custom import filter and imports 

the file according to your specifications. 

• Import data from the web pages using the Clipboard. 

• Extract variables from the import file name and header. 

• Specify custom delimiters and date formats. 

• The ability to post-process your imported data using a custom LabTalk script.  

Note: For more information, view the help topic:  

Help: Origin: Origin Help > Importing and Exporting Data > The Import Wizard  

 

Tutorial: Importing Multiple Files into Worksheets  

1. Click on the New Workbook button  on the Standard toolbar to open a new 

workbook. 

2. With the new workbook active, click on the Import Multiple ASCII button  on 

the same toolbar. This opens the ASCII dialog. 

3. In the ASCII dialog, select the files Sensor01.dat, Sensor02.dat, and 

Sensor03.dat from the \Samples\Curve Fitting subfolder of your Origin 

installation folder, and click the Add File(s) button. Then check the Show 

Options Dialog check box and press OK. 

4. The impASC dialog will open. Under the Import Options node, change Import 

Mode to Start New Sheets. Expand the (Re)Naming Worksheet node and clear 

Rename Book with (Partial) Filename. 

5. Press the arrow button  at the top right of the dialog box, then select Save 

As... from the shortcut menu. In the dialog box that opens, enter a name such as 

Import to sheets and press OK. This will save your settings as a Theme that you 

can later use with other files. 

6. Press OK to close the impASC dialog.  

 
The three files will be imported, each into a worksheet, and the sheets will be renamed 
with the file name.  

http://www.originlab.com/doc/Origin-Help/ImpWiz
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You can quickly access your custom import theme from the File: Recent Imports 
menu item. You can also use the File: Import: Customize... menu to open the 
Import Menu Customization dialog box where you can select and add User Themes 
to the File: Import menu.  

8.2 CSV Import 

 You can use File: Import: Comma Delimited (CSV)... to import comma delimited files into an Origin 
workbook file. Modifications to import file handling are made in the impCSV dialog box and changes can be 
saved as a Theme file for later use. Alternately, once you've successfully imported your .csv file into an Origin 
workbook, you can save the workbook as a workbook template file (*.ogw) and reuse the template for re-
importing files of like structure.  

 

You can now skip columns, when doing a partial file import of CSV files. Additionally, a 
flexible syntax is added for selecting or excluding columns and rows to import. 

 

8.3 Binary Import 

 Files with an optional header section followed by a sequential binary structure, can be imported using the 
Origin Import Wizard (File: Import: Import Wizard...).  

If the binary file format is commonly used in your field of work, please contact your Origin representative so 
we can consider adding support for such files in future versions.  
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8.4 Copy/Paste the Clipboard Data 

 One obvious way to get data into Origin is simply to copy data to the Clipboard and paste it into Origin. This 
can be as easy as selecting a block of data in an Excel workbook and pasting it into an Origin workbook. 
However, Clipboard data may not be formatted, arrayed or delimited in a way that makes it easy to paste your 
data into Origin. Here are some things you should know:  

• Data copied from Excel and pasted to Origin will be brought over with full precision, regardless of the 

number of displayed decimal digits in Excel. 

• When working with Excel files with header information, paste the Clipboard data into data row 1 in Origin 

(not into the column label rows), then select a row and use the (right-click) shortcut key commands Set 

as Long Name, Set as Units, Set as Comment, etc. to tag your header information. 

• Data copied from the web can be formatted in various ways. You may have to experiment a bit to find a 

method that brings the data over cleanly. If a simple copy and paste doesn't work, try using the Import 

Wizard. The Import Wizard provides an interactive interface for parsing Clipboard data, with the added 

benefit that you can save your procedure to an import filter file (.oif) for reuse with identically formatted 

data. For more information, see the tutorial Using the Import Wizard to Import Clipboard Data. 

 

http://www.originlab.com/doc/Origin-Help/ImpWiz-ClipboardData
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8.5 Excel 

 There are three ways to work with Excel data in Origin:  

• You can import your Microsoft Excel workbook into an Origin workbook. To do this, use the File: Import: 

Excel (XLS, XLSX, XLSM)... menu command, or click the  button located in the Standard toolbar. 

You can also update the imported data by using File: Re-Import Directly or use Ctrl+4 keys to re-

import Excel sheets with same settings as before. 

• You can copy Excel data to the Clipboard and paste or paste link that data into Origin. 

• You can open your Excel workbook in Origin as an Excel workbook. To do this, use the File: Open Excel... 

menu command. 

When you import or paste your Excel workbook data into an Origin workbook, you have full access to Origin's 
powerful graphing and analysis features. When you open your Excel workbook as an Excel workbook, you are 
actually running an OLE instance of Excel inside of the Origin workspace. In this case, you have access to 
Excel's menus and features, but limited access to Origin's graphing and analysis features.  

Things to know:  

• To re-import multiple sheets from Excel to Origin, you need to have Origin 2015 or later. 

• To open an Excel file in Origin as an Excel workbook, you need to have Office 97 or later installed on your 

computer. 

• To import an Excel file in Origin, the file needs to be of file type .xls, .xlsx or .xlsm.  

• Starting with Origin 2017, you can import Excel files without having MS Excel installed (open as Excel still 

requires Office 97 or later). 

• Origin does not support dynamically linking a formula in an Excel workbook to source data in another 

Excel workbook. 

• You can link your Origin project file to an external Excel file. That way updates to the Excel file will trigger 

updates to dependent graphs etc. when you open the Origin project file. 

Note: To learn more about working with Excel data, see the Origin Help:  

Help: Origin: Origin Help > Working with Microsoft Excel  

 

Origin 2018 adds more naming options on Excel import ((Re)Naming Worksheet and 
Workbook branch of impMSExcel dialog).  

In addition, you can now do partial import of your Excel data by defining rows and 
column ranges. A flexible syntax is provided for including or excluding data ranges. 

8.6 Third Party Formats 

Origin imports many widely-used third party data formats, including pClamp, NI TDM, and NetCDF. As with 
ASCII import, you can customize third-party file import options and save your settings with the worksheet 
template or as a dialog Theme for later use.  

As with other supported file types, you can import third party files by drag and drop.       

http://www.originlab.com/doc/Origin-Help/Work-With-Excel
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File Type  Method  

To Learn More, see  

Help: Origin: Origin Help > 
Importing and Exporting Data  

 
Thermo (SPC, CGM)  
pCLAMP (ABF, DAT, AB?)  
Princeton Instruments (SPE)  
Sound (WAV)  
NetCDF (NC)  
CDF (CDF)  
HDF5 (H5, HE, HDF5)  
NI DIAdem (DAT)   
NI TDM (TDM, TDMS)  
Famos (DAT, RAW)  
ETAS INCA MDF (DAT, MDF)  
IgorPro (PXP, IBW)  
Prism (PZFX, XML)  
MATLAB (Mat)  
Minitab (MTW, MPJ)  
KaleidaGraph (QDA)  
SigmaPlot (JNB)  
MZXML(mzData, mzXML, mzML, imzML)  
EarthProbe (EPA)  
EDF (EDF, BDF, REC, HYP)  
Somat SIE (SIE)  
JCAMP-DX (DX, DX1, JDX, JCM)  
HEKA (DAT)  
SPSS (SAV)  
BRUKER OPUS  
SAS (sas7bdat)  
Tektronix (ISF)  
Data Translation (DCF, HPF)  
Binary 2D Array   
Image   

File: 
Import:  > Importing Third Party Files  

 

Note: Some of these 3rd party file formats are hidden by default. Turn them on by choosing 
File:Import:Add/Remove File Types.... This will add file types to the File:Import menu. To insert 

separators between menu commands, right-click in the right-hand panel of Import Menu Customization 
and choose Add Separator.  

  

 

Drag-and-drop support for various file extensions can be customized using the Filter 
Manager dialog accessible from the Tools: Import Filter Manager... menu item.  
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8.7 Database 

 File: Database Import menu and Database Access toolbar are provided to import data from database. 
There are two ways to build the query:  

• SQL Editor: A simple SQL editor to setup database connect and enter SQL query. It's available in both 

Origin 32-bit and 64-bit.  

• Query Builder: A graphical query builder that assists you in creating an SQL query. It's only available in 

Origin 32-bit.  The query built by it can be loaded and run in Origin 64-bit.  

 

Note: For more information, see the Origin Help  

Help: Origin: Origin Help > Importing and Exporting Data > Importing Data from a Database  

8.8 Digitizer 

 At times, you may only have a graphic representation of some data that you would like to explore further. In 
such cases, Origin's Digitizer tool may prove handy. Use the Digitizer to import an image file, then digitize the 
plots, converting your image to numeric data that you can study and re-plot using Origin's analysis and 
graphing tools.  

 

http://www.originlab.com/doc/Origin-Help/Import-From-Database
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• Import most common image formats. 

• Rotate the imported image, remove noise and calibrate scales by picking start and end values. 

• Pick points on curves manually or automatically. 

• Manually add curve inflection points, as needed. 

• Interactively remove points that you do not want digitized. 

• Support for Cartesian, polar and ternary coordinate systems. 

 
To open the Digitizer:  

1. Click the Digitize Image button on the Standard toolbar or choose Tools: Digitizer... from the 

main menu. 

8.9 Re-Importing Data Files 

 There are two re-import commands in the File menu:  

• Re-Import Directly. When you import a file into an Origin worksheet or matrix sheet, by default a 

number of parameters, including file path and name, are saved in the sheet. If you have an external data 

file that is periodically updated, direct re-import is a quick way to update your Origin project file. 

• Re-Import.... This menu command opens the corresponding X-Function import dialog box for the file 

type so that you can adjust your import options before re-importing. 

Notes:  

• Only one file can be re-imported at a time. When you use either of these two menu commands, 

only the file associated with the active worksheet or matrix sheet, will be imported. If the selected 

data are imported from multiple files, re-importing will fail.  

• If you import an ASCII file via the Import Wizard and select File: Re-Import..., the Import 

Single ASCII dialog will be open instead of the Import Wizard.  

• Re-import does not work for Binary or User Defined data types brought in using the Import 

Wizard. 

8.10 Topics for Further Reading 

• Importing Simple ASCII Data Files 

• Customizing the ASCII Import Options 

• Import and Reimport Excel Data 

• Importing Third Party Files 

• Tutorial: Updating Graphs by Re-importing Data from a Database 

http://www.originlab.com/doc/Origin-Help/Import-Single-ASCII
http://www.originlab.com/doc/Origin-Help/ImpASC-Options
http://www.originlab.com/doc/Origin-Help/Work-With-Excel
http://www.originlab.com/doc/Origin-Help/Import-ThirdPartyFormats
http://www.originlab.com/doc/Tutorials/Update-Graph-By-Reimport-Data-From-Database
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• Importing Data from a Database 

• Drawing or Deleting Data Points 

• Tutorial: The Digitizer 

http://www.originlab.com/doc/Origin-Help/Import-From-Database
http://www.originlab.com/doc/Origin-Help/Draw-Delete-DataPoint
http://www.originlab.com/doc/Tutorials/enhanced-digitizer
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9 Workbooks Worksheets Columns 

 

9.1 Workbook, Worksheet and Column Basics 

The Origin workbook is a nameable, moveable, sizeable window that provides a framework for importing, 
organizing, analyzing, transforming, plotting and presenting your data. Each workbook is a collection of one or 
more worksheets. Each worksheet contains a collection of columns and each column contains rows of cells.  
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9.1.1 Naming Workbooks, Worksheets and Columns 

       

Workbooks  

• A Workbook has a Short Name and an optional Long Name and Comments. 

Origin uses the Short Name for internal operations. 

• Short Names must be unique within the project file, can contain only alpha-

numeric characters (letters and numbers), must begin with a letter and are 

limited to 13 characters. 

• A Workbook Long Name is optional, need not be unique within the project 

file, can use any characters in any order and should be limited to 359 

characters (including spaces). 
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Worksheets  

• A Worksheet has a Short Name and optional Long Name and Comments. 

• The Short Name must be unique in a workbook. 

• A Worksheet Short Name has a 32 character limit, including spaces. It can 

contain special characters but must begin with an alpha-numeric character. 

These special characters are not allowed: {}|"<>()![]. 

• A Worksheet Long Name is optional, need not be unique within the project 

file, can use any characters in any order. 

Columns  

• A Column has a Short Name and an optional Long Name. 

• The Short Name must be unique within the worksheet, cannot contain special 

characters, must begin with a letter or number, use only alphanumeric and 

limited to 18 characters. 

• A Column Long Name is optional, need not be unique within the project file, 

can use any characters in any order. 

• If the Auto update column Short Name to follow Long Name check box is 

selected (Tools: Options: Miscellaneous),column Short Name tracks 

column Long Name, removing spaces/special characters, truncating to 17 

characters, as needed. Check box is cleared by default.  

• Dialog box and Status Bar references to data range will use Long Names, 

provided that (1) Long Name exists and (2) you have selected Use Long 

Names when available (Tools: Options: Miscellaneous). Otherwise, 

Short Names are used. 

 

9.1.2 Workbooks 

By default, when you start an Origin session, Origin loads an empty project with a single, one sheet, two-
column workbook created from the default ORIGIN.otwu workbook template. You can add workbooks to your 

Origin project file by clicking the New Workbook button  on the Standard toolbar.  

An added workbook window is assigned a Short Name of BookN, with N reflecting the order of window 
creation. You can rename the workbook with something more meaningful:  

1. Right-click on the workbook window title bar and choose Properties....  

2. Give your workbook a Long Name (optional) and/or a Short Name and choose to display either or Both 

in the window title bar. See the above table for rules on workbook naming. 

 

The Window Properties dialog has a Spreadsheet Cell Notation check box that is 

enabled by default. When enabled, the  icon displays in the upper-left corner of the 
book (applies to all sheets). Spreadsheet cell notation is useful for defining column 
formulas and must be enabled to make use of cell-level formulas. This is explained in 
more detail, below.  



Origin User Guide 

56 

 

The Window Properties dialog has a Comments box for entering text. These Comments 
display as a workbook window tooltip in Project Explorer and become searchable 
when using the Find in Project tool.  

9.1.3 Worksheets 

 

Prior to Origin 2018, an Origin workbook could a maximum of 255 worksheets. That 
number is now increased to 1024. When you have more than 255 sheets in a book, you 
will need to save your file using one of the new Unicode formats (opju, oggu, otwu). 

To add worksheets to the workbook, right-click on a worksheet's tab and choose one of the following:  

• Insert. Inserts a single worksheet ahead of the active sheet. 

• Add. Appends a single worksheet. 

• Duplicate Without Data. Duplicates the active worksheet without duplicating the data. 

• Duplicate. Duplicates the active sheet, including the data. 

 

Each sheet in a workbook can have its own set of customizations. When you Insert or 
Add a worksheet, the new sheet is based on the ORIGIN.otwu file, specifically the 
version of ORIGIN.otwu that is saved to your User Files Folder, if you have 
customized this file. To add a sheet that is based on another sheet in the workbook 
(including number of columns and special formatting), you would use the Duplicate or 
Duplicate Without Data shortcut command.  

To control worksheet tab name display:  

1. Right-click on the worksheet tab. 

2. Select Sheet Name to Show: Long Name if available/ Short Name/ Long Name from the shortcut 

menu. 

 
To change the Short Name or Long Name that displays on the worksheet tab:  

1. Double-click on the worksheet name or right-click on the worksheet tab and choose Name and 

Comments. See the above table for rules on worksheet naming. If you are editing the Short Name and 

you exceed 32 characters, Origin automatically truncates your entry to create the Short Name. If Long 

Name did not previously exist, the unmodified text becomes the Long Name. 

 

Note: When mousing over the worksheet tab, the worksheet Short Name, Long Name and Comments 
appear as a tooltip.  



Workbooks Worksheets Columns 

57 

9.1.3.1 Worksheet Properties 

The Worksheet Properties dialog box is used to customize properties of the sheet, including...  

• Display of row labels, header labels and grid lines (View tab). 

• The number or rows and columns and other sheet dimensions such as column or row header height (Size 

tab). 

• Enabling of Rich Text, text wrap, how to display truncated cell content, sheet font and color (Format tab). 

• Auto add rows, ignore hidden rows in plotting and analysis, cell resizing (Miscellaneous tab). 

• Printing/exporting of grid lines, headers and footers, background color (Print/Export tab). 

• Script to run after import or upon data change (Script tab). 

 
Note that many of the sheet customizations can be applied at the cell level.  

For more information, see The Worksheet Properties dialog box.  

9.1.4 Worksheet Columns 

• To add a new column to an existing worksheet, right click in the gray area to the right of the worksheet 

columns and choose Add New Column or Click the Add New Column button on the Standard 

toolbar.  

• To add multiple columns to the worksheet, make the worksheet active then choose Column: Add New 

Columns... from the main menu. Specify the number of columns to add in the Add New Columns dialog 

box and click OK; or use the Format: Worksheet... menu item or the F4 hot key to open the 

Worksheet Properties dialog, then set the desired value for Column Number in the Size tab. 

 
Worksheet columns can be renamed by:  

• Double-clicking on the column heading opens the Column Properties dialog box. Enter/edit Short Name 

and/or Long Name.  

• Type a Long Name directly into the worksheet header cell by double-clicking in the cell.  

• Import a data file and specify that the workbooks, worksheets, and columns be named upon import. 

• Use the Enumerate Labels tab of the Worksheet Properties dialog to enumerate or duplicate column 

names and labels. 

• Type names into a few columns (e.g. Peak 1 and Peak 2), then highlight the cells and drag the bottom-

right corner of the selection to auto fill and enumerate the names for other columns. This also works for 

other column label rows such as Comments. 

 
See the above table for rules on worksheet column naming.  

9.1.4.1 The Column Properties Dialog Box 

http://www.originlab.com/doc/Origin-Help/WksProperties-Dialog
http://www.originlab.com/doc/User-Guide/Worksheets-Columns
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 The Column Properties dialog box is used to customize properties of the column including...  

• Long Name, Short Name, Units, Comments, etc. 

• Format (Numeric, Text, Time, Date, etc.).  

• Plot Designation. 

 
To open the Column Properties dialog box:  

1. Double-click on the column header. 

2. Right-click the selected column(s) and choose Properties.... 

Use the Properties tab to edit the column Short Name, if desired. Other properties -- Long Name, Units 
and Comments -- can be edited here or entered directly into the appropriate cell.  

9.1.5 Column Label Rows 

 Column label rows store metadata -- data that is used to describe other data. Typically, though not 
necessarily, that data will be contained in the data columns immediately below the column label rows. This 
metadata may be brought in as header information in imported files, or it may be manually entered. Display of 
column label rows is optional and the user can selectively show them or hide them.  

Column label row information is often used in plotting operations (e.g. worksheet Long Names used as graph 
legend text). The F(x)= row is typically used in performing math operations on columns of data. Data stored 
in User-defined Parameter rows might be used in labeling or grouping of datasets in plotting, data 
manipulation, statistical analysis or math operations.  
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Display of column label rows is controlled by shortcut menu commands:  

 

1. Right-click here and choose View from the shortcut menu. 

2. Right-click here and choose Edit Column Label Rows or other label row command. 

3. Right-click here for global control of row labels and row and column header display. 

 

Numeric data stored in a column will graphically display in the column header in a special label row called 
Sparklines. A sparkline is, by default, a small inset line plot of the data in a column, plotted as the dependent 
variable (Y) against the row number or the associated X column as independent variable (X). Sparklines can 
also be plotted as a histogram or as a box chart, providing a "thumbnail" view of column statistics. When 
importing data, Origin displays sparklines by default when the number of columns is less than 50.  

 

Turn on sparklines for selected columns by clicking Column: Add or Update Sparklines or for all columns by 
right-clicking on the Sparklines row label and choosing Add or Update Sparklines. Sparklines can be deleted 
by clicking the Sparklines row label and pressing the delete key.  
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Sparklines can be edited graphically. Double-clicking on a sparkline pops open a graph 
window where you can customize the plot. When you close the pop-up window, your 
customizations are applied to sparkline.  

9.1.6 The Workbook Organizer 

 As mentioned, the workbook commonly stores metadata, some of which is visible in the column label rows 
and some of which is hidden and not necessarily visible. Such hidden metadata might include things like 
import file path and name, date and time of data import, file header information not written to the column 
label rows, variable names and values, etc. This hidden metadata can be viewed in the Workbook Organizer 
panel.  

To show a workbook's Organizer panel right-click on the workbook title bar and select Show Organizer (note 
that this action toggles the panel on or off). The Organizer provides a tree-view listing of metadata stored with 
a particular workbook.  
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9.1.7 Some Workbook, Worksheet and Column Limits 

 Maximum Number of...  32Bit OS  64Bit OS  

Worksheets in a workbook  
Rows in a worksheet, 1 column 
Rows in a worksheet, 5 columns 
Rows in a worksheet, 32 columns 
Columns in a worksheet, 1 row 
Columns in a worksheet, 100 rows 
Columns in a worksheet, 1000 rows 

1024† 
90,000,000 
25,000,000 
4,860,000 
65,500 
65,500 
65,500 

1024† 
90,000,000 
90,000,000 
7,300,000 
65,500 
65,500 
65,500 

† > 255 sheets requires saving file to Unicode (e.g. *.opju) file format. Unicode formats not compatible with 
Origin versions prior to Origin 2018 SR0.  

9.2 Workbook Templates 

Origin workbook windows are created from a workbook template file with an .otwu extension. By default, 
Origin uses the ORIGIN.otwu template when creating new workbook windows. ORIGIN.otwu contains a single, 
two-column worksheet. You can customize an Origin workbook and save it as a new template file. Customized 
templates get saved to your User Files Folder (UFF) by default.  

1. To save the active workbook as a template, choose File: Save Template As. This opens the 

template_saveas dialog box.  

2. Use Category = UserDefined or create your own. 

3. Give the template a name. By default, the name is the name of the template used to create the window. If 

the template is a System template (e.g. the Origin.otwu file used to create new workbooks), saving the 

file to your UFF will make this your new default template.  

4. Provide a Template Description if desired and save either to File Path = User Files, or browse to a new 

location. 

 

The System templates that ship with Origin are stored in the EXE folder and cannot be 
overwritten. If you have saved a customized template to your User Files Folder but 
want to restore the original System template, simply remove your customized template 
from the UFF.  

Note: Data are NOT saved with a template file.  

http://www.originlab.com/doc/Origin-Help/UserFilesFolder
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The following table lists some of the kinds of things that are saved with the workbook template file. Click the 
dialog box link for more information.  

Dialog Box  What is Saved?  Menu Command  

Worksheet Properties  

• Display of row/column heading 

labels. 

• Display of worksheet grid lines. 

• Number of rows/columns in the 

worksheet. 

• Auto addition of worksheet rows, 

when needed. 

• Creation and naming of 

worksheet column heading user-

defined parameters. 

• The order of worksheet column 

heading row labels. 

Format: Worksheet...  

Column Properties  

• Column Short Name, Long 

Name, Units, Comments. 

• Formula (if any) used for 

calculating column values. 

• Column width settings.  

• Column Plot Designation. (X,Y,Z, 

Label, etc.). 

• Column data Format (text, 

numeric, date, etc.). 

• Column number Display 

(decimal, scientific, engineering). 

• Column Digits and data storage 

requirements. 

Format: Column...  

Column Formulas and 
Scripts  

(Set Column Values)  

• Formulae used to create or 

transform column values. Column: Set Column 
Values...  

http://www.originlab.com/doc/Origin-Help/WksProperties-Dialog
http://www.originlab.com/doc/Origin-Help/ColProperties-Dialog
http://www.originlab.com/doc/Origin-Help/Wks-Set-Column-Values
http://www.originlab.com/doc/Origin-Help/Wks-Set-Column-Values
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Dialog Box  What is Saved?  Menu Command  

Properties  

• Any annotations along with their 

settings in the Properties dialog 

box. 

• Any scripts associated with the 

object's Properties dialog, 

Programming tab. 

Format: Text Object  
Format: Object Properties  

Worksheet Query  
• Equations in the Worksheet 

Query dialog box. Worksheet: Worksheet 
Query  

Worksheet 
Properties, Script 

tab 
or 

Script Panel 

• Scripts entered in the Script tab 

of the Worksheet Properties 

dialog box. 

• Scripts in the worksheet Script 

Panel. 

Worksheet: Worksheet 
Script 
Show Script Panel  

Query Builder  
• Option to save database queries 

with the workbook template. File: Database Import: New  

9.2.1 Creating a New Workbook from a Custom Template 

 As mentioned, Origin ships with a number of System Templates (workbook, matrix, graph) that are installed 
to the Origin EXE folder and cannot be overwritten. When you customize a window that is created from a 
System Template and save the template with the same name to your User Files Folder, this customized 
template then becomes the new default template associated with a particular toolbar button or menu 
command. This applies to the workbook template that is opened when you click the New Workbook button 

 on the Standard toolbar.  

Other methods of creating a window from a customized workbook file:  

• If the template was recently saved, look under File: Recent Books or go to the Books tab in Origin 

Central (Help: Origin Central or press F11).  

• Click File: Open..., set file type to Origin Template (*.otpu, *.otwu, *.otmu) and browse to the file. 

• Click the Open Template...  button on the Standard toolbar and change the file type to Workbook 

Template (*.otwu), then browse. 

• Click File: New: From Template: More... This menu command opens the Load Template dialog box. In 

the Type group, select Workbook. If necessary, use the browse button in the Path group to locate the 

.otwu file, then select the worksheet template from the Name drop-down list. Optionally, specify this as 

the default workbook template by clicking Set Default. 

http://www.originlab.com/doc/Origin-Help/TextOb-Prop-Text-tab
http://www.originlab.com/doc/Origin-Help/Ref-TextLabel-DrawingObjects
http://www.originlab.com/doc/Origin-Help/Wks-Query-QS
http://www.originlab.com/doc/Origin-Help/Wks-Query-QS
http://www.originlab.com/doc/Origin-Help/WksProperties-Dialog
http://www.originlab.com/doc/Origin-Help/WksProperties-Dialog
http://www.originlab.com/doc/Origin-Help/WkbkScript-Panel
http://www.originlab.com/doc/Origin-Help/Import-From-Database
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9.3 Simple Utilities for Filling Columns with Data 

 Origin provides several utilities for filling a worksheet range or column, with data. The simplest of these use a 
menu command to fill a worksheet column with either row index numbers, uniform random numbers or 
normal random numbers. This is useful for generating quick datasets to test and try out other Origin 
features.  

These simple procedures create a dataset in a pre-selected worksheet range or column(s):  

Action  Toolbar Button  Menu Command  

Fill a range or column with row 
numbers   

• Column:Fill Column With:Row 

Numbers 

or 

• Right-click and select Fill 

Range/Column(s) With Row 

Numbers 

Fill a column with uniformly 
distributed random numbers between 
0 and 1   

• Column:Fill Column 

With:Uniform Random 

Numbers 

or 

• Right-click and select Fill 

Range/Column(s) With 

Uniform Random Numbers 

Fill a column with normally distributed 
random numbers  

 

• Column:Fill Column 

With:Normal Random Numbers 

or 

• Right-click and select Fill 

Range/Column(s) With Normal 

Random Numbers 

Fill a column with a patterned or 
random set of numbers  --  

• Right-click and select Fill 

Range/Column(s) With A set 

of Numbers... 
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Action  Toolbar Button  Menu Command  

Fill a column with a patterned or 
random set of Date/Time Values  --  

• Right-click and select Fill 

Range/Column(s) With A set 

of Date/Time Values... 

Fill a column with arbitrary set of 
Text&Numeric values  --  

• Right-click and select Fill 

Range/Column(s) With 

Arbitrary set of Text&Numeric 

values... 

 
The auto fill feature can be used in filling column label rows and the worksheet data cells:  

To use auto fill to extend a pattern in the data across a range of cells (numeric data only):  

1. Select a contiguous block of cells and move the mouse cursor to the bottom right corner of the selection.  

2. When the cursor becomes a "+", hold down the ALT key and drag the mouse to the bottom or the right.  

 
To use auto fill to repeat a pattern in the data across a range of cells (text or numeric data):  

1. Select a contiguous block of cells and move the cursor to the bottom right corner of the selection.  

2. When the cursor become a "+", hold down the CTRL key and drag the mouse toward the bottom or to the 

right. 

 
Datasets can also be generated quickly using LabTalk script. As an example:  

1. With a new worksheet active, open the Script Window from the Windows menu, and copy-paste the 

following lines of script code into that window: 

col(1)={0:0.01:4*pi}; 

col(2)=sin(col(1)); 

2. Highlight the two lines and press ENTER to execute them. The first two columns of the worksheet will be 

filled with data. 

9.4 Setting Column Values 

    

The Set Values dialog box is used to set up a mathematical expression that creates or transforms one or 
more columns of worksheet data. The dialog box includes a menu bar, a control used to define output range, a 
tool for searching and inserting LabTalk functions into your expression, a column formula box used to define a 

http://www.originlab.com/doc/User-Guide/Programming-in-Origin
http://www.originlab.com/doc/Origin-Help/Wks-SetColVal-QuickStart
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one-line mathematical expression and a Before Formula Scripts panel (usage optional) intended for data 
pre-processing and defining of variables used in your one-line expression.  

 

Since Origin 2017, the column formula box (the upper box) in Set Values has supported a simplified 
spreadsheet cell notation like is used in MS Excel and Google Sheets (e.g. "col(A)" is now simply "A" and 

"col(A)[1]" is now simply "A1"). When this spreadsheet cell notation is enabled (default), you will see an  
icon in the upper-left corner of the worksheet. This notation can only be used in defining the column formula. 
It cannot be used in the Before Formula Scripts panel of Set Values, nor can it be used in your LabTalk 
scripts. Note that the "old" column and cell notation will work in "spreadsheet" mode, so if you prefer to use 
the old notation, you may enter it as you always have.  

To open the Set Values dialog box for a single column:  

1. Select a worksheet column or a range of cells in a worksheet column.  

2. From the menu, choose Column: Set Column Values... or right-click on the worksheet column and 

choose Set Column Values... from the shortcut menu. 

 
To open the Set Values dialog box for multiple columns:  

1. Select multiple, contiguous worksheet columns (skip no columns) or the entire worksheet. 

2. From the menu, choose Column: Set Multiple Column Values... or right-click on the worksheet column 

and choose Set Multiple Column Values... from the shortcut menu. 
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9.4.1 Set Values Menu Commands 

Menu 
Commands  

• Formula: Load a saved formula into the column formula box. Formulas are 

saved using Formula: Save or Formula: Save As.... 

• wcol(1): Use the menu to include worksheet columns in either your column 

formula or your Before Formula Scripts (column reference is inserted at the 

cursor). A Column Browser is available to help in selecting the correct 

columns. Columns are listed by column index. 

• Col(A): Similar to wcol(1) menu functionality but columns are listed by 

column name (including Long Name, if it exists). 

• Function: Add LabTalk functions to your expressions (function name is 

inserted at the cursor). Note that when you hover over a function in the menu 

list, the function description will be shown in the Status Bar. When a function 

is selected, its description will be displayed in a pop-up Smart Hint.  

• Variables: Add a variable or a constant to Column Formula or Before 

Formula Scripts; Add range variables (including by selection) or file 

metadata, to Before Formula Scripts. 

• Options: Allow direct editing of column formula in worksheet Formula row; 

add a comment about the column formula; or preserve text in Set Values 

columns (do not treat as text as missing values). 
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Column Formula  

• Add a single line expression for generating data. Functions, conditional 

operators and variables can be used. 

Before Formula 
Scripts  

• LabTalk scripts to be executed before the expression in the column formula 

box is executed.  

 

When you mouse over one of the functions listed in the Function menu in Set Values 
dialog, a one-line tooltip is displayed in the Status Bar. If you select the function, a 
Smart Hint appears with a more detailed explanation and a link to the full function 
description, syntax, examples, etc.  

Additionally, you can click the Search and Insert Functions button to search for 
available functions by keyword and, once found, insert the function into your 
expression.  

 

Use the Before Formula Scripts panel to define variables, LabTalk functions, or run 
LabTalk scripts before the expression in the upper panel is evaluated.  

 
To learn more, see Set Column Values - Quick Start  

9.4.2 The F(x)= Worksheet Column Label Row 

For simple expressions, you can use the F(x)= row to set column values. Any expression you enter here is 
directly entered into the Set Values dialog and vice versa. Note that the simplified spreadsheet cell notation 
that works in the formula box in Set Values also works in F(x)=:  

1. Double-click in a cell in the F(x)= column label row. 

2. Enter an expression to enter output in the data column below. 

 

9.4.3 Set Column Values Tutorials 

 

Tutorial 1: A Quick Units Conversion using F(x)=  

1. Start with a new workbook and import the file \Samples\Graphing\WIND.DAT. 

2. We will assume that column B contains Speed values in miles per hour (MPH). Click 

http://www.originlab.com/doc/User-Guide/Origin-Interface
http://www.originlab.com/doc/Origin-Help/Wks-SetColVal-QuickStart
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on the column heading for column C, then right-click and choose Insert. Origin 

inserts a new column C and moves Power values to column D. 

3. Now, we'll convert the MPH values in column B to kilometers per hour (KPH). 

Double-click in the F(x)= cell of column C and enter  

B*1.6 

4. and press Enter. Column C is filled with values in units of KPH. 

 
Tutorial 2 : Computing Moving Average and Moving Standard Deviation  

1. Import the file Samples\Signal Processing\fftfilter1.DAT. 

2. Add two more columns to the worksheet by clicking the twice. 

3. Click on the header of the 3rd column to select it, then right-click and select Set 

Column Values... from the context menu. 

4. In the Set Values dialog, enter the following in the upper panel:  

movavg(B,5,5) 

5. and press Apply. Column 3 is filled with an 11-point moving average of the data 

from column B (note that you can insert functions such as movavg from the 

Function menu of the Set Values dialog box). 

6. Click the >> button above the edit box to switch to the 4th column. 

7. In the edit box for the 4th column, enter the formula:  

movrms(B,5,5) 

8. and press OK. This 4th column will be filled with root-mean-square (RMS) values, 

using a window size of 11 at each point. 

 
Tutorial 3: Set Values for Multiple Columns  

1. Create a new project by clicking the New Project button on the Standard 

toolbar. 

2. Click the Import Multiple ASCII button to import the files F1.dat and F2.dat 

in the <Origin Folder>\Samples\Import and Export\ path. In the impASC dialog, 

select Start New Books for the Import Mode drop-down list. 
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3. Two workbooks are created, named as F1 and F2. Click the New Workbook 

button on the Standard toolbar to create another workbook. 

4. With the 3rd workbook active, click the Add New Columns button to add a 

column. Highlight all columns and select Column: Set Multiple Columns Values 

from the main menu or right-click the columns and select Set Multiple Columns 

Values from the shortcut menu to open the Set Values dialog box. 

5. Expand the bottom panel by clicking the Show Scripts button . Enter this script 

in the Before Formula Scripts edit box,  

        range r1=[F1]F1!wcol(j); //"j" is the column index. 

        range r2=[F2]F2!wcol(j); 

6. Enter (r1+r2)/2 in the Column Formula edit box  

7. Select Options: Direct Edit Formula Cell to clear this option.  

8. Select Options: Formula Text... and enter (F1+F2)/2 in the Formula Text 

dialog, then click OK.  

9. Click the OK button in the Set Values dialog box. You will see the results in the 

worksheet, and (F1+F2)/2 will display in the F(x)= column label row instead of the 

formula.  
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9.5 Setting Cell Values 

 

Origin 2018 now supports cell-level expressions similar to those used by spreadsheet 
programs. 

Cell-level expressions which return a single value can be entered into any worksheet data cell or into cells in a 
User-Defined Parameter row of the column label row area. When Edit Mode (Edit: Edit Mode) is toggled on, 
cell formulas display. When Edit Mode is toggled off, the resulting value is displayed. Cell content can be edited 
regardless of Edit Mode state.  

 

• To use cell formulas, Spreadsheet Cell Notation must be enabled ( appears in upper-left corner of 

sheet). 

• Cell formulas begin with an equal sign (e.g. "=B1 - C1). 

• Cell formulas can return a numeric, a string or a date-time value. 

• Cell formulas can incorporate cell references, variables, operators, LabTalk-supported functions and 

constants. 

• Cell formulas can reference values in other sheets or books. 

• Cell formulas can be extended to other cells by dragging with your mouse. 

 
To learn more, see Using a Formula to Set Cell Values.  

9.5.1 Set Cell Values Tutorials 

 

Tutorial 1: Extending a cell formula to other cells  

1. Click the New Workbook button to open a new book. 

2. Click on the column A heading to select, then right-click and choose Fill Column 

with Row Numbers. 

http://www.originlab.com/doc/Origin-Help/Using-Formulae-to-Set-Cell-Values
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3. Click on cell B1 and enter:  

=A1+A[1] 

4. Press ENTER. This adds the value in A1 to the value in A1.  

5. With the cell still selected, hover on the selection handle in the lower-right corner 

of the cell and drag to the end of the column, extending your cell calculation to 

other cells. This will add the quantity in A1 to values in column A. 

6. Click the Add New Columns button to add column C. 

7. Click on the Cell in C1 but this time enter:  

=A1+A1 // omit the square bracket 

8. Press ENTER. This adds the value in A1 to the value in A1.  

9. With the cell still selected, hover on the selection handle in the lower-right corner 

of the cell and drag to the end of the column, extending your cell calculation to 

other cells. Note that this time, the resulting values are different. 

10. Click Edit: Edit Mode to display the underlying cell formulas. Note that the square 

brackets in column B "protected" the second cell A1 reference so that it didn't 

change but that the A1 reference in column C changed as we extended the cell 

calculation to other cells. 

 

 

Tutorial 2: Quickly finding maximum values in multiple columns of data  

The only place where you can use cell formulas in the worksheet column label rows 
(worksheet header rows), is in a User Parameter row.  

1. Create a new workbook and then choose File: Import: Single ASCII and import 

the file \Samples\Import and Export\S15-125-03.dat. 

2. With your mouse, hover just to the left of the F(X)= row label and when the 

pointer becomes an arrow, right-click and Add User Parameters.  

3. In the dialog box that opens, enter "MaxValue" and click OK. 

4. In column A(X), in the MaxValue cell, enter:  

http://www.originlab.com/doc/Origin-Help/WksHeaderRow-DataSupportDisplay
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=Max(This) 

5. Click outside the cell and cell should now display "10". 

6. Click back on this cell, then grab the selection handle in the lower right corner of 

the cell and drag to the right to extend the cell formula to MaxValue cells in 

columns B(Y), C(Y) and D(Y). All MaxValue cells should now display the 

maximum values in their respective columns. 

 

Tutorial 3: Use a column label row value in a cell calculation  

All data in the worksheet column label rows, including User Parameter rows, is stored 
as string data. To use a "number" stored in a column label row in a cell calculation, you 
must convert the string to a numeric value. In the following example, we use the 
LabTalk value() function to convert column label row data to a numeric so that it can 
be used in a cell calculation:  

1. Create a new workbook and then choose File: Import: Single ASCII and import 

the file \Samples\Import and Export\S15-125-03.dat. 

2. With your mouse, hover just to the left of the F(X)= row label and when the 

pointer becomes an arrow, right-click and Add User Parameters.  

3. In the dialog box that opens, enter "Correction" and click OK. 

4. In column D, enter the value "0.2" into the Correction cell. 

5. Click the Add New Columns button to add column E. 

6. In cell E1, enter:  

 =D1+value(D[Correction]$) 

7. Press ENTER. This converts the Correction value to a numeric and adds the 

numeric to the value in cell D1. The cell should display 101.9. 

http://www.originlab.com/doc/LabTalk/ref/Value-func
http://www.originlab.com/doc/LabTalk/ref/Value-func
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9.6 Processing Worksheet Data 

Origin provides a number of utilities for manipulating worksheet data. Most of these are found on the 
Worksheet menu while some are on the Edit, Column or Analysis menus. Note that a worksheet must be 
the active window.        

Utility  Menu Access  

• Sorting Data 
Worksheet: Sort Range 
Worksheet: Sort Columns 
Worksheet: Sort Worksheet 
Worksheet: Sort Columns by Label 

• Find 

• Replace 

• Go To (sheet row/column) 

Edit: Find in Project 
Edit: Find in Sheets 
Edit: Replace 
Edit: Go To  

• Hide Column 

• Hide Rows 
Column: Hide/Unhide Columns  

Hide/Unhide Rows (shortcut menu only)  

• Move Columns 

• Swap Columns 

Column: Move Columns or Column 
toolbar.  

Column: Swap Columns  

• Query Worksheet Data 
Worksheet: Worksheet Query  

• Copy Columns to (new locations) 
Worksheet: Copy Columns to  

• Append Worksheet 
Worksheet: Append Worksheet  

• Split Columns 

• Split Worksheet 

• Split Workbook 

Worksheet: Split Columns  

Worksheet: Split Worksheet  

Worksheet: Split Workbooks  

• Worksheet Transpose 
Worksheet: Transpose  

http://www.originlab.com/doc/Origin-Help/Wks-Sort-Data
http://www.originlab.com/doc/Origin-Help/Wks-Sort-Data
http://www.originlab.com/doc/Origin-Help/Wks-Sort-Data
http://www.originlab.com/doc/Origin-Help/Wks-Sort-Col-by-Labels
http://www.originlab.com/doc/Origin-Help/Finding-Project
http://www.originlab.com/doc/Origin-Help/Wks-Find-Replace-Data
http://www.originlab.com/doc/Origin-Help/Wks-Find-Replace-Data
http://www.originlab.com/doc/X-Function/ref/colmove
http://www.originlab.com/doc/Origin-Help/Column-Toolbar
http://www.originlab.com/doc/Origin-Help/Column-Toolbar
http://www.originlab.com/doc/X-Function/ref/colswap
http://www.originlab.com/doc/Origin-Help/Wks-Query-QS
http://www.originlab.com/doc/Origin-Help/copy-columns
http://www.originlab.com/doc/Origin-Help/append-worksheet
http://www.originlab.com/doc/X-Function/ref/colsplit
http://www.originlab.com/doc/Origin-Help/split-wks-into-sheets
http://www.originlab.com/doc/Origin-Help/split-wkbk
http://www.originlab.com/doc/Origin-Help/transpose-wks
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Utility  Menu Access  

• Stack Multiple Columns into One with 

Grouping 

• Unstack Grouped Data into Multiple 

Columns 

Worksheet: Stack Columns  

Worksheet: Unstack Columns  

• Summarize Data with Pivot Table 
Worksheet: Pivot Table  

• Filter data using conditions on one or more 

columns 
Column: Filter menu, or Worksheet Data 
toolbar  

• Data Reduction 

Worksheet: Remove/Combine Duplicated 
Rows  
Worksheet: Reduce Columns 
Worksheet: Reduce Rows  
Analysis: Data Manipulation: Reduce 
Duplicate X Data 
Analysis: Data Manipulation: Reduce by 
Group 
Analysis: Data Manipulation: Reduce to 
Evenly Spaced X  

• Reverse Order 
Column: Reverse Order  

 

 

Some of these worksheet data processing utilities are available from a shortcut menu. 
For access, right-click on your data selection.  

http://www.originlab.com/doc/Origin-Help/Wks-Stacking-Cols
http://www.originlab.com/doc/Origin-Help/Wks-Unstacking-Cols
http://www.originlab.com/doc/Origin-Help/Wks-Pivot-Table
http://www.originlab.com/doc/Origin-Help/Wks-DataFilter
http://www.originlab.com/doc/Origin-Help/Wks-Data-Toolbar
http://www.originlab.com/doc/Origin-Help/reduce-duplicate-rows
http://www.originlab.com/doc/Origin-Help/reduce-duplicate-rows
http://www.originlab.com/doc/Origin-Help/Reduce-Columns
http://www.originlab.com/doc/Origin-Help/reduce-rows
http://www.originlab.com/doc/X-Function/ref/reducedup
http://www.originlab.com/doc/X-Function/ref/reducedup
http://www.originlab.com/doc/X-Function/ref/reducexy
http://www.originlab.com/doc/X-Function/ref/reducexy
http://www.originlab.com/doc/X-Function/ref/reduce_ex
http://www.originlab.com/doc/X-Function/ref/reduce_ex
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9.6.1 Worksheets for Analysis and Reporting 

    

Apart from containing text and numeric data, worksheet cells support storage and display of various other 
types of data such as graphs, graphic objects, notes, hyperlinks to documents and web pages, and links to 
project variables.  

This makes the worksheet an ideal medium for presenting analyses and reporting results. You can link to cells 
in other worksheets and report sheets. You can also embed graphs, images from external disk files, or image 
plots corresponding to matrix objects in your Origin Project. Groups of cells in a worksheet can be merged, 
allowing for larger objects to be displayed fully. Graphs can also be placed on worksheets as floating objects.  

Once created, such custom reports can be exported as image files (for instance, as PDF or JPEG), and they can 
also be used in the creation of an Analysis Template.  

 

 

You have the option of generating custom reports by exporting data to a custom MS 
Word template, and optionally, a PDF file. This is done by running an output-
generating analysis in Origin, then associating key results with bookmarks in a Word 
template, and, finally, saving the workbook as an Analysis Template. To generate your 
report, you open the Batch Processing tool, point to both your Analysis Template and 
your Word template, run the batch process and generate your reports. For more 
information on batch analysis and generating custom reports, see the Batch Analysis 
section of the "How to Handle Repetitive Tasks" chapter of this Guide.  

http://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks


Workbooks Worksheets Columns 

77 

 

9.7 Topics for Further Reading 

• The User Files Folder 

• Origin Template Files 

• What is Saved with the Workbook Template? 

• Arranging the Worksheet 

• Displaying Supporting Data in the Worksheet Header Rows 

• Controlling How Numeric Data Display  

• Dates and Times in the Worksheet  

• Generating Simple Worksheet Datasets 

• Using Formulae to Set or Transform Worksheet Column Values 

http://www.originlab.com/doc/Origin-Help/UserFilesFolder
http://www.originlab.com/doc/Origin-Help/OFileType-Template
http://www.originlab.com/doc/Origin-Help/Wkbk-Saved-with-Template
http://www.originlab.com/doc/Origin-Help/Arrange-Wks
http://www.originlab.com/doc/Origin-Help/WksHeaderRow-DataSupportDisplay
http://www.originlab.com/doc/Origin-Help/Wks-Col
http://www.originlab.com/doc/Origin-Help/WksCol-DateTime
http://www.originlab.com/doc/Origin-Help/Wks-GenerateDataset
http://www.originlab.com/doc/Origin-Help/Wks-Set-Column-Values
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• Using a Formula to Set Cell Values 

• Simple Manipulation of Worksheet Datasets 

• Inserting Graphs, Images and other Objects into Worksheet Cells 

• Inserting Links into Worksheet Cells 

• Inserting Variables into Worksheets 

• Analysis Report Sheets and Columns 

http://www.originlab.com/doc/Origin-Help/Using-Formulae-to-Set-Cell-Values
http://www.originlab.com/doc/Origin-Help/Wks-Manipulate-Datasets
http://www.originlab.com/doc/Origin-Help/InsObject-to-WksCell
http://www.originlab.com/doc/Origin-Help/InsLink-to-WksCell
http://www.originlab.com/doc/Origin-Help/InsVariable-Dialog
http://www.originlab.com/doc/Origin-Help/Analysis-Rep-Wks-Cols
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10 Matrix Book Matrix Sheet Matrix Objects 

 

10.1 Matrix Books, Matrix Sheets and Matrix Objects 

A matrix is a dataset of Z values arranged as an array of columns and rows which are linearly mapped to X 
and Y values.  The following table summarizes some important matrix book limits:  

Maximum Number of...  32Bit OS  64Bit OS  

Matrix sheets in a matrix book 
Matrix objects in a matrix sheet 
Cells in a matrix (Note) 

1024† 
65,527 
90,000,000 

1024† 
65,527 
90,000,000 

† > 255 sheets requires saving file to Unicode (e.g. *.opju) file format. Unicode formats not compatible with 
Origin versions prior to Origin 2018 SR0.  

Note: The product of any combination of rows and columns must not be greater than 90,000,000.  
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10.1.1 Naming Matrix Books, Matrix Sheets and Matrix Objects 

       

 

Matrix Book  

• The matrix book has a Short Name whether you display it or not. Origin uses 

the Short Name for internal operations. 

• Short Names must be unique within the project file, cannot contain spaces, 

must begin with a letter, consist only of alphanumeric characters (A to Z and 0 

to 9), and limited to 13 characters. You can use lowercase characters and the 

text will appear as such, but upper and lower case are not unique characters. 

(You cannot name one matrix MBOOK1 and another mbook1.) 

• Long Names are optional, need not be unique within the project file, can 

contain spaces, can begin with a letter, a number or a special character, and 

the length cannot exceed 520 characters, including spaces. 
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Matrix Sheets  

• The sheet Short Name (a Layer object) must be unique within the matrix book 

and is limited to 32 characters. 

• Can contain spaces, numbers and special characters. 

• Can begin with a letter, number or special character. 

• These special characters are not allowed: `!%"|()[]{}<>. 

Matrix Objects  

• Origin assigns a Short Name -- the matrix object index number -- to each 

matrix object, as it is created. This name/index number cannot be changed.  

• You can add an optional Long Name to the object by clicking on the yellow 

object icon - for a data matrix or for an image matrix - in the upper 

right corner of the matrix sheet and choosing Rename from the menu.  

10.1.2 Different Views of the Matrix 

   In the worksheet, a dataset is contained in a single column and the dataset may consist of X,Y,Z, Error, or 
Label data. In the Origin matrix, a dataset is arranged in a specified dimension of rows and columns. The 
matrix contains a single dataset of Z values.  

• Matrix columns are mapped to linearly-spaced X values.  

• Matrix rows are mapped to linearly-spaced Y values.  

 
Note that the matrix window has two column and row heading view modes:  

• By default, matrix row and column headings display as row and column index numbers (View: Show 

Column/Row from the menu or press Ctrl+Shift+C).  

• You can opt to view matrix row and column as X and Y values by choosing View: Show X/Y from the 

Origin menu (or press Ctrl+Shift+X). The displayed X and Y values are the X and Y coordinate values, 

calculated by linear interpolation of the axes From and To values by the number of columns and rows. 

 
In addition to the two row and column heading view modes, there are two matrix display modes:  

• In Data Mode (View:Data Mode from the menu or press Ctrl+Shift+D), the matrix object displays as 

raw numbers. 

• In Image Mode (View:Image Mode from the menu or press Ctrl+Shift+I), the matrix object displays as 

either a gray scale image or a color image, depending upon the type of data in the matrix. A matrix of real 

numbers or complex numbers displays as a gray-scale image while RGB values will display as a color 

image. 

http://www.originlab.com/doc/Quick-Help/Data-and-Image
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An image in a matrix can be cropped within the existing window or it can be cropped and copied to create a 
new matrix window:  

1. Make sure that there is a check mark beside Region of Interest Tools on the Tools menu. If this menu 

item is not checked, select it.  

2. Click the Rectangle Tool button on the Tools toolbar.  

3. Drag out a rectangular area on the image.  

4. Right-click on the rectangle and select Crop from the shortcut menu. 
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Note: If the matrix object is an image, the object icon will display as whether you are viewing the 
matrix object as an image (View:Image Mode) or as numbers (View:Data Mode). Likewise, when the 

matrix object contains numbers, the object icon will display as regardless of view mode.  

10.1.3 Matrix Books 

 Like the workbook window, the matrix book window is created from a customizable template (.otmu file). The 
matrix template stores such things as number of sheets in the book, the names of the matrix sheets, matrix 
dimensions, data type, math functions, data import handling instructions as well as various style and format 
options.  

When you create a new matrix book, the book is named MBookN, with N reflecting the order of window 
creation. Appended to the book name, you will see something like ":1/3" where the first integer denotes the 
active matrix object and the second denotes the number of matrix objects in the active matrix sheet. Following 
the above example, if you click the yellow object icon to the right side of the matrix, the menu shows three 
matrix objects with the first being the active one - the one with a check mark placed beside it (note that in our 
illustration, the objects are empty).  
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10.1.4 Matrix Sheets 

 

Prior to Origin 2018, an Origin matrix book could a maximum of 255 sheets. That 
number is now increased to 1024. When you have more than 255 sheets in a book, you 
will need to save the file using one of the new Unicode formats (opju, ogmu, etc). 

A matrix book can have up to 1024 matrix sheets. The default matrix book template - ORIGIN.otmu - has a 
single matrix sheet containing 32 rows and 32 columns. Each matrix sheet can differ in dimensions(number of 
rows and columns and X & Y range).  

To specify the dimensions of the matrix sheet:  

1. Click on a tab to activate the sheet and choose Matrix:Set Dimensions/Labels. This opens the Matrix 

Dimensions and Labels dialog box. 

2. Specify a number of columns (X dimension) and rows (Y dimension). 

3. Specify a From and To value for X (columns) and Y (rows). 

 

Note: The X and Y coordinates of the matrix are evenly spaced. The first X is mapped to the first matrix 

column and the last X is mapped to the last matrix column. The X coordinates of other columns are 
interpolated. Matrix rows are similarly mapped using the From Y and To Y values. When plotting or 

analyzing matrix data, the position of a point in 3D space is determined by the column X and row Y 
coordinate values (not column or row index) and the Z value contained in the cell intersected by the row 

and column.  

10.1.5 Matrix Objects 

A matrix sheet can contain up to 65,527 matrix objects, though the actual limit is likely to be far less 
(determined by system resources). Objects in a sheet share the same X/Y dimensions and column (X) and row 
(Y) headers, but every object can have its own Z header. Other matrix object properties include internal data 
type and numeric display options.  

http://www.originlab.com/doc/Origin-Help/MatOb-Header
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Matrix object properties are set in the user interface via the Matrix Properties dialog box. To open the dialog 
box:  

1. Make sure that the matrix object is active (check mark shows beside it in the object menu). 

2. Choose Matrix:Set Properties... from the main menu.  

 

You can set properties for multiple matrix objects without closing the Matrix 
Properties dialog boxes by clicking the Previous or Next buttons at the top of the 
dialog box.  

10.2 Virtual Matrix 

   

Data arranged in a block of worksheet cells can be treated as a "virtual matrix". As is the case with regular 
matrix data, virtual matrix data can be used to create 3D plots, such as color mapped surfaces or contour 
plots. The data can include a column or label row with the X or Y values. Unlike a regular matrix which only 
supports a linear spacing in the X and Y dimensions, a virtual matrix supports irregular spacing of X and Y 
coordinate values (provided those values are in ascending or descending order). 
 

 

Note: You can create 3D plots from XYZ columns of worksheet data in which data are irregularly spaced in 
the X and Y dimensions. This is not considered a "virtual matrix."  

10.3 Matrix Templates 

  Matrix windows are created from a matrix template file (*.otmu). The template file saves such things as the 
number of sheets in the matrix book, the number of rows and columns in each sheet, internal memory 
allocated for each sheet, mathematical formula used to fill the matrix with numbers and certain ASCII import 
and export options.  

Note: Data are NOT saved with the matrix template file.  

http://www.originlab.com/doc/User-Guide/Graphing
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To save the active matrix window as a template:  

1. With the matrix window active, choose File: Save Template As from the main menu. This opens the 

template_saveas X-Function dialog box.  

2. Select a category from the Category drop-down list or enter a new category.  

3. Select or type a file name in the Template Name box (the .otmu extension is automatically added).  

4. Enter a description into the Template Description text box (optional).  

5. Type the file path for the template or click the browse button to locate your folder. Typically, you would 

save your template to your User Files folder. 

The following table lists some of the kinds of things that are saved with the matrix template file. It also tells 
you where to find these controls.    

Dialog Box  What is Saved?  Menu Access  

--  

• The Organizer  

• The Script Panel  

• The Matrix Image Thumbnails 

Right-click on window title bar 
and choose:  

• Show Organizer 

• Show Script Panel 

• Show Image 

Thumbnails 

Matrix Properties  

• Matrix Long Name, Units, Comments. 

• Column width settings.  

• Column number Display (decimal, 

scientific, engineering). 

• Column Digits and data storage 

requirements. 

Matrix:Set Properties  

Matrix 
Dimensions and 

Labels  

• Numbers of rows and columns in the 

matrix, xy coordinates, XYZ axis labels. Matrix:Set 
Dimensions/Labels...  

Set Values 
• Formula used to create or transform 

matrix values. Matrix: Set Values ...  

ASCII Import 
Options  

• ASCII import options pertinent to the 

matrix window are saved with the 

template. 
File:Import:Single ASCII  
File:Import Multiple ASCII  
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10.4 Simple Manipulation of Matrix Data 

  

Utility  Menu Access  

• Flip or Rotate Matrix: Rotate90 
Matrix: Flip: Vertical 
Matrix: Flip: Horizontal  

• Expand (by interpolation) 
Matrix: Expand  

• Shrink (by averaging) 
Matrix: Shrink  

• Transpose 
Matrix: Transpose  

• Convert to Worksheet 
Matrix: Convert to Worksheet  

10.5 Setting Matrix Values 

  The Set Values dialog box is used to generate or transform data in a matrix object.  

To open the Set Values dialog box, make sure that the matrix object is active, then:  

1. From the menu, choose Matrix: Set Values.  

or  

1. Select the matrix by clicking in the upper-left corner (in the empty header cell just below the matrix 

icon/name), then right-click on the matrix and choose Set Matrix Values from the shortcut menu. 
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Menu 
Commands  

• Formula: Load a saved formula into the matrix formula box. Formula are 

saved using Formula: Save or Formula: Save As.... 

• Mat(1): Use the menu to include matrix objects in either your matrix formula 

or your Before Formula Scripts (matrix object reference is inserted at the 

cursor). A Matrix Browser is available to help in selecting the correct objects. 

Objects are listed by object index. 

• Mat(A): Similar to Mat(1) menu functionality but matrix objects are listed by 

object Long Name, if one exists. 

• Function: Add LabTalk functions to your expressions (function name is 

inserted at the cursor).  

• Variables: Add a variable or a constant to Matrix Formula or Before 

Formula Scripts; Add range variables (including by selection) or file 

metadata, to Before Formula Scripts. 

Matrix Formula  

• Add a single line expression for generating data. Functions, conditional 

operators and variables can be used. 

Before Formula 
Scripts  

• Enter one or more lines of LabTalk script to be executed before the expression 

in the Matrix formula box is executed.  
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Use the Before Formula Scripts panel at the bottom of the Set Values dialog box to 
define variables or LabTalk functions that you wish to use in your matrix formula.  

Click the Search and Insert Functions button to search for built-in LabTalk 
functions.  

10.6 Converting Worksheets to Matrixes 

There are four methods for converting worksheet data to matrix data.    

Method  Conversion Type  Notes  

Direct  

• X across columns 

• Y across columns 

• No X and Y 

Ideal for spreadsheet data that 
conforms to the following:  

• X data values in the 1st 

column, Y data values in the 

1st row and Z values in 

columns 2 to N and rows 2 

to M.  

• Y data values in the 1st 

column, X data values in the 

1st row and Z values in 

columns 2 to N and rows 2 

to M.  

Expand  

• Row 

• Column 

Some ASCII files have an upper limit 
for characters allowed on a single line. 
Use this method when your file breaks 
a single line of data across multiple 
lines.  

• Expand by Row: specifies 

the number of ASCII file 

rows comprising one matrix 

row. 

• Expand by Column: 

specifies the number of 

ASCII file columns 

comprising one matrix 

column. 



Origin User Guide 

90 

Method  Conversion Type  Notes  

XYZ 
Gridding  

• Regular 

• Sparse  

• Random (Renka Cline)  

• Random (Shepard)  

• Random (Thin Plate Spline)  

• Random (Kriging Correlation)  

• Random (Weighted Average) 

Conversion Type depends upon XY 
spacing:  

• Choose Regular applied for 

data that are regularly 

spaced in XY. 

• Choose Sparse when you 

have missing values. 

• Choose Renka-Cline, 

Shepard, TPS, Kriging or 

Weighted Average 

methods for data that are 

irregularly spaced in XY. 

XYZ Log 
Gridding  Methods same as XYZ Gridding  Calculates logarithmic values for X 

and Y, then performs XYZ Gridding.  

10.7  Converting Matrixes to Worksheets 

   

There are two methods for converting matrix data to worksheet data: 

 

• Direct: This copies the Z values in the matrix to a worksheet with no reordering. If the matrix 

consists of M rows by N columns of Z values, this method produces a worksheet which has M rows 

and N columns. By default, the X and Y coordinates of the matrix Z values are not copied to the 

worksheet. You can opt to copy X coordinates to the 1st worksheet row or a parameter row and the Y 

coordinates to the 1st worksheet column.  
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• XYZ Columns: This method produces a worksheet with three columns: an X, a Y and a Z column. 

The X and Y columns contain the X and Y coordinate values of the matrix Z values. The matrix Z 

values are contained in the worksheet Z column.  

 

10.8  Profiling Matrix Data 

Data in a matrix can be viewed in profile -- either in the X, Y or arbitrary cross-section.  

1. Activate the matrix object and choose Plot > 2D: Profile: Image Profiles from the main menu.  
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This creates an image plot and opens the Image/Contour Profile dialog box. Use the dialog box to specify X 
and/or Y profile plots and the location and appearance of the cross-sectional lines. Note that this dialog box is 
interactive. You can make adjustments to your image profile -- move the cross-sectional lines or change the 
configuration or the appearance of the plots -- without closing the dialog box. After closed the dialog box, a 
button Profiles...will appear at the right-top corner of graph window, which can be used to reopen the 
Image/Contour Profiles dialog. 

 

10.9 Topics for Further Reading 

• Matrix Books, Matrix Sheets and Matrix Objects 

• Matrix Book and Matrix Sheet Operations 

• What is Saved with the Matrix Template? 

• Matrix Dimensions and XY Coordinates 

• Matrix Object Data Properties 

• Setting Matrix Values 

• Matrix Conversion and Gridding 

• Creating 3D and Contour Graphs from a Virtual Matrix 

• Viewing and Profiling Matrix Data 

http://www.originlab.com/doc/Origin-Help/MatBk-Mats-MatOb
http://www.originlab.com/doc/Origin-Help/MatBk-Mats-Operation
http://www.originlab.com/doc/Origin-Help/MatBk-Template-What-is-saved
http://www.originlab.com/doc/Origin-Help/Mats-Dim-XYCoord
http://www.originlab.com/doc/Origin-Help/MatOb-DataProperty
http://www.originlab.com/doc/Origin-Help/Set-Mat-Value
http://www.originlab.com/doc/Origin-Help/Matrix-Conversion-Gridding
http://www.originlab.com/doc/Origin-Help/Plot-3D-Contour-VirtMat
http://www.originlab.com/doc/Origin-Help/View-Profile-MatData
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11 Graphing 

 

11.1 Creating a Graph 

Graphs can be created from both hard data and from mathematical functions. With Origin, you can create over 
100 graph types using Origin's built-in graph templates. Each of these graphs has been specifically chosen for 
its applications in various technical fields.  

All graph types are accessible from the Plot menu. Note that while most graph types also have a 
corresponding 2D Graphs or 3D and Contour Graphs toolbar button, some do not. Until you've had time to 
familiarize yourself with available toolbar buttons, the Plot menu should be your "go to" place for creating 
graphs. 

Creating most graphs involves just two steps.  

1. Select your data.  

2. Select the plot type.  

Some Origin graph types have very specific data requirements. Other graphs can be created from multiple 
data arrangements. See the Origin Graph Types section for specific requirements.  

11.1.1 Creating Graphs from Worksheet Data 

Origin's most generic graph types -- line, column/bar, pie -- plus a lot of the more specialized types, are 
created from worksheet data. The following quick tutorial demonstrates importing an ASCII data file and 
creating a simple graph. 

 

Tutorial: One click to create graph with selected data  

1. Open a new workbook and select File: Import: Single ASCII... from the main 

menu.  

2. Choose the file Samples/Curve Fitting/Multiple Gaussians.dat and click Open. 

3. Now highlight columns B(Y), C(Y), D(Y) and E(Y) by clicking and dragging across 

the four column headings. 

4. Click Plot > 2D: Line & Symbol: Line & Symbol. A graph window is created with 

four line and symbol plots. Note that the plots differ by line color and by symbol 

type. 

5. Return to the worksheet, and again select columns B(Y), C(Y), D(Y) and E(Y). 

6. This time, select the Plot > 2D: Multi-Panel: 4 Panel menu item. Note that a 

very different plot is created using the same datasets. 

We were able to quickly create two different graphs using the same data. The chapter Customizing Graphs 
discusses customizing graphs and saving templates in more depth.  

We are also able to create 3D plot types from worksheet data. The following tutorial demonstrates creating a 
3D surface plot, then overlaying it with a 3D scatter plot.  

http://www.originlab.com/doc/User-Guide/Graphing
http://www.originlab.com/doc/User-Guide/Customizing-Graphs
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Tutorial: 3D Surface Plot from XYZ Data  

1. Create a new, empty workbook window and import the file \Samples\Matrix 

Conversion and Gridding\XYZ Random Gaussian.dat. 

2. Highlight column C and right click. Select Set As: Z from the fly-out menu. 

3. Select Plot > 3D: Surface: 3D Colormap Surface to create a 3D Colormap 

Surface plot. 

4. Select the Graph: Layer Contents... menu item or right click the layer icon on the 

left-top of the graph to open the Layer Contents dialog. In this dialog, click on 

drop-down next to the button and select 3D Scatter/Trajectory/Vector 

from the fly-out menu. 

5. Select column C from the left panel and click on the Add Plot button to add 

the 3D scatter plot to the graph. Click OK to close the dialog. 

6. Double-click on the plot to open the Plot Details dialog. In the left panel, expand 

the Layer1 node and then expand the 2nd node which represents the scatter plot. 

Click and select the branch named Original. Be sure to leave the node-level check 

box selected, otherwise this plot will be hidden. 

7. In the Symbol tab on the right side, set Shape to Ball, Size to 12 and Color to 

Color Mapping: Col(C). 

8. In the Drop Lines tab, clear the Parallel to Z Axis check box. 

9. Select Layer1 from the left panel of the Plot Details dialog. In the Lighting tab, 

under Mode, select Directional. Click OK to close the dialog. 

10. Click on the scatter plot in the graph to select this plot, then in the Style toolbar, 

click on the button and select the Rainbow palette.  

Your graph should look like this:  

:   
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You can hold down the R key on your keyboard and use the mouse to freely rotate the 
surface. With the pointer tool active, click on the layer for additional controls to move, 
stretch and rotate the surface.  

11.1.1.1 Worksheet Column Plot Designations 

 The labels (X), (Y), (Z), etc. in column headings are referred to as the Column Plot Designation. Columns 
can also be designated as Label, Disregard, Y Error or X Error. Each plot type has its own data 
requirements and these work in concert with settings saved in the graph template, to quickly create a graph.  

To set the Column Plot Designation, select a column or multiple columns, then from the menu choose 
Column: Set as:<option> or right click and choose an option from the Set As: context menu.  

In the 1st tutorial above, we plotted 2D graphs, which require Y data. The Y data were automatically plotted 
against the X column data to their left. In 2nd tutorial, we plotted a 3D graph from Z data. The Z data were 
plotted against X and Y data columns to the left of the Z data column.  

Note: For a complete explanation of Column Plot Designations and how they affect plotting behavior, 

consult the Origin Help file topic The Column Properties Dialog Box, Properties tab Settings.  

11.1.1.2 Selecting Worksheet Data 

 There are a number of ways to select data for plotting:  

• Single column: Click on the column heading, e.g. B(Y) 

• Multiple columns: To select a small number of contiguous columns, click on the first column heading and 

drag the pointer to the last column heading. To select a large number of contiguous columns, click on the 

first column heading, use the scroll bar at the bottom of the worksheet to locate the last column, then 

press the SHIFT key and click on the last column heading. To select non-contiguous columns, press the 

CTRL key while clicking on the desired column heading. 

• A range in a column: Click on the first cell of the range and drag to the last cell of the range. 

• Multiple ranges within a column: Select one range. Press the CTRL key while selecting each range. 

When plotting, each range will be treated as a separate data plot in a plot group. 

• Ranges across multiple columns: If cells are contiguous, click on the first cell and drag to the last cell. 

If cells are not contiguous, press the CTRL key while selecting each range. Each range selection will be 

treated as a separate data plot in a plot group. 

• Range(s) across all columns: Click on the first row heading and drag to the last row heading, to select 

multiple rows. This will select data in all columns in the worksheet. Press the CTRL key while selecting row 

headings for non-contiguous rows. Each range selection will be treated as a separate data plot in a plot 

group. 

• Entire worksheet: Press CTRL+A to select the entire worksheet; or mouse over the bottom-right corner 

of the blank cell in the upper-left corner of the worksheet. When the pointer becomes a downward-

pointing arrow, click to select the entire worksheet. 

• Specific columns: To select columns by data in column label rows (header rows); or to select columns 

using a pattern, choose Edit: Select. 

http://www.originlab.com/doc/User-Guide/Worksheets-Columns
http://www.originlab.com/doc/Origin-Help/ColProperties-Dialog-Properties-Tab
http://www.originlab.com/doc/User-Guide/Graphing
http://www.originlab.com/doc/User-Guide/Graphing
http://www.originlab.com/doc/User-Guide/Graphing
http://www.originlab.com/doc/User-Guide/Graphing
http://www.originlab.com/doc/User-Guide/Worksheets-Columns
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11.1.2 Creating a Graph from Matrix Data 

 As discussed in the Matrix Book, Matrix Sheets and Matrix Objects chapter, a matrix is a dataset of Z values 
arranged as an array of columns and rows which are linearly mapped to X (column) and Y (row) values. Matrix 
data is used to create 3D, contour and heatmap graphs -- all of which require require "3D" data. In earlier 
versions of Origin you had to have your data in a matrix to create such plot types but this is no longer the case 
(see discussion of the Virtual Matrix below). A few graph types such as a color-filled surface with error bars 
still require matrix data.  

Note, however, that there are still many situations in which you will be creating 3D plots from matrix data. If 
you have data in worksheet form and you need to convert it into a matrix form, see Converting Worksheets to 
Matrixes.  

Once your data are in a matrix form, plotting matrix data is simple: activate the matrix window then select 
your plot type using a Plot menu command or corresponding 3D and Contour Graphs toolbar button. Note 
that you cannot select a portion of the matrix when plotting 3D graphs. You can, however, choose a subset of 
the data plot to display once the graph is created. See Editing Plot Range in the Manipulating Data Plots 
section of this chapter.  

11.1.2.1 The Virtual Matrix 

The Virtual Matrix concept was covered in the Matrix Book, Matrix Sheet and Matrix Object chapter of this 
Guide. To recap, a virtual matrix is block of worksheet cells which contain Z values, with X and Y coordinates in 
the first row or column label row, and column. X and Y coordinates don't have to be evenly spaced and can 
even be in the form of text or date/time data.   

When selecting and plotting virtual matrix data to 3D, Contour and Heatmap graph types, Column Plot 
Designations are ignored and a dialog box is opened where you designate your X and Y coordinates. The 
intersecting data points are then treated as Z values.  

 

Tutorial: Contour Plot from Virtual Matrix  

1. With a new workbook active, use the File: Import: Import Wizard... menu to 

open the Import Wizard dialog. 

2. Press the browse button in the dialog and select the file Waterfall.dat from the 

Samples\Graphing subfolder. 

3. This file has an import filter already associated with it. Press the Finish button to 

import the file.  

4. With the workbook active, press CTRL+A to select the entire sheet. 

5. Now select the Plot > 2D: Contour: Contour - Color Fill menu item. The plotvm 

dialog will open.  

6. In the dialog, set the Y Values in drop-down to Column Label, and then set the 

Column Label drop-down to Excitation Wavelength(nm). 

7. Set the X Values in drop-down to 1st column in selection, then press OK to 

close this dialog. 

8. The contour plot will be created. 

9. Use the Graph: Speed Mode... menu item, then in the dialog that opens, set the 

Speed Mode drop-down to Off and press OK. This will turn off speed mode so that 

all data points are plotted (see the discussion of Speed Mode, below). 

10. Click on the contour plot to select this data plot, then from the Style toolbar, click 

the Palette button and then select the Pumpkin Patch palette.  

http://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
http://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
http://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
http://www.originlab.com/doc/User-Guide/Graphing
http://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
http://www.originlab.com/doc/User-Guide/Graphing
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Your graph should look similar to the image below:  

 

 

Once you customize your contour levels and colors, you can save your settings as a 
Theme, or simply copy-paste your customizations from one graph to another. To save a 
Theme, right-click on the graph and choose Save Format as Theme; or use the 
Colormap Theme controls on the Colormap/Contours tab of the Plot Details dialog 
box.  

11.1.3 2D and 3D Function Plots 

    To create function plots and parametric function plots, select File: New: Function Plot menu. There are 
four options to choose from:  

Type  Function Form  

2D Function Plot  y = f(x)  

2D Parametric Function 
Plot  

x = f1(t) 
y = f2(t)  

3D Function Plot  z = f(x, y)  

3D Parametric Function 
Plot  

x = f1(u, v) 
y = f2(u, v) 
z = f3(u, v)  

http://www.originlab.com/doc/User-Guide/Customizing-Origin
http://www.originlab.com/doc/Origin-Help/PD-Dialog-ColorMapContour-Tab
http://www.originlab.com/doc/Origin-Help/PD-Dialog-ColorMapContour-Tab
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These plot types are also accessible from the function plot buttons on the Standard toolbar.  

 

 

 

Tutorial: 3D Function and 3D Parametric Function in Same Layer  

1. From the menu, choose File: New: Function Plot: 3D Parametric Function 

Plot... 

2. In the dialog that opens, click on the arrow button at the top right side of the 

dialog, and from the fly-out menu select the built-in example Partial Torus 

(System) and press OK to close the dialog. The function plot will be created. 

3. With the function plot window active, invoke the menu File: New: Function Plot: 

3D Function Plot.... 

4. In the dialog that opens, enter -5 and 5 for the From and To edit boxes for x and 

y scale. 

5. In the Z(x,y) edit box, enter 0. 

6. Set the drop-down at the bottom left corner of the dialog to Add to Active Graph 

and press OK to close dialog. 

7. The Z=0 plane will be added to the graph, and the plane will properly intersect the 

parametric surface plot. You can hold down the R key and use the mouse to freely 

rotate the plot.  

 



Graphing 

99 

 

• Some function plot dialogs provide sample formulas. Click the arrow button beside 

Theme at the top of the dialog box to access them. You can download more 

examples at http://originlab.com/3dfunctions. 

• For 2D parametric, 3D, and 3D parametric function plots, data is generated when 

the function plot is created. To create data for 2D function plots, right-click the plot 

and choose Make dataset copy of Function or if on the Function tab in Plot 

Details, click the Workbook button. 

• Besides function plots, you can also create graphs with all built-in and user-defined 

nonlinear curve-fitting or surface-fitting functions. From the menu, choose 

Analysis: Fitting: Simulate Curve... or Simulate Surface.... You can even add 

noise to the plot. Corresponding data is created as well.  

11.2 Plotting without Using Column Plot Designations 

 While Column Plot Designations remain an important concept, they are no longer required by many Origin 
graphing and analysis operations. The Plot Setup dialog box allows you to freely specify which column is used 
as X, Y, etc. when plotting, thereby overriding the Column Plot Designations.  

In order to make full use of the Plot Setup dialog box, you need to have some familiarity with the hierarchy of 
objects contained in the Origin graph window.       

11.2.1 Pages, Layers, Plots and the Active Plot 

 Each Origin graph window is comprised of a single, editable graph page. The graph page is defined by the 
white area inside the graph window. Anything that lies outside the page is not printed or exported. By default, 
the dimensions of the graph page are defined by the printable area of your default printer driver; without 
adjusting settings, a printed graph should fill the printed page.  

 

http://originlab.com/3dfunctions
http://www.originlab.com/doc/User-Guide/Worksheets-Columns
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The graph page must contain at least one, and may contain as many as 1024, graph layers. In turn, each 
graph layer generally contains one or more data plots (graphical depictions of datasets). Note that the graph in 
the image above contains three graph layers, represented by the three non-printing layer icons in the upper-
left corner of the graph page. Note that there is one layer icon which is highlighted, indicating the active layer. 
Just as there is only one active layer, there is only one active plot in a graph. Usually, the active plot is the 
first plot in the active layer. To verify which plot is active, click on the Data menu while the graph is active. 
The active plot will have a check mark beside it.  

 

 
The hierarchical structure of the graph page can be seen in these places:  

• The Plot Details Dialog Box (Format: Page Properties ...) 

• The Object Manager (View: Object Manager) 

• The Plot Setup Dialog Box (Graph: Plot Setup...) 

 

 

11.2.2 The Plot Setup Dialog Box 

The Plot Setup dialog box is a flexible all-in-one plotting tool for creating graphs and manipulating the data 
plots in an existing graph.  

• Creating graphs without regard to Column Plot Designations 

• Creating graphs from a combination of data sources: multiple worksheets, workbooks, matrix books, loose 

datasets, etc. 

• Creating graphs combining multiple plot types. 

• Adding, removing, replacing data plots. 

• Grouping or ungrouping data plots. 

• Reordering data plots in a layer or moving data plots to another layer. 
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To create a graph with the Plot Setup dialog, make sure no data is selected in the active worksheet and 
choose the plot type.  

To open the Plot Setup dialog for an existing graph window, right-click on any layer icon in the upper left 
corner of the graph window and select Plot Setup..., or choose menu Graph: Plot Setup....  

 

 

Tutorial: Creating a Simple Line Plot with the Plot Setup Dialog Box  

1. Click the New Workbook button on the Standard toolbar. 

2. Click File: Import: Single ASCII, browse to the Origin installation folder and import 

the file \Samples\Curve Fitting\Step01.dat. Starting from column B, columns are 

actually paired - X data and Y data -- but by default all columns are assigned a "Y" 

Column Plot Designation on import. 

3. Without selecting any data, click Plot > 2D: Line: Line. This opens the Plot Setup 

dialog box. 

4. Click the two "double-arrow" buttons to show all three dialog box panels. 

5. In the middle panel, select the "X" box for Column B (Sensor Ax) and the "Y" box for 

Column C (Sensor Ay), then click the Add button to add the plot to Layer 1 in the 

bottom panel.  

6. Select the "X" box for column D (Sensor Bx) and the "Y" box for Column E (Sensor 

By), then click Add. 

7. Select the "X" box for column F (Sensor Cx) and the "Y" box for Column G (Sensor Cy), 

then click Add. Three plots are added to Layer 1. 
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8. Press CTRL and click on each plot in the bottom panel to select all three, then right-

click and choose Group. 

9. Click OK to create a grouped line plot. 

 

 

Tutorial: Creating a Graph with Data from Multiple Worksheets  

1. Click the New Workbook button on the Standard toolbar. 

2. Click File: Import: Multiple ASCII, browse to the Origin installation folder and select 

Sensor01.dat, Sensor02.dat and Sensor03.dat under \Samples\Curve Fitting\ to 

import. After Import, 3 workbooks are created.  

3. Without selecting any data, click Plot > 2D: Line+Symbol: Line+Symbol. This 

opens the Plot Setup dialog box. 

4. Expand the top panel if it is hidden. From the Available Data list, choose 

Worksheets in Folder.  

5. Select Sensor01, Sensor02 and Sensor03 sheets in the top panel. 

6. In the middle panel, select the "X" box for Column A (Displacement) and the "Y" box 

for Column B (Sensor Output), then click the Add button.  

7. Click OK to create a grouped Line+Symbol plot using Sensor Output columns from 3 

worksheets. 
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• The Plot Setup middle panel only allows choosing one X column at a time.  

• If your worksheet is set up with the correct Column Plot Designations (e.g. XYXY) 

but you only want columns with same Long Name, click the toggle in the upper-

right corner of middle panel so that only plottable columns show (e.g. for 2D plot 

types, X columns are not shown). Then you can sort the columns and select all 

columns with same Long Name and plot them together. The Y columns will be 

plotted against corresponding X columns. 

• To change a data plot's type, choose the corresponding plot in bottom panel. 

Corresponding X and Y columns will show in middle panel. Choose a new plot type 

in middle panel and click the Replace button.  

• All data plots in a group share the same plot type. To change the plot type of a 

single plot in a group, right-click the Group node (bottom panel) and Ungroup first.  

• Drag and drop data plots to move them to different layers. 

• If the bottom panel is hidden and you have selected columns in the middle panel, 

you can directly click the OK button to create your graph. 
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11.3 Manipulating Data Plots 

The following sections discuss higher level modifications to existing graphs such as changing plot type, adding 
or removing plots from the layer and controlling the density of plotted points (Speed Mode). For more detailed 
plot customizations, including those involving such things as changing plot symbols, colors, and legend 
customizations, see the Customizing Graphs chapter.  

 

The following methods of manipulating data plots in the graph window are fairly easy to 
use. Thus, you may want to choose File: Open Template and pick your template to 
create a blank graph window. Then, using the methods below you can add and group 
data plots in the graph.  

11.3.1 Changing Plot Type 

 Some Origin plot types (e.g. scatter, line, line+symbol) allow you to interchange the plot type of an existing 
plot with a few other select plot types. Some examples:  

• Scatter, line, line+symbol, column/bar are interchangeable. 

• 3D scatter/trajectory/vector, 3D bars, 3D surface are interchangeable. 

 
To change the plot type of an existing plot:  

• Right-click on the data plot and choose Change Plot to: Graph Type from the shortcut menu. 

• Click on the data plot and choose Format: Plot Properties and in Plot Details choose from the Plot Type 

drop-down list. 

• Click on the data plot, then click one of the supported graph toolbar buttons. 

 
Note that if you switch plot types and the selected plot is part of a plot group, all plots in the group are 
switched.  

11.3.2 Exchanging Data Plots 

 You can quickly change the data source (X, Y, or worksheet) of a plot using these context menu commands. 
Right-click on a data plot, then select one of these options:  

• Change X. This menu item allows you to change the assignment of X data to another data column in the 

same worksheet.  

• Change Y. This menu item allows you to change the assignment of Y data to another data column in the 

same worksheet. 

• Change Worksheet. This menu item allows you to replace both X and Y with data from another 

worksheet. The selected worksheet should have the same Short Names, the same Column Plot 

Designations and the same row index range as the current worksheet. 

http://www.originlab.com/doc/User-Guide/Customizing-Graphs
http://www.originlab.com/doc/User-Guide/Graphing
http://www.originlab.com/doc/User-Guide/Worksheets-Columns
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If you have a grouped data plot, then clicking once on any of the plots in the group will 
select the entire group. Click a second time to select a particular member of the group. 
The context menu options to change worksheet, X, or Y are available only when a 
single data plot is selected.  

 

Tutorial: Changing X and Y assignment of a data plot  

1. Start with a new workbook and import the file automobile.dat from the 

Samples\Statistics sub-folder of the Origin installation folder. 

2. Select the Gas Mileage column and select the Plot: Symbol: Scatter menu item. 

The Gas Mileage column is plotted against the default X column Year. 

3. Right-click on the data plot and select Change X: Engine Displacement. The 

Gas Mileage column is now plotted against Engine Displacement.  

Note: If new data is significantly outside of the current range for X or Y axes, you will be asked if the graph 
should be rescaled. If data are not significantly different, you may want to manually rescale the graph (Hot 

key: CTRL+R).  

 

If you perform analysis on the data plot (e.g. linear regression with Recalculate set to 
Auto), the fit results will automatically update when you change X/Y or the worksheet.  

11.3.3 Adding, Removing and Hiding Data Plots 

 Use the following methods to add or remove data plots from a graph.  

11.3.3.1 Adding Data with the Add Plot to Layer Menu Command 

This is a simple method for adding a range of data to an existing Line, Scatter, Line + Symbol, Column or 
Area graph:   

1. Highlight your worksheet data.  

2. Go to the graph window where you want to add data. If there are multiple layers in the graph, press the 

layer icon to activate the desired layer. 

3. From the menu, choose Graph: Add Plot to Layer: Graph Type. 

 

• You can use the Graph: Add Error Bars... menu item to add error bars, calculated 

from statistics such as standard deviation. 

• Error data will be output beside the data column in the worksheet. This only works 

for the active plot. You can set the active plot from the Data menu. The active plot 

has a check mark beside it. 
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11.3.3.2 Adding Data by Drag and Drop 

 You can add data to a graph by drag and drop. When using this method, Origin relies on worksheet Column 
Plot Designations to create the plot.  

1. Select the worksheet data (one or more columns or a range of one or more columns).  

2. Move the mouse over the left or right edge of the selected range.  

3. When the pointer looks like this , hold down the left mouse button and drag the data to the graph 

window. Release the mouse. 

4. If there are multiple layers in the graph, drag the data to the desired layer, then release the mouse. 

 

Usually the current plot type is used when plotting by drag-and-drop. To change the 
global plot type to use when drag and drop, choose Tools: Options... from the main 
menu. Go to the Graph tab and change the global Drag and Drop plot type.  

11.3.3.3 Adding and Removing Data with the Layer Contents Dialog Box 

  Open the Layer Contents dialog box by double-clicking or right-clicking on the layer icon(s) in the top left 
corner of the graph page. Controls in the left panel can be used to filter and list available datasets. The right 
panel lists datasets that are plotted in the active layer.  

 

Controls in the center of the dialog box allow you to add or remove plots from the active graph layer. When 
adding data to the graph, click the list button (downward-pointing arrow) to pre-select the plot type before 
adding data to the layer. Use controls in the right panel to group or ungroup plots, or re-order plots in the 
layer.  

http://www.originlab.com/doc/User-Guide/Worksheets-Columns
http://www.originlab.com/doc/User-Guide/Worksheets-Columns
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11.3.3.4 Adding, Removing, Replacing or Hiding Data Plots with the Plot Setup Dialog Box 

 Among other things, the Plot Setup dialog box can be used to add or remove data plots from the graph.  

1. To add plots to the graph, use the top panel of Plot Setup to identify your source data. 

2. Use the controls in the middle panel to specify the plot type and how the data selection should be treated 

(as X, Y, yError or Label). 

3. In the bottom panel, choose the Layer to which you want to add plots, then click the Add button. 

4. To remove a plot from the layer, select the plot in the bottom panel, then right-click and choose Remove. 

5. To hide a plot, uncheck the Show check box for the plot. 

6. To replace a plot, select the plot in bottom panel, then change the X and Y selection and plot type in 

middle panel and click the Replace button. 

 

11.3.3.5 Adding Data by Direct ASCII Import 

 You can import ASCII files directly into the active graph window using the the Import ASCII toolbar button. 
Note that this method works only with files having a simple structure and it supports only the simplest of 
graph types - Line, Scatter, Line + Symbol, Column and Bar charts.  

1. Click the Import ASCII  button. This opens the Import ASCII dialog box.  

2. Choose a file.  

3. Click Open.  

The file is imported and plotted in the active graph window.  

11.3.3.6 Adding Data by Copying and Pasting a Plot 

You can copy a plot from an existing graph window and paste it into the same or another window.  

1. Click on the plot to select it and press CTRL+C.  

2. Click on the target graph and press CTRL+V.  



Origin User Guide 

108 

Simultaneously, a ClipbN worksheet is created. You can open this worksheet by double-clicking on the plot, 
then clicking the Workbook button at the bottom of Plot Details; or right-click on the plot in the graph window 
or in the Object Manager and choose Create worksheet ClipbN.  

 

You can also "paste" a copied plot to a worksheet cell. Select a cell and press CTRL+V 
to fill the column(s) with plot data.  

11.3.3.7 Removing or Hiding Plots with the Object Manager 

 The Object Manager is a dockable panel that allows for easy manipulation of graph layers and data plots. 
See the section on The Object Manager in this Guide.  

To hide or remove plots, right-click on a plot and choose from the shortcut menu:  

 

• To show or hide plots of the same Long Name. 

• Show all plots. 

• Remove a plot from the graph window (not the same as hiding). 

 

• When you right-click on a plot, there is a Remove shortcut menu item. If the plot 

is part of a group, the entire group will be removed. 

• When you right-click on a plot, you can use the Hide Data Plot and Hide Others 

shortcut menu items to quickly hide selected plots (restore plots by enabling their 

display in the Object Manager or in Plot Details). 

http://www.originlab.com/doc/User-Guide/Origin-Interface
http://www.originlab.com/doc/User-Guide/Graphing
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11.3.3.8 Removing or Hiding Data with Plot Details 

In the left panel of the Plot Details dialog box (Format: Plot Properties), right-click on a plot and choose 
Remove or Hide from the context menu. Remove will delete the data plot from the graph so if you just want 
to temporarily hide a plot, choose Hide. Neither of them will delete data from worksheet or matrix.  

11.3.3.9 Deleting Plots using the Delete Key 

Click on a data plot (either in the graph window or Object Manager) and press the Delete key. If the selected 
plot is part of a group, the entire group is deleted. This action does not delete worksheet or matrix data. To 
restore the deleted plots, choose Edit: Undo Remove Plot from the main menu.  

11.3.3.10 Editing Plot Range 

Once a graph is made, you can edit the plot display range, specifying only a portion of the plotted data:  

• Right-click on the plot and choose the Edit Range... shortcut menu command. Edit the From and To 

values. 

• In the right panel of the Layer Contents dialog box (Graph: Layer Contents), turn on the Range column 

by right-clicking on the column headings and choosing Range. Click on a plot's range values, then click 

the ... button that appears to the right side of that column. 

• In the bottom panel of Plot Setup (Graph: Plot Setup), Click on the plot range in the Range column and 

click ... button that appears to the right side of that column. 

 

Choose Graph: Rescale to Show All menu to rescale the graph after editing plot 
range.  

11.3.4 Grouping Data Plots 

 When you make multiple range or column selections, then create a graph, Origin groups the resulting data 
plots in the graph layer. This applies to most 1D (statistical) and 2D graphs, plus 3D XYY (XYY 3D bar, 3D 
ribbon, 3D wall, and 3D waterfall plots) and 3D XYZ (3D scatter, 3D bar) graphs.  

Grouping provides for quick creation of presentation-ready graphs because each plot in the group is assigned a 
differentiating set of plot attributes (line color = black, red, green...; symbol shape = square, circle, 
triangle...; etc.). Assignments are made by cycling through a pre-determined (user-modifiable) increment list 
of styles. For instance, the first plot of a grouped line plots might be denoted by a black line; the second plot 
might be denoted by a red line (the second color in the color list), the third plot by a green line (the third color 
in the color list), and so on.  

 

Tutorial: Creating a simple grouped data plot  

1. Open a fresh worksheet and click the Import Single ASCII button on the 

Standard toolbar. 

2. Browse to the Samples\Graphing subfolder in the Origin software folder and Open 

GROUP.DAT. 

http://www.originlab.com/doc/Origin-Help/PD-Dialog-Group-Tab
http://www.originlab.com/doc/Origin-Help/PD-Dialog-Group-Tab


Origin User Guide 

110 

3. Select B(Y), C(Y), and D(Y) columns 

4. Click the Line & Symbol button on the 2D Graphs toolbar. Note that line and 

symbol color and symbol type are automatically differentiated for each plot.  

 

Tutorial: Grouping (or ungrouping) plots manually  

• Via the Layer Contents dialog box 

1. To open the Layer Contents dialog box, double-click on the layer n icon in 

upper-left corner of the graph window.  

2. To create a group, select the desired data sets from the Layer Contents list (use 

CTRL + select, SHIFT + select, or simply drag the mouse to select multiple data 

sets). 

3. Click Group. Note that each plot in Layer Contents is now preceded by a gn (for 

"group1", "group2", etc.). 

4. To ungroup, click on one of the grouped data plots in the Layer Contents list and 

click Ungroup. 

 

• Via the Plot Setup dialog box 

1. To open the Plot Setup dialog box, ALT + double-click on the layer n icon in 

upper-left corner of the graph window.  

2. To create a group, select the desired plots from the Plot List (use the CTRL or 

SHIFT keys to select multiple data sets). 

3. Right-click and select Group. Note that a Group icon now precedes the selected 

plots in the Plot List. 

4. To ungroup, right-click on the Group icon and choose Ungroup from the shortcut 

menu. 
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11.3.5 Speed Mode 

  With Speed Mode, you can control the number of data points displayed in a graph layer. This option is most 
useful when working with large data sets. Speed Mode can be turned on for any 2D or 3D graph. When Speed 
Mode is enabled, the layer icon displays in red and a Speed Mode is On watermark appears in the layer. The 
watermark is not included when printing, copying, or exporting the graph.  

 

To adjust Speed Mode settings:  

1. With your graph active, select Format: Layer Properties from the Origin menu. 

2. Select the Size/Speed tab. 

3. For plots created from worksheet data, Select the Worksheet Data, Maximum Points Per Curve check 

box to enable Speed Mode for all the data plots in the layer that are created from worksheet data. Type 

the desired value (n) in the associated text box. If the number of data points in a data plot exceeds n, 

Origin displays a subset of the data plot containing n points, drawn by extracting values at regular 

intervals from the data set. 

4. For 3D data plots created from a matrix or for contour data in the layer, Select the Matrix Data, 

Maximum Points Per Dimension check box to enable Speed Mode. Type the desired value (n, m) in the 

X and Y text boxes. If the number of data points in a data plot exceeds n or m, Origin displays a subset of 

the data plot composed of -- at maximum -- n by m points. This subset is drawn by extracting values at 

regular intervals from the matrix columns (X) and rows (Y). 

For broad control, you can select Speed Mode from the Graph menu. This opens the speedmode X-
Functiondialog. The dialog lets you specify a number of options for where your changes should apply ( Target 
) as well as a range of Speed Mode settings from Off to On - High.  

http://www.originlab.com/doc/X-Function/ref/speedmode
http://www.originlab.com/doc/X-Function/ref/speedmode
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Click the Enable/Disable Speed Mode button on the Graph toolbar, to toggle 
Speed Mode on/off for all layers in the graph window.  

To turn off the Speed Mode is On watermark:  

1. Select Tools: Options to open the Options dialog box.  

2. Select the Graph tab and clear the Speed Mode Show Watermark check box. 

Notes on Speed Mode:  

• The Speed Mode controls on the Size/Speed tab of the layer's Plot Details only apply to what you 

see on screen. They do not apply to graphs that are printed or exported, by default. If you wish to 

skip points in printouts, use controls in the Print dialog. See the discussion of the Skip Points 

feature as it applies to some graph windows in the Origin Help file. If you wish to apply Speed 

Mode settings to graphic export, please see this discussion of Performance Group controls on 

the Miscellaneous tab of the Plot Details dialog box or use controls under Export Settings node 

in Graph Export dialog. 

• All Speed Mode settings are saved with the graph template. If you make changes to Speed Mode 

settings for a particular graph type, you will have to resave the graph template to make those 

changes permanent. 

• Always exercise caution when using Speed Mode. Since Speed Mode systematically weeds out a 

portion of your data points, it should be kept in mind that any graph in which Speed Mode is 

turned on, may -- or may not -- accurately represent your data, to your satisfaction. Always 

familiarize yourself with your data and adjust and compare Speed Mode settings to ensure that 

trends in your data are accurately depicted. 

11.4 Publishing Your Graph: Copy/Paste, Image Export, Slide Shows and 
Printing 

There are a number of ways to present your finished graph.  

• Copy a graph page and paste it in other applications such as Word, Powerpoint, etc. 

• Export graph page as an image file (raster or vector). 

• Send Graphs to Powerpoint. 

• Printout. 

• Slideshow within Origin. 

• Create Movies. 

Please read details in the Publishing and Export chapter of this User Guide and the "Topics for Further Reading" 
there.  

http://www.originlab.com/doc/User-Guide/Publishing-and-Export
http://www.originlab.com/doc/User-Guide/Publishing-and-Export
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11.5  Origin Graph Types 

 Origin supports over 100 plot types. Origin's 2D graphs are plotted from Worksheet data. Typically, this 
means an "X" column and one or more "Y" columns (or a sub-range of one or more Y columns). A few graphs 
require an additional error bar column. Of the 3D and contour graph types, some are created from XYZ 
worksheet data; some are created from a particular worksheet data arrangement that we call a Virtual 
Matrix; and some are created from Matrix window data. For information on these data arrangements, see 
these sections of this Guide:  

• Different Views of the Matrix (Chapter 9) 

• Creating a Graph from Worksheet Data (this chapter) 

• Worksheet Column Plot Designations (this chapter) 

 

Origin Graph Samples of most 2D and 3D graph types are included with your Origin 
software. To view graphs, supporting data and guidelines for making the graphs, 
choose Help: Origin Central; or click on the Origin workspace to activate Origin and 
press F11 on your keyboard.  

The following is a comprehensive list of Origin 2D and 3D graph types as they appear in the Plot menu. In 
these tables, the Plot menu icon precedes the graph name. The Notes column provides some basic 
information on data requirements. For specific data requirements, follow the link in the Graph Types column.  

 

http://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
http://www.originlab.com/doc/User-Guide/Graphing
http://www.originlab.com/doc/User-Guide/Graphing
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11.5.1 2D Graphs 

 

Origin 2018 adds these new graph types: Bridge Charts (Waterfall Charts to Excel 
users), plus Double-Y Box Charts and Colormapped Line Series graphs. 

  

Plot Menu Group  Graph Types  Notes  

Line  

 Line 

 Horizontal Step 

 Vertical Step 

 Spline 

• Start with a Worksheet. 

• Select one or more Y columns or at 

least a portion of one Y column.  

• Multiple Y columns are grouped in 

layer.  

• If there is an associated X column, X 

column supplies X values; otherwise, 

Y sampling interval or row number is 

used. 

• For specific data requirements, follow 

links in the Graph Types column. 

Scatter  

 Scatter 

 Scatter Central 

 Column Scatter 

 Y Error 

 XY Error 

 Vertical Drop Line 

 Bubble 

 Color Mapped 

 Bubble+ColorMap 

 Error Band 

• Start with a Worksheet. 

• If there is an associated X column, X 

column supplies X values; otherwise, 

Y sampling interval or row number is 

used. 

• For specific data requirements, follow 

links in the Graph Types column. 

http://www.originlab.com/doc/Origin-Help/Line-Graph
http://www.originlab.com/doc/Origin-Help/HorizontalStep-Graph
http://www.originlab.com/doc/Origin-Help/VerticalStep-Graph
http://www.originlab.com/doc/Origin-Help/Spline-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/2DScatter-Graph
http://www.originlab.com/doc/Origin-Help/2DScatterCentral-Graph
http://www.originlab.com/doc/Origin-Help/column-scatter
http://www.originlab.com/doc/Origin-Help/Y-ErrBar-Graph
http://www.originlab.com/doc/Origin-Help/XY-ErrBar-Graph
http://www.originlab.com/doc/Origin-Help/Vertical-Drop-Line
http://www.originlab.com/doc/Origin-Help/Bubble-Graph
http://www.originlab.com/doc/Origin-Help/Color-Mapped-Graph
http://www.originlab.com/doc/Origin-Help/Bubble-Color-Map-Graph
http://www.originlab.com/doc/Origin-Help/Error-Band-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
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Plot Menu Group  Graph Types  Notes  

Line + Symbol  

 Line + Symbol 

 Line Series 

 2 Point Segment 

 3 Point Segment 

 Spline Connected 

• Start with a Worksheet. 

• Select one or more Y columns or at 

least a portion of one Y column.  

• Multiple Y columns are grouped in the 

graph layer (except Line Series). 

• For Line Series graph, select 2 or 3 Y 

columns. 

• If there is an associated X column, X 

column supplies X values; otherwise, 

Y sampling interval or row number is 

used. 

• For specific data requirements, follow 

links in the Graph Types column. 

Function  
 New 2D Plot 

 New 2D Parametric 

• Function plots are not created from 

physical data. 

• Once a function plot is created, you 

can obtain the derived dataset. 

• For more information on function 

plots, follow links in the Graph Types 

column. 

http://www.originlab.com/doc/Origin-Help/LineSym-Graph
http://www.originlab.com/doc/Origin-Help/Line-Series-Graph
http://www.originlab.com/doc/Origin-Help/2Point-Seg-Graph
http://www.originlab.com/doc/Origin-Help/3Point-Seg-Graph
http://www.originlab.com/doc/Origin-Help/Spline-Connected-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/PD-Dialog-2DFunc-Tab
http://www.originlab.com/doc/Origin-Help/PD-Dialog-2DParaFunc-Tab
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Plot Menu Group  Graph Types  Notes  

Bar  

 Column 

 Column + Label 

 Bar 

 Stacked Column 

 Stacked Bar 

 100% Stacked Col 

 100% Stacked Bar 

 Floating Column 

 Floating Bar 

• Start with a Worksheet. 

• For Bar, Column or Column + Label, 

select one or more Y columns 

(multiple Y columns are grouped in 

layer). 

• For Floating Bar/Column, select two Y 

columns. 

• For Stack graphs, select two or more 

Y columns. 

• If there is an associated X column, X 

column supplies X values; otherwise, 

Y sampling interval or row number is 

used. 

• For specific data requirements, follow 

links in the Graph Types column. 

Pie  
 3D Color Pie Chart 

 2D B&W Pie Chart 

• Start with a Worksheet. 

• Select exactly one Y column or a 

range from one Y column. 

• If there is an associated X column, the 

X data are used in the graph legend; 

otherwise row number is used. 

• For specific data requirements, follow 

links in the Graph Types column. 

Area  

 Area 

 Stacked Area 

 100% Stacked Area 

 Fill Area 

 Fill 2 Colors 

• Start with a Worksheet. 

• If there is an associated X column, X 

column supplies X values; otherwise, 

Y sampling interval or row number is 

used. 

• For specific data requirements, follow 

links in the Graph Types column. 

http://www.originlab.com/doc/Origin-Help/Column-Graph
http://www.originlab.com/doc/Origin-Help/Column-label-Graph
http://www.originlab.com/doc/Origin-Help/Bar-Graph
http://www.originlab.com/doc/Origin-Help/Stack-Column-Graph
http://www.originlab.com/doc/Origin-Help/Stack-Bar-Graph
http://www.originlab.com/doc/Origin-Help/100-Stack-Column-Graph
http://www.originlab.com/doc/Origin-Help/100-Stack-Bar-Graph
http://www.originlab.com/doc/Origin-Help/Floating-Column-Graph
http://www.originlab.com/doc/Origin-Help/Floating-Bar-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/3D-Color-PieChart
http://www.originlab.com/doc/Origin-Help/2D-B-W-PieChart
http://www.originlab.com/doc/Origin-Help/Area-Graph
http://www.originlab.com/doc/Origin-Help/StackArea-Graph
http://www.originlab.com/doc/Origin-Help/100-StackArea-Graph
http://www.originlab.com/doc/Origin-Help/FillArea-Graph
http://www.originlab.com/doc/Origin-Help/Fill-2-Colors-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
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Plot Menu Group  Graph Types  Notes  

Multi-Y  

 Double-Y 

 2Ys, Col-Line&Sym 

 Dbl-Y Column 

 3Ys Y-Y-Y 

 3Ys Y-YY 

 4Ys Y-YYY 

 4Ys YY-YY 

 Multiple Y Axes... 

 Stack Lines Y Offset 

 C-map Line Series 

• Start with a Worksheet. 

• Select two or more Y columns. 

• Multiple Y Axes opens interactive 

dialog. Choose plot type, number of 

axes, plots per layer, axis color to 

match plot, etc. 

• For specific data requirements, follow 

links in the Graph Types column. 

Multi-Panel  

 Vertical 2 Panel 

 Horizontal 2 Panel 

 4 Panel 

 9 Panel 

 Stack... 

 Mult Panel by Label 

• Start with a Worksheet. 

• Select one Y column (or range) per 

panel. 

• If there is an associated X column, X 

column supplies X values; otherwise, 

Y sampling interval or row number is 

used. 

• For specific data requirements, follow 

links in the Graph Types column. 

http://www.originlab.com/doc/Origin-Help/Double-Y-Graph
http://www.originlab.com/doc/Origin-Help/2Ys-Column-LineSym-Graph
http://www.originlab.com/doc/Origin-Help/DoubleY-Column-Graph
http://www.originlab.com/doc/Origin-Help/3Y-Y-Y-Y-Graph
http://www.originlab.com/doc/Origin-Help/3Y-Y-YY-Graph
http://www.originlab.com/doc/Origin-Help/4Y-Y-YYY-Graph
http://www.originlab.com/doc/Origin-Help/4Y-YY-YY-Graph
http://www.originlab.com/doc/Origin-Help/MultiY-Graph
http://www.originlab.com/doc/Origin-Help/StackLineYOffset-Graph
http://www.originlab.com/doc/Origin-Help/Colormap-Line-Series
http://www.originlab.com/doc/Origin-Help/Vertical-2-Panel-Graph
http://www.originlab.com/doc/Origin-Help/Horizontal-2-Panel-Graph
http://www.originlab.com/doc/Origin-Help/4Panel-Graph
http://www.originlab.com/doc/Origin-Help/9Panel-Graph
http://www.originlab.com/doc/Origin-Help/Stack-Graph
http://www.originlab.com/doc/Origin-Help/MultiPanel-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
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Plot Menu Group  Graph Types  Notes  

Zoom  
 Zoom  

• Start with a Worksheet. 

• Select at least one Y column or a 

range from at least one Y column. 

• If there is an associated X column, X 

column supplies X values; otherwise, 

Y sampling interval or row number is 

used. 

• For specific data requirements, follow 

the link in the Graph Types column. 

Box  

 Box Chart 

 Interval Plot 

 Marginal Box Chart 

 Bar Chart 

 Box Overlap 

 Box Normal 

 Bar Overlap 

 Bar Normal 

 Scatter Interval 

 Double Y Box 

• Start with a Worksheet. 

• Select at least one Y column or a 

range from at least one Y column. 

• For specific data requirements, follow 

the link in the Graph Types column. 

http://www.originlab.com/doc/Origin-Help/Zoom-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/BoxChart-Graph
http://www.originlab.com/doc/Origin-Help/interval-plot
http://www.originlab.com/doc/Origin-Help/Marginal-Boxes-Charts
http://www.originlab.com/doc/Origin-Help/Bar-chart
http://www.originlab.com/doc/Origin-Help/BoxChart-Graph
http://www.originlab.com/doc/Origin-Help/BoxChart-Graph
http://www.originlab.com/doc/Origin-Help/Bar-chart
http://www.originlab.com/doc/Origin-Help/Bar-chart
http://www.originlab.com/doc/Origin-Help/interval-plot
http://www.originlab.com/doc/Origin-Help/DoubleY-Box-Chart
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Plot Menu Group  Graph Types  Notes  

Histogram  

 Histogram 

 Histogram + Prob 

 Stacked Histogram 

 Marginal Histogram 

 Distribution 

 Histogram w Labels 

• Start with a Worksheet. 

• Select at least one Y column or a 

range from at least one Y column. 

• For specific data requirements, follow 

links in the Graph Types column. 

2D Kernel 
Density   2D Kernel Density 

• Start with a Worksheet. 

• Select at least one Y column or a 

range from at least one Y column. 

• For specific data requirements, follow 

the link in the Graph Types column. 

Scatter Matrix  
 Scatter Matrix 

• Start with a Worksheet. 

• Select two Y columns or a range from 

two Y columns. 

• For specific data requirements, follow 

the link in the Graph Types column. 

Probability  
 Probability Plot 

 Q-Q Plot 

• Start with a Worksheet. 

• Select one Y column or a range from 

one Y column. 

• For specific data requirements, follow 

the link in the Graph Types column. 

http://www.originlab.com/doc/Origin-Help/Histogram-Graph
http://www.originlab.com/doc/Origin-Help/Histogram-Graph
http://www.originlab.com/doc/Origin-Help/StackedHistogram-Graph
http://www.originlab.com/doc/Origin-Help/Marginal-Histograms-Graph
http://www.originlab.com/doc/Origin-Help/Histogram-Graph
http://www.originlab.com/doc/Origin-Help/Histogram-Graph
http://www.originlab.com/doc/Origin-Help/2D-Kernel-Density
http://www.originlab.com/doc/Origin-Help/Scatter-Matrix
http://www.originlab.com/doc/Origin-Help/Probability-Plot
http://www.originlab.com/doc/Origin-Help/QQ-Plot
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Plot Menu Group  Graph Types  Notes  

Pareto  
 Pareto – Bin Data 

 Pareto - Raw Data 

• Start with a Worksheet. 

• Select one Y columns or a range from 

one Y column (Raw), or a Y column of 

Binned results. 

• For specific data requirements, follow 

the link in the Graph Types column. 

QC (X-bar R) 
Chart   QC (X-bar R) Chart 

• Start with a Worksheet. 

• Select at least one Y column or a 

range from at least one Y column. 

• For specific data requirements, follow 

the link in the Graph Types column. 

Contour  

 Contour - Color Fill 

 B/W Lines + Labels 

 Gray Scale Map 

 Heat Map 

• Contour Color Fill, B/W Lines + 

Labels, Gray Scale Map: XYZ, Virtual 

Matrix, Matrix. 

• Heat Map: Virtual Matrix, Matrix. 

• For specific data requirements, follow 

links in the Graph Types column. 

http://www.originlab.com/doc/Origin-Help/ParetoChart-BinData
http://www.originlab.com/doc/Origin-Help/ParetoChart-RawData
http://www.originlab.com/doc/Origin-Help/QC-XBarR-Graph
http://www.originlab.com/doc/Origin-Help/ColorFill-Contour-Graph
http://www.originlab.com/doc/Origin-Help/BWLinesLabels-Contour-Graph
http://www.originlab.com/doc/Origin-Help/Contour-GrayScaleMap
http://www.originlab.com/doc/Origin-Help/Heat_map
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Plot Menu Group  Graph Types  Notes  

Polar  

 Polar θ(X) r(Y) 

 Polar r(X) θ (Y) 

 Bar θ, r 

 Bar r, θ 

 Line + Symbol θ, r 

 Line + Symbol r, θ 

 Symbol θ, r 

 Symbol r, θ 

 Contour θ (X), r(Y) 

 Contour r(X), θ (Y) 

• Start with a Worksheet (Polar, Polar 

Contour) or Matrix (Polar Contour 

only). 

• For data requirements and other 

information on all polar graphs except 

polar contour graphs, see Polar 

Graph. 

• For data requirements and other 

information on polar contour graphs 

from XYZ data, see Polar Contour 

from XYZ Data. 

• For data requirements and other 

information on polar contour graphs 

from matrix data, see Polar Contour 

from Matrix Data. 

Vector  
 Vector XYAM 

 Vector XYXY 

• Start with a Worksheet. 

• For XYAM Vector, select three Y 

columns (or a range of the three Y 

columns). 

• For XYXY Vector, select two X columns 

and 2 Y columns (or a range of two X 

and two Y columns). 

• For specific data requirements, follow 

links in the Graph Types column. 

http://www.originlab.com/doc/Origin-Help/Polar-Graph
http://www.originlab.com/doc/Origin-Help/Polar-Graph
http://www.originlab.com/doc/Origin-Help/XYZ-Polar-Contour
http://www.originlab.com/doc/Origin-Help/XYZ-Polar-Contour
http://www.originlab.com/doc/Origin-Help/Matrix-Polar-Contour
http://www.originlab.com/doc/Origin-Help/Matrix-Polar-Contour
http://www.originlab.com/doc/Origin-Help/XYAM-Graph
http://www.originlab.com/doc/Origin-Help/XYXY-Graph
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Plot Menu Group  Graph Types  Notes  

Ternary  

 Ternary  

 Line+Symbol  

 Ternary, Line  

 Ternary Contour  

 Piper  

• Start with a Worksheet. 

• For specific data requirements, follow 

links in the Graph Types column. 

Stock  

 High-Low-Close 

 Japanese Candle 

 OHLC Bar Chart 

 OHLC-Volume 

 Line 

• Start with a Worksheet. 

• For specific data requirements, follow 

links in the Graph Types column. 

Bridge Chart  

 Bridge Chart  

 Stack Bridge  

 Stack Total Bridge 

 Horiz-Bridge Chart 

• Start with a Worksheet. 

• Select one or more Y columns (or a 

range of one or more Y columns). If 

there is an X column to the left of the 

Y column(s), this X column is treated 

as categorical data; otherwise, the 

worksheet's row indices will be used. 

• Origin Bridge Charts are variants of 

one basic chart type. For more 

information, see Bridge Charts. 

Profile  
 Contour Profiles 

 Image Profiles 

• Start with a Worksheet, Virtual 

Matrix or Matrix (Image Profiles, 

Matrix only). 

• For specific data requirements, follow 

links in the Graph Types column. 

http://www.originlab.com/doc/Origin-Help/Ternary-Graph
http://www.originlab.com/doc/Origin-Help/Ternary-Graph
http://www.originlab.com/doc/Origin-Help/Ternary-Graph
http://www.originlab.com/doc/Origin-Help/Ternary-Contour
http://www.originlab.com/doc/Origin-Help/Piper-Diagram
http://www.originlab.com/doc/Origin-Help/High-Low-Close-Graph
http://www.originlab.com/doc/Origin-Help/Japanese-Candlestick
http://www.originlab.com/doc/Origin-Help/OHLC-Bar-Chart
http://www.originlab.com/doc/Origin-Help/OHLC-Volume
http://www.originlab.com/doc/Origin-Help/Stock_Line
http://www.originlab.com/doc/Origin-Help/Legend-CateData
http://www.originlab.com/doc/Origin-Help/Bridge-Chart
http://www.originlab.com/doc/Origin-Help/Contour-Profile
http://www.originlab.com/doc/Origin-Help/Image-Profile
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Plot Menu Group  Graph Types  Notes  

Smith Chart  
 Smith Chart 

• Start with a Worksheet. 

• Select at least one Y column of values 

(or a range from at least one column). 

If there is an associated X column, X 

column supplies X values; otherwise, 

Y sampling interval or row number is 

used. 

• For more information, follow the link 

in the Graph Types column. 

Wind Rose  
 Binned Data 

 Raw Data 

• Start with a Worksheet. 

• Select one or more Y columns or a 

range from one or more Y columns. If 

there is an associated X column, X 

column supplies X values; otherwise, 

Y sampling interval or row number is 

used. 

• For specific data requirements, follow 

links in the Graph Types column. 

Radar  

 Radar  

 Line Fill 

 Line  

 Symbol  

• Start with a Worksheet. 

• Select at least one Y column (or a 

range from at least one Y column). 

The X column displays as the title of 

the radial axis around the chart. If 

there is an associated X column, X 

column supplies X values; otherwise, 

Y sampling interval or row number is 

used. 

• Radar Charts and Spider Charts are 

created from the same basic Origin 

plot type. 

• For more information, see Spider 

Charts. 

http://www.originlab.com/doc/Origin-Help/SmithChart-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/WindRose-Binned-Graph
http://www.originlab.com/doc/Origin-Help/WindRose-Raw-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/RadarChart-Graph
http://www.originlab.com/doc/Origin-Help/RadarChart-Graph
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Plot Menu Group  Graph Types  Notes  

Group Plot  

 Column Index Data 

 Box Index Data 

 Box Raw Data 

• Start with a Worksheet. 

• Select at least one Y column (or a 

range from at least one Y column), 

plus a second column with grouping 

information. If there is an associated 

X column, X column supplies X 

values; otherwise, Y sampling interval 

or row number is used. 

• For more information, follow the link 

in the Graph Types column. 

Trellis Plot  
 Trellis Plot 

• Start with a Worksheet. 

• Select at least one Y column as input 

data. Optionally, you can have an 

additional associated Y error column 

for each Y column. Other column(s) 

generally contain grouping 

information. 

• For more information, see the link in 

the Graph Types column. 

11.5.2 3D Graphs 

  

Plot Menu Group  Graph Types  Notes  

Line + Symbol  

 3D Scatter 

 3D Scatter + Error 

 3D Line 

 3D Trajectory 

• Data requirements vary by plot type. 

See links in the Graph Types column. 

http://www.originlab.com/doc/Origin-Help/grouped-column-index-data
http://www.originlab.com/doc/Origin-Help/GroupedBoxCharts-IndexedData
http://www.originlab.com/doc/Origin-Help/GroupedBoxCharts-RawData
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/trellis
http://www.originlab.com/doc/Origin-Help/Mat-3DScatter
http://www.originlab.com/doc/Origin-Help/3D-ErrBars
http://www.originlab.com/doc/Origin-Help/3DLine
http://www.originlab.com/doc/Origin-Help/Trajectory-Graph
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Plot Menu Group  Graph Types  Notes  

Function  
 New 3D Plot 

 New 3D Parametric 

• Function plots are not created from 

physical data. 

• When a 3D Function is plotted, a 

matrix of Z values is simultaneously 

generated. 

• For more information on function 

plots, follow links in the Graph Types 

column. 

Vector  
 3D XYZ XYZ 

 3D XYZ dXdYdZ 

• Start with a Worksheet. 

• Select 6 worksheet columns, 

designated as XYZ XYZ. 

• For more information, see links in the 

Graph Types column. 

Bar  

 3D Bar Graph 

 3D Stacked Bar 

 3D 100%Stack Bar 

• Start with a Worksheet (XYZ) or a 

Virtual Matrix or Matrix of Z values. 

• For specific data requirements, follow 

links in the Graph Types column. 

Surface  

 Color Fill Surface 

 X Constant w Base 

 Y Constant w Base 

 Color Map Surface 

 C-Map w Projection 

 Wire Frame 

 Wire Surface 

• Start with a Worksheet or Matrix. 

• For specific data requirements, follow 

links in the Graph Types column. 

http://www.originlab.com/doc/Origin-Help/PD-Dialog-3DFunc-Tab
http://www.originlab.com/doc/Origin-Help/PD-Dialog-3DParaFunc-Tab
http://www.originlab.com/doc/Origin-Help/3DVector-XYZ-XYZ
http://www.originlab.com/doc/Origin-Help/3DVector-XYZ-dXdYdZ
http://www.originlab.com/doc/Origin-Help/3D-Bars
http://www.originlab.com/doc/Origin-Help/3D-Stacked-Bars
http://www.originlab.com/doc/Origin-Help/3D-100PC-Stacked-Bars
http://www.originlab.com/doc/Origin-Help/Color-Fill-Surface
http://www.originlab.com/doc/Origin-Help/X-Const-Base-Surface
http://www.originlab.com/doc/Origin-Help/Y-Const-Base-Surface
http://www.originlab.com/doc/Origin-Help/Color-Map-Surface
http://www.originlab.com/doc/Origin-Help/Color-Map-Surface-Projection
http://www.originlab.com/doc/Origin-Help/Wire-Frame
http://www.originlab.com/doc/Origin-Help/Wire-Surface
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Plot Menu Group  Graph Types  Notes  

Ternary  
3DTernary C-Map 

 3D Ternary Symbol 

• Start with a Worksheet. 

• Select two Z columns (XYZZ) or a 

range of data from two Z columns (Z 

columns may be multiples of 2). 

• For more information, follow links in 

the Graph Types column. 

Waterfall  

 Waterfall 

 Waterfall: Y C-Map 

 Waterfall: Z C-Map 

 3D Waterfall 

 3D:Y Color Mapping 

 3D:Z Color Mapping 

• Start with a Worksheet. 

• Select at least one Y column (or a 

range from at least one Y column). 

Ideally, select at least two Y columns 

(or a range of at least two Y 

columns). If there is an associated X 

column, X column supplies X values; 

otherwise, Y sampling interval or row 

number is used. 

• For more information, see the links in 

the Graph Types column. 

Multi-Y  

 XYY 3D Bars 

 XYY 3D Stack Bars 

 XYY 3D 100% 
Stack Bars 

• Start with a Worksheet. 

• Select at least one Y column (or a 

range from at least one Y column). 

Ideally, select at least two Y columns 

(or a range of at least two Y 

columns). If there is an associated X 

column, X column supplies X values; 

otherwise, Y sampling interval or row 

number is used. 

• For more information, see the links in 

the Graph Types column. 

http://www.originlab.com/doc/Origin-Help/3d-ternary-colormap
http://www.originlab.com/doc/Origin-Help/3d-ternary-symbol
http://www.originlab.com/doc/Origin-Help/2DWaterfall-Graph
http://www.originlab.com/doc/Origin-Help/2DWaterfall-Y-ColMap
http://www.originlab.com/doc/Origin-Help/2DWaterfall-Z-ColMap
http://www.originlab.com/doc/Origin-Help/3D-Waterfall-Graph
http://www.originlab.com/doc/Origin-Help/3D-Waterfall-YColor-Mapping
http://www.originlab.com/doc/Origin-Help/3D-Waterfall-ZColor-Mapping
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/3DBar-Graph
http://www.originlab.com/doc/Origin-Help/3DStackBar-Graph
http://www.originlab.com/doc/Origin-Help/3D100PC_StackBar-Graph
http://www.originlab.com/doc/Origin-Help/3D100PC_StackBar-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
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Plot Menu Group  Graph Types  Notes  

3D Ribbons  
 3D Ribbons 

• Start with a Worksheet. 

• Select at least one Y column (or a 

range from at least one Y column). 

Ideally, select at least two Y columns 

(or a range of at least two Y 

columns). If there is an associated X 

column, X column supplies X values; 

otherwise, Y sampling interval or row 

number is used. 

• For more information, see the link in 

the Graph Types column. 

Walls  

 3D Wall Graph 

 3D Stack Wall 

 3D 100% Stack 
Wall 

• Start with a Worksheet. 

• Select at least one Y column (or a 

range from at least one Y column). 

Ideally, select at least two Y columns 

(or a range of at least two Y 

columns). If there is an associated X 

column, X column supplies X values; 

otherwise, Y sampling interval or row 

number is used. 

• For more information, see the link in 

the Graph Types column. 

11.6 Topics for Further Reading 

• The Page-Layer-Plot Hierarchy 

• Page Viewing Modes 

• Graph Axes 

• Creating Graphs from Graph Templates 

• Creating Multi Layered Graphs 

• Adding Data Plots to the Graph Layer 

• The Layer Contents Dialog Box 

• The Object Manager 

• Graph Layers 

• Linking Layers 

• 3D and Contour Graphing 

http://www.originlab.com/doc/Origin-Help/Ribbon-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/Wall-Graph
http://www.originlab.com/doc/Origin-Help/Stacked-Wall-Graph
http://www.originlab.com/doc/Origin-Help/100-Stacked-Wall-Graph
http://www.originlab.com/doc/Origin-Help/100-Stacked-Wall-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/Page-Layer-Plot-Hierarchy
http://www.originlab.com/doc/Origin-Help/Compare-PageView-Modes
http://www.originlab.com/doc/Origin-Help/GraphAxes
http://www.originlab.com/doc/Origin-Help/Plot-Graph-Template
http://www.originlab.com/doc/Origin-Help/MultiLayer-Graph
http://www.originlab.com/doc/Origin-Help/DataPlot-Manage
http://www.originlab.com/doc/Origin-Help/LayerN-Dialog
http://www.originlab.com/doc/Origin-Help/Object-Manager
http://www.originlab.com/doc/Origin-Help/Legend-ColorScale
http://www.originlab.com/doc/Origin-Help/Link-Layers
http://www.originlab.com/doc/Origin-Help/3D-Contour-Graphing
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• Plotting Mathematical Functions 

• Appendix 2 - Complete Listing of Origin Graph Types 

http://www.originlab.com/doc/Origin-Help/FuncPlot
http://www.originlab.com/doc/Origin-Help/GraphTypes
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12 Customizing Graphs 

 

 

12.1 Introduction 

This chapter introduces you to various aspects of graph customization. All Origin graphs start from a graph 
template. If the graph is fairly standard for its type, the options that were stored in the graph template may be 
entirely adequate to produce a polished-looking graph. The business of basic graph creation was covered in the 
last chapter, Graphing.  

http://www.originlab.com/doc/User-Guide/Graphing
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Sooner or later, however, you are going to want to add annotations, modify axis scales or change plot colors. 
Hence, the purpose of this chapter is to introduce you to some key Origin graph customization tools and 
techniques and to point you toward resources that will help you manage more complex graph customization 
tasks.  

We begin with a discussion of the graph customization-related toolbars, as these toolbars have tools that are 
commonly used for quick modifications of graph elements.  

12.2 Toolbars 

Toolbar buttons useful for graph-customization tasks:  

Description  Toolbar  
(default configuration)  

Format toolbar buttons:  
 

• Creating and 

customizing text 

objects. 

 

Style toolbar buttons:  
 

• Editing colors, line 

thickness, fill patterns. 
 

Tools toolbar buttons:  
 

• Add text objects, lines, 

arrows, 

rectangles/circles/poly

gons. 

 

http://www.originlab.com/doc/User-Guide/Toolbars
http://www.originlab.com/doc/User-Guide/Toolbars
http://www.originlab.com/doc/User-Guide/Toolbars
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Description  Toolbar  
(default configuration)  

Graph toolbar buttons:  
 

• Add graph layers incl. 

inset graphs, merging 

or extracting graphs; 

exchanging axes; anti-

aliasing and Speed 

Mode. 

 

Add Object to Graph toolbar 
buttons:  
 

• Add legends/color 

scales/bubble scales; 

date & time and 

project path stamps; 

XY scale; table 

objects. 

 

Object Edit toolbar buttons: 
 

• Arranging and aligning 

objects and layers on 

the page. 
 

http://www.originlab.com/doc/User-Guide/Toolbars
http://www.originlab.com/doc/User-Guide/Toolbars
http://www.originlab.com/doc/User-Guide/Toolbars
http://www.originlab.com/doc/User-Guide/Toolbars
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12.3 Menus and Dialog Boxes 

Many graph customizations are initiated via commands on the Graph menu. Options for customization are 
explained in the sections below.  

The following table lists key dialog boxes used for customizing graphs:  

Task  Dialog Name  Method  

Customize the graph 
Page, Layer, or Data Plot  

• Plot Details dialog 

• Double-click on Page, 

Layer or Data Plot 

• Format: Page 

Properties... menu 

• Format: Layer 

Properties... menu 

• Format: Plot 

Properties... menu 

Customize Axes  
• Axis Dialog  

• Double-click on axes or 

tick labels 

• Format: Axes... menu 

• Format: Axis Tick 

Labels... menu 

• Format: Axis Titles... 

menu 

Add or Customize Legend   

• Update Legend dialog 

• Legends/Titles tab at Page 

level of Plot Details dialog 

• Right-click legend and 

choose Legend: Update 

Legend 

• Graph: Legend: Update 

Legend... menu 

• Legends/Titles tab at 

page level of Plot Details 

dialog 

Merge multiple graph 
windows into one graph 
window  

• Merge Graphs dialog 
• Graph: Merge Graph 

Windows... menu 
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Task  Dialog Name  Method  

Layer level 
customizations: resize, 
move, swap, align, or add 
layers  

• Layer Management dialog 
• Graph: Layer 

Management... menu 

Save settings as graph 
template  

• Save Template As dialog 

• File: Save Template As... 

menu 

• Right-click graph window 

title and choose Save 

Template As... 

Manage graph templates, 
add plots to a template  

• Template Library (custom 

graph templates) 

• System Templates (built-in 

graph templates) 

• Plot > Templates: 

Template Library menu 

• Plot > Templates: 

System Template Library 

menu 

Save settings as graph 
Theme  

• Save Format as Theme 

dialog 

• Right-click and choose 

Save Format as Theme... 

context menu 

Manage Graph Themes: 
edit, combine, apply 
Theme, set as System 
Theme  

• Theme Organizer dialog 

• Tools: Theme Organizer.. 

> Graph tab. 

• F7 hotkey. 

12.4 Customizing Page, Layer and Data Plots 

 A graph has a collection of editable properties at the page, layer and data plot levels. Quick formatting of 
some graph properties can be done using toolbar buttons, as discussed above. However, the vast majority of 
properties are customized via Origin's Plot Details dialog box (opened by double-clicking on your plot or by 
choosing Format: Page/Layer/Plot Properties, from the menu).  

The figure below shows an example of the Plot Details dialog box:  

• The left panel depicts the Page > Layer > Plot hierarchy as an expandable/collapsible tree. 

• The right panel lists controls that pertain to the object that is currently selected in the left panel.  

• To customize an object, select it in left panel and modify the corresponding properties that appear on the 

various tabs in the right panel.  
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Selected Left 
Panel Object  Right Panel, Controls for...  

Page  Print/Dimensions, layer drawing orders, page display color, legends/titles.  

Layer  
Layer background colors, layer size and speed mode settings, layer display settings, 
stack settings for applicable plot types. Some plot types will include extra tabs/controls 
specific to the plot type.  

Data Plot  Plot specific properties. The tabs and controls are pertinent to the plot type.  

Data Point  Point specific properties. Available for some plot types. The tabs and controls are 
generally similar to those available at the Data Plot level.  
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You can UNDO customizations made in the Plot Details dialog box. Click OK to close 
Plot Details and choose Edit: Undo Modify Page or press CTRL + Z.  

 
:

  

 

Prevent text and label objects from scaling when resizing layer, by going to the Display 
tab of Plot Details (at the Layer level) and setting Fixed Factor to 1.  

12.4.1 Customizing Grouped Plots 

 When you select and plot multiple data ranges to a single graph layer, the plots are grouped in the layer. By 
default, grouped plots are automatically differentiated by varying one or more plot properties, by cycling 
through customizable increment lists (one for each property). These increment lists are saved with the graph 
template (.oggu) or Theme file (.oth).  
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The above image shows the Plot Details Group tab settings for a line + symbol plot in the upper-left. The first 
column lists Line Color, Symbol Type, Line Style Symbol Edge Color and Symbol Interior. Line Color, 
Symbol Type and Symbol Edge Color are set to increment By One Between Subgroups (grouping occurs 
using the column Long Name), while Line Style and Symbol Interior are set to increment by None (they 
do not vary).  

This arrangement is completely customizable and you can save customizations with the graph template:  

• To find out more about customizing of grouped and subgrouped plots, see The Plot Details Group Tab 

Controls. 

• To find out more about saving graphs as templates, see Graph Template Basics. 

 

For Origin 2018, you can set Symbol Size to increment for each plot in a group. 

12.4.2 Customizing Individual Data Points 

 For some plot types such as scatter and column, you can modify the display properties of a single data point. 
This is another plot customization that happens via the Plot Details dialog box.  

To edit a single point:  

1. Press the CTRL key and double-click on the data point in the graph. This opens the Plot Details dialog box 

with the focus set to edit this data point. (Note that the data point will be identified in the left-panel of Plot 

Details by its row index number. ) 

2. Use the controls on the tabs in the right panel to modify the appearance of the data point. Changes you 

made will not affect the appearance of other points in the data plot. 

http://www.originlab.com/doc/Origin-Help/PD-Dialog-Group-Tab
http://www.originlab.com/doc/Origin-Help/PD-Dialog-Group-Tab
http://www.originlab.com/doc/Origin-Help/Graph-Template-Basics
http://www.originlab.com/doc/Origin-Help/PD-Dialog-Group-Tab


Customizing Graphs 

137 

 

Alternately, when the Custom Construction box is checked, you can use these controls to customize the 
symbol.  

 

To remove customizations made to a single data point:  

• Right-click the single point in the left panel of the Plot Details dialog and choose Delete. 

• In the graph window, click on the single point to select it, then press DELETE on the keyboard.  

The point properties revert to those of the containing dataset.  

12.5 Customizing Graph Axes 

  Most graph axis customizations are made via the Axis Dialog box. Double-click on the graph axis or tick 
labels to open the Axis Dialog - Layer N dialog box.  

This image shows the tab-based axis dialog used by most 2D and 3D graphs.  

http://www.originlab.com/doc/Origin-Help/PD-Dialog-Sym-Tab
http://www.originlab.com/doc/Origin-Help/PD-Dialog-Sym-Tab
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In earlier versions of Origin, you had to customize each layer's axes from separate Axis 
dialogs. Starting with Origin 2017, you can switch layers inside the Axis dialog using 
the Layer drop-down at the bottom of the dialog box.  

In the left panel, you can select one or more icons (hold the CTRL key to select multiple icons) to specify the 
axis or axes to be customized, then select the desired tab and choose your options.  

Tab  Controls for  

Scale  Scale range of values, scale type, rescale mode and margin, reverse scale, major and 
minor ticks.  

Tick Labels  Display and format options for major and minor tick labels, including custom labeling by 
formula.  

Title  Axis title (often set using variable notation) and font options. Note that you can directly 
edit by double-clicking the text object in the graph.  

Grids  Control display and properties of grid lines at major and minor ticks.  

Line and 
Ticks  Global axis line and tick display options for all axes.  
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Tab  Controls for  

Special Ticks  Placement of special tick labels.  

Reference 
Lines  

Placement of reference lines and "recession bars" (shaded areas with transparency, that 
can be added on top of the data plot).  

Breaks  Enable line breaks and configure each break.  

 

Click the Apply To... button to selectively apply the axis format settings of one axis to 
another axis.  

Note: For more information on axis customization and for axis controls for specialized graph types (e.g. 
polar, ternary, radar chart.etc), refer to:  

Help: Origin: Origin Help > Graphing > Graph Axes  

12.6 Graph Legends 

12.6.1 Auto Creation of the Graph Legend 

   A graph legend is automatically created when you plot data. For 2D and some 3D graph templates, Origin 
creates a default legend that combines plot style information with dataset information (metadata) and places 
the resulting label object in the upper-right corner of the graph page.  

The default legend object is created using LabTalk substitution notation. The reason for this is:  

• The legend object is able to incorporate identifying information such as has data that has been entered 

into the worksheet column headings (either manually or automatically on file import). 

• The legend object is dynamically linked to the plotted data so that the legend can be updated when data 

are added or removed from the graph. The substitution notation becomes visible when you double-click 

inside of the legend object (as if to edit it).  

 

The notation used for legend texts is controlled by the Translation mode of %(1), %(2) list in the 
Legends/Titles tab of the Plot Details dialog box (Format: Page Properties...). Custom format of the 
notation(s) is supported.  

http://www.originlab.com/doc/Origin-Help/GraphAxes
http://www.originlab.com/doc/Origin-Help/PD-Dialog-LegendTitles-Tab
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• To prevent auto creation of a graph legend, create and customize your graph, then 

delete the legend object and save the graph template to a new name.  

• Right-click the legend object for some useful controls such as Reverse Order, 

Show Legend for Visible Plots Only, and Hide Legend for Fitted Curves.  

• Select the legend object; then press CTRL while dragging a selection handle to 

change the layout of the legend (e.g. drag horizontally to create a legend that is all 

on one line). 

• Double-click the legend text to go to in-place edit mode. Double-click a legend 

symbol to open the Plot Details dialog box with corresponding plot selected. 

12.6.2 Adding and Updating the Graph Legend or Scale Object 

There are a number of reasons for modifying the default graph legend. We suggest that you look at this topic 
to see what sort of customizations are supported.  Before attempting to customize the data plot legend, you 
should know the difference between updating a legend and reconstructing a legend:  

• Updating will preserve any previous customizations, reconstructing will overwrite previous 

customizations.  

• The graph template stores a Legend Update Mode setting that determines how the legend is refreshed 

when adding or removing data plots from the graph. For more information, see Legend Update Mode. 

 
This table lists tasks associated with creating and customizing the default legend and where to find controls for 
each.  

Task  Method (graph is active)  

Add or reconstruct 
legend  

• Graph: Legend: Reconstruct Legend menu. 

• Reconstruct Legend button  (Add Object to Graph toolbar). 

• CTRL+L. 

Note: Customizations made to an existing legend will be lost when you use 
these commands.  

Update legend  

Open the legendupdate dialog box:  

• Graph: Legend: Update Legend menu. 

• Right-click on legend and select Legend: Update Legend. 

http://www.originlab.com/doc/Origin-Help/Graph-Template-Basics
http://www.originlab.com/doc/Origin-Help/Legend-ColorScale
http://www.originlab.com/doc/Origin-Help/PD-Dialog-LegendTitles-Tab
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Task  Method (graph is active)  

Advanced legend 
customizations  

Right-clicking the legend object provides several advanced options to customize 
the graph legend. Applies primarily to:  

• Categorical data plots. 

• Box charts. 

• Legends constructed point-by-point. 

Add color scale   

Only available for color-mapped plots.  

• Click the Add Color Scale button  (Add Object to Graph 

toolbar). 

• Right-click in the layer and select New Color Scale. 

• Graph: New Color Scale menu. 

• For multiple color-mapped plots with different color scale in one graph, 

click on each plot to select it and add corresponding color scale.  

Control color scale  

Available when a color scale object is added to a graph. To open the Color 
Scale Control dialog:  

• Double click on the color scale object. 

• Right-click on the color scale object and choose Properties. 

Add bubble scale  

Available for bubble plot, or when symbol size is controlled by a dataset.  

• Select Graph: New Bubble Scale. 

• Right-click in the layer and select New Bubble Scale.  

• Click the Add Bubble Scale button in the Add Object to Graph 

toolbar. 

• Right-click the legend to select Add Bubble Scale from the context 

menu. 
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Task  Method (graph is active)  

Control bubble scale  

Available when bubble scale object is added to a graph. To open the 
Bubble Scale Control dialog:  

• Double click on the bubble scale object. 

• Right-click on the bubble scale object and choose Properties. 

 

The legendupdate dialog box and the Legend/Titles tab at page level of Plot 
Details both offer options for incorporating metadata properties such as the Long 
Name, Comment, User Parameters, etc., in the graph legend. Metadata properties 
can also be combined using custom LabTalk notation. For more information, see 
Legend Substitution Notation.  

There are several approaches for further customizing the legend. These customizations do not apply to color 
scales:  

• Right-click on the legend and select Properties..... Includes controls for formatting font, size, color, 

background, and rotation. 

• Right-click on the graph legend and choose Properties. Modify the size, color, line width and data plot 

symbols associated with each plot.  

• Click on the legend border to view border line controls for adjusting padding between text and border. 

 

Origin 2018 now includes an interface tool to manually Add Legend Symbols to the 
graph legend. Right-click on the legend object and choose Properties. Click the Add 
Legend Symbol button in the lower-right corner of the dialog box.  

 

Note: For more information on creating and customizing graph legends, see:  

Help: Origin: Origin Help > Graphing > Graph Legends and Color Scales  

12.6.3 Controlling Legend Update 

When a data plot is added or removed from a graph layer, the default behavior is to update the legend. The 
Legend/Titles tab at the graph page level in the Plot Details provides a Legend Update Mode drop-down 
to control this behavior.  

The default setting Update when Adding only affects the legend display of data plots that are added or 
removed. Previous legend customizations to existing plots, such as literal text entered manually, will be 
maintained.  

http://www.originlab.com/doc/LabTalk/ref/Legend-Substitution-Notation
http://www.originlab.com/doc/Origin-Help/Legend-ColorScale
http://www.originlab.com/doc/Origin-Help/PD-Dialog-LegendTitles-Tab
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Tutorial: Customize legend and add data plots  

1. Start with a new project in Origin. 

2. Open Windows Explorer and navigate to the subfolder <Origin EXE 

folder>\Samples\Import and Export\ 

3. Shift-select the files S15-125-03.dat, S21-235-07.dat, S32-014-04.dat and 

then drag-and-drop the files onto an empty Origin workbook. The three files will be 

imported into three separate workbooks. 

4. Click on one of the workbooks, select the column B, and create a line plot. 

5. Right-click on the legend and select Legend: Update Legend... to open the 

legendupdate dialog. 

6. Change the Auto Legend Translation Mode drop-down to Custom, and in the 

edit box that appears below, enter the string: 

@WS, @LD3 

and then press OK to close the dialog box. The legend updates, displaying the 

sheet name and the third user parameter. 

7. Click on the second workbook, select column B, move the mouse over the right-

edge of the column until it changes to , and then drag-and-drop this data 

onto the graph to create a 2nd data plot.  

8. Repeat the procedure with column B from the third workbook. The graph will now 

display three data plots, and the legend will automatically update to display the 

identifier for all three plots.  

9. Click on each individual curve and use the Style toolbar to set a different line color 

for each. The legend will automatically update and display the new line color. 
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12.6.4 Special Legend Types 

Origin also has several special legends used with certain graph types. These legends can be customized and 
updated similarly to the default legend object.  

Legend Type  Menu Access  Used When..  

Legend for 
Categorical Values  

Graph:Legend:Categorical 
Values  

At least one plot attribute (e.g. color, symbol 
shape.etc) is controlled by data indexing. See 
the Legend for Categorical Values help page.  

Point by Point 
Legend  Graph:Legend:Point by Point  

The symbol style is controlled by data 
indexing, or increment list, or color mapping. 
See the Point by Point Legend help page.  

Legend for Box 
Chart 
Components  

Graph:Legend:Box Chart 
Components  

The graph is a box chart, or a grouped box 
chart. See the Legend for Box Chart 
Components help page.  

12.7 Annotating Your Graph 

  

 

Origin 2018 adds Unicode (UTF-8) support. 

Annotating a graph can be as simple as adding a static text object and formatting it with Format toolbar tools. 
Or you might add a more complex object that is linked to some LabTalk script that executes whenever some 
user-specified event occurs (e.g. object is moved, window is activated, graph axes are rescaled, etc.).  

Task  Method  

Label Data Points  

• Choose Format: Plot Properties, then click the Label tab and 

select Enable (not available for all plot types). 

• To annotate individual points, see "Annotate a Data Point", 

below. 

Add Text Objects  

• Click the Text Tool  button, then click on graph to place 

object. 

• Right click on the graph and choose Add Text from the shortcut 

menu. 

• Double click on text to do rich text editing. 

http://www.originlab.com/doc/Origin-Help/Legend-CateData
http://www.originlab.com/doc/Origin-Help/pts-pts-legend
http://www.originlab.com/doc/Origin-Help/box-legend
http://www.originlab.com/doc/Origin-Help/box-legend
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Task  Method  

Add Layer Title  

• Right-click on graph and choose Add/Modify Layer Title from 

the shortcut menu to add/modify layer title in active layer. 

Add Vertical/Horizontal Line  

• With 2D graph active, use the Graph: Add Straight Line... 

menu item. 

Annotate a Data Point  • Click the Annotation  tool on the Tools toolbar.  

Add Drawing Objects  

Use the corresponding toolbar buttons on Tools toolbar. Origin supports:  

• Arrow, Curved Arrow. 

• Line, Polyline, Freehand Draw. 

• Rectangle, Circle, Polygon, Region. 

Insert Equation, Word 
Object, Excel Object, Other 
OLE Object   

• Insert Equation group on the Tools toolbar. 

Insert Image  

• Right click on the graph and choose Insert Images From 

Files. 

Add Table  

• Click the New Link Table  button on the Add Object to 

Graph toolbar and then click on the graph. 

• Right click on the graph and choose New Table from the 

context menu. 

• Double click the table object to edit and customize the table.  

Insert Date & Time Stamp  • Date & Time  button on the Add Object to Graph toolbar. 

Insert Project Path  • Project Path  button on the Add Object to Graph toolbar. 
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Task  Method  

Add Bracket with Asterisk  

• To indicate statistical groupings, click the Add Asterisk 

Bracket  button on the Add Object to Graph toolbar. 

Manually adjust the size and placement of brackets by dragging 

handles on the object. 

Add XY Scale  

This is useful when using a nonlinear xy scale.  

• New XY Scale button  and click on a graph layer. 

• Right click on a graph layer and choose New XY Scale from the 

shortcut menu.  

12.7.1 Tips for Editing Your Graph Annotations 

• Pressing CTRL when drawing with the Rectangle  or Circle  tools, will draw a square or circle (as 

opposed to a rectangle or ellipse). 

• Right-click an object and choose Properties... to edit the properties of the text or drawing object and set 

the default. 

• Use the Format and Style toolbar buttons to quickly modify some plot elements including plot colors and 

axis titles. 

• For text objects, including the axis titles, you can edit text objects directly in "In-place Edit" mode. 

Double-click on a text object to edit. Use the Format toolbar buttons to add superscript, subscript, and 

Greek characters. 

• When you are in In-place Edit mode, you can right-click and choose Symbol Map to insert special 

characters into your text object. 

• You can insert the contents of a worksheet cell (data or metadata) into a text object by copying the cell 

contents; while in In-place Edit mode in the text object, right-click and choose Paste or Paste Link from 

the shortcut menu.  

• Also, when in In-place Edit mode, you can right click and choose Insert Info. Variable... to insert 

information related to plotted data, into the text object. 

• You can insert variable values into a text object using the LabTalk %, and $ substitution notation by 

setting the Link to (%,$), Substitution Level to 1 in the text object's Properties dialog box, 

Programming tab. Right-click on the text object and choose Properties from the shortcut menu.  

• You can use controls on the Programming tab to associate LabTalk script with a text or drawing object (for 

instance, see Linking Text Labels to Data and Variables). Enter your script in the text box and specify a 

Script, Run After condition for running the script. Use the Apply to drop-down to set the scope for the 

script. 

http://www.originlab.com/doc/Origin-Help/LinkVar-TextLabel
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• You can copy a range (of cells) from a workbook and paste it into a graph as a table object. The table 

object is editable. 

12.7.2 Object Attachment and Scaling 

 When you add a text or drawing object to an Origin graph window, the object becomes part of the active 
graph layer. This is important to note because if you resize or delete a graph layer, you may resize the object 
or you will delete the object.  

To view or change a text or drawing object's attachment method:  

1. Right-click on a text or drawing object and choose Properties....  

2. Click on the Programming tab and note the object's Attach to setting.  

 

Though objects remain a part of the layer that was active at the time of their creation, you can manage some 
object behaviors by changing the object attachment method. An object is attached in one of three ways:  

• Page. When attached to the page, objects are not affected by moving or resizing the graph layer, nor are 

they affected by a change in axis scales. These objects are still associated with a particular graph layer 

and they will be hidden or deleted if the layer is hidden or deleted. 

• Layer Frame. Objects that are attached to the layer frame, resize and move with the layer frame, but are 

unaffected by changes in the layer's axis scale values. Objects are hidden or deleted if the associated 

layer is hidden or deleted. 

• Layer and Scales. Objects are linked to a particular range of axis scale values. If you resize the layer, 

the object is resized accordingly. If you rescale the axes, the object moves in relation to the scale change 

and will disappear from view if the associated axis scale range is not displayed. These objects are hidden 

or deleted if the associated layer is hidden or deleted. 

http://www.originlab.com/doc/Origin-Help/Create-Tables
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The following table summarizes default attachment methods for common objects. Note that the default 
attachment method varies by object type.  

Object Type  
When Created Inside Layer 

Frame,  
Object is Attached to...  

When Created Outside 
Layer Frame,  

Object is Attached to...  

Text  Layer Frame  Page  

Rectangle, Circle, Polygon, Region, 
Polyline, Freehand  Layer Frame  Page  

Arrow, Line, Curved Arrow  Layer and Scales  Page  

 

Note: For more information on object attachment methods, see,  

Help: Origin: Origin Help > Graphing > Adding Text and Drawing Objects > Object 
Attachment and Scaling  

12.7.3 Grouping, Aligning and Arranging with the Object Edit Toolbar 

 
You can group text labels and drawn objects so that they move or resize as a unit:  

1. To select objects, press SHIFT + click; or drag out a box around objects using the Pointer  tool. 

2. To group the selected objects, click the Group button  on the Object Edit toolbar. 

3. To ungroup objects, click the Ungroup button  on the Object Edit toolbar. 

 
You can align text labels and drawn objects using the tools on the Object Edit toolbar:  

1. Select objects to be aligned by holding the SHIFT key while selecting (or drag out a selection box using 

the Pointer  tool), then click one of the align objects buttons on the toolbar. Note that objects will be 

aligned with respect to the first-selected object. 

 
You can bring overlapping objects to the front or send them to the back:  

1. Select the objects that you want to move to the front or the back. 

2. Click the Front button  or the Back button  on the Object Edit toolbar. 

http://www.originlab.com/doc/Origin-Help/Attachment-Scaling-Object
http://www.originlab.com/doc/Origin-Help/Attachment-Scaling-Object
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Note: For more information on graph annotations, see your Origin User Guide:  

Help: Origin: Origin Help > Graphing > Adding Text and Drawing Objects  

 

You can also use Object Edit Toolbar manipulate graph layers. Selected graph layers 
respond just like text or drawing objects. Use it to align and set a uniform size for 
multiple graph layers or to swap layer order.  

12.8 Arranging Graphs and Layers 

   

Task  Method  

Merge multiple graph 
windows into a single 
graph window.  

• Graph: Merge Graph Windows... menu command 

or  

• Merge Graph Windows button  on the Graph toolbar. 

Extract data plots in one 
layer to multiple layers.  

• Extract to Layers button  on the Graph toolbar. Hint: to 

preserve your original graph, click the Duplicate button  before 

extracting to layers. 

Extract multiple layers in 
a single graph to 
multiple graph windows  

• Graph: Extract to Graphs  

or  

• Click the Extract to Graphs button  on the Graph toolbar.  

All layers are extracted to individual graph windows, even if a layer is 
linked to another layer. 

By default, Extracted Layers is set to 1:0, which specifies that all 
layers be extracted. To act only on certain layers, clear Auto and use the 
layextract X-Function's comma/colon notation to point to specific 
layers. The notation 1:0 means starting with layer 1, extract all layers to 
graphs (0 denotes all). Specifying 1,3:4, for example, tells Origin to 
extract only the first, third and the fourth layer. 

http://www.originlab.com/doc/Origin-Help/AddText-DrawObject
http://www.originlab.com/doc/X-Function/ref/layextract
http://www.originlab.com/doc/X-Function/ref/layextract
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Task  Method  

Add, arrange, resize, 
position, swap, align, or 
link layers  

Graph: Layer Management... menu.  

Hint: to physically swap inplane positions for layers (don't reassign layer 
number), use the Layer Management tool's Swap control (Graph: Layer 
Management,Size/Position tab).  

Link graph layers   

• Linked Axes Scales tab, layer level of Plot Details dialog box.  

• Link tab of the Layer Management dialog box. 

When linking layers, the child layer must have a higher layer number 
than the parent layer.  

Linked layers can be moved and resized together. 

You can link layers' axis scale values to be Straight (1:1) or you can 
specify a Custom mathematical relationship. 
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Task  Method  

Reorder layers   

There are several ways to reorder graph layers (reassign Layer number 
for each Layer). Learn more about reassigning layer numbers in the mini 
tutorial below this table.  

• Method 1: Open the Layer Management dialog and click the row 

header (shown in image below) and drag it up or down to change 

the Layer order. 

 

For more information, see the Layer Management tool.  

• Method 2: Enter the following LabTalk script in the Command 

Window (Window:Command Window), then press Enter to 

execute. 

page.reorder(n,m)  

The command changes the nth Layer to the mth Layer.  

• Method 3: Use the Front and Back buttons on the Object Edit 

toolbar (these buttons work on the active layer as indicated by the 

graph layer icon ). Alternately, you can right-click on the 

graph layer icon and change layer order using shortcut menu 

commands. 

Note: Reordering layers may break layer linking relationships.  

Exchange X-Y Axes  

• Graph: Exchange X-Y Axes menu command 

• Exchange Axes button on the Graph toolbar. 

http://www.originlab.com/doc/Origin-Help/GraphRef-LayerManage
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Task  Method  

Move a plot(s) to 
another layer  

• Method 1: Open Plot Setup dialog(by selecting Graph:Plot 

Setup), expand the bottom panel, select a plot and drag it from a 

layer to another layer. 

• Method 2: Run laymplot -d; to open the Move Plot dialog to 

specify plot(s) to move and a target layer. 

 

You can move a plot by Copying(CTRL+C or 
Copy Range context menu) and 
Pasting(CTRL+V or Paste context menu) 
operations, between different layers or different 
graphs. Please note, the pasted plot won't be 
associated with the source data of copied plot, 
but exists as a loose dataset.  

 

 

In a multi-layer graph, layer order determines drawing order. The 1st layer is plotted and 
then 2nd layer is plotted on top of it, and so on. The layer with higher number is drawn on 
top of the layer with lower number. This is important when plots in one layer overlay plots 
in another layer. When necessary, you can change layer order to change plot drawing 
order.  

This mini tutorial shows you how layer reassignment works. Use the preview window to 
see how layer number reassignment affects your graph.  

1. Click Help: Origin Central or press F11. 

2. Click on the Graph Sample tab, set the Samples in drop-down list to Area Plots 

and double-click on this graph:  

 

3. Activate the graph Area Plot With Horizontal Color Gradient, then click the 

Extract to Layers button  on the Graph toolbar. Set both number of rows 

and columns to 1, click OK, then, click OK again for the page spacing. The green 

layer is on the top of the yellow layer in the figure. The purpose of this last step 

was simply to create a two layer graph in which the data in one layer partially 
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hides the data in the other layer. What we will do now is to reorder the layers and 

set the yellow layer on the top, giving you a better view of the two plots.  

 

4. Choose Graph: Layer Management... menu, then drag the row header "1" of the 

Layer1 in the Layer Selection downward under the Layer2 (indicated by a blue line), 

and click OK. 

5. You can see the yellow layer is on the top now.  
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Alternate Method: Beginning with Origin 2017, you can use the Front  or Back  
toolbar buttons (located in the Object Edit toolbar, or at the top of Layer Selection box 
in the Layer Management dialog) to bring a layer forward or push it backwards. Just as 
with the previous method by dragging row header in Layer Management, this method 
swaps layer numbers.  

 

 

You can easily add an inset layer with data by clicking the Add Inset Graph With 

Data button  on the Graph toolbar or Graph: New Layer(Axes): Inset With 
Data (Linked Dimension) .  

 

You can copy a layer from one graph window to another graph window. Click to select 
the layer first (a frame shows around the layer). Then press Ctrl+C or right-click and 
choose Copy. Click on the target graph window, then right-click to Paste.  

Note: For more information on merging graphs, see your Origin User Guide:  

Help: Origin: Tutorials > Graphing > Layers > Adding and Arranging Layers  

Help: Origin : Origin Help > Graphing > Reference > The Merge Graph Dialog Box  

12.9 Templates and Themes 

Origin's flexible Page > Layer > Plot hierarchy, plus an extensive list of editable object properties makes it 
easy to customize and save your graph settings for repeat use. You can preserve your custom settings in a 
couple of ways -- either with templates or with Themes. These concepts are introduced below.  

Note: For detailed information please refer to Origin Help file, see:  

Help: Origin: Origin Help > Graphing > Creating Graphs from Graph Templates  

Help: Origin: Origin Help > Customizing Your Graph > Graph Formats and Themes  

12.9.1 Templates 

 Customizations to your graph can be saved to template files for repeat use. For example, you can customize a 
graph page to add multiple layers, set relationships between layers, modify data plot properties, and then save 
all of these attributes as a graph template (.otpu) file. You can further specify that the graph template be 
"cloneable" allowing you to link these graph customizations to dataset Long Name, Short Name or worksheet 
column index number and quickly re-create your graph with new data.  

A few things to note:  

• By default, new, blank 2D graphs are created from the ORIGIN.otpu template. Other graph windows use 

different templates, saved with a set of customizations pertinent to a specific template. 

http://www.originlab.com/doc/Tutorials/Customize-Add-Arrange-Layer
http://www.originlab.com/doc/Origin-Help/GraphRef-MergeGraph
http://www.originlab.com/doc/Origin-Help/Plot-Graph-Template
http://www.originlab.com/doc/Origin-Help/Graph-Format-Theme
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• Origin ships with over 100 built-in graph templates. These "system" templates are installed to the Origin 

software folder. These templates are customizable but you cannot overwrite the template files in your 

software folder (see next).  

• You can customize and save a system template to the same file name, in your User Files Folder. If the 

system template was the default template associated with a menu command or toolbar button (e.g. 

ORIGIN.otpu and the New Graph toolbar button), the customized template becomes the new default 

template associated with the command or button. 

• To view system or custom graph templates, click Plot (workbook or matrix should be active) and under 

Templates, choose User or System Templates. 

• You can save a graph template anywhere and with any name that you like -- it does not need to be saved 

with the name of a system template. However, by saving your templates to your User Files Folder, they 

will be collected in one, easily-remembered place and from there, they can easily be transferred to your 

new User Files Folder when you upgrade your Origin software. 

 

• For an overview of graph templates, see Graph Template Basics. 

• For information on the Template Library, see The Graph Template Library. 

• For information on "cloneable" templates, see Cloneable Templates. 

12.9.2 Themes and Copy/Paste Format 

http://www.originlab.com/doc/User-Guide/Installation-Startup
http://www.originlab.com/doc/Origin-Help/Graph-Template-Basics
http://www.originlab.com/doc/Origin-Help/Graph-Template-Gallery
http://www.originlab.com/doc/Origin-Help/Graph-Template-Basics
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An Origin Theme is a file containing a set of object properties. There are four kinds of Theme files in Origin: 
graph Themes, worksheet Themes, dialog Themes and function plot Themes. Graph Themes are a 
collection of properties of different elements in a graph window (e.g. a Theme could be as simple as axis major 
and minor tick direction settings, a colormap for a plot, or a combination of page dimensions, layer 
background, axis scales, color palettes used in a plot, etc.). 

Themes allow you to quickly change one or more object properties in an existing graph; or to apply a 
consistent set of properties for all graph windows. For example, you might apply a black-and-white Theme to 
one of your color graphs in order to prepare it for journal publication; or you could change the font in all of 
your graph windows to Times New Roman. 

The properties that can be saved as a Theme differ depending upon the selected object. At a basic level, it 
works like this: 

1. Right-click on an object in a graph window, e.g. a plot and choose Copy Format. Depending on what you 

click on, there may be sub-menu items under the Copy Format shortcut menu, which give you the option 

as to what exact format to copy.  

o To apply the copied formats to a single graph, right-click on your target graph and choose Paste 

Format To. Again, this shortcut menu might has some sub-items that limit what to paste. In this 

way, the formatting option(s) from your source graph should be applied to your target graph. 

o To apply the copied formats to multiple windows in the project, keep the source graph window 

active and select Edit:Paste Format(Advanced)... from the Origin menu. This opens the Apply 

Formats dialog box. Here you have the option of editing or selectively applying formats to one or 

more graph windows in the Origin Project. 

2. You can do the above on-the-fly copy and paste format or you can choose the Save Format As a 

Theme... shortcut menu item instead of Copy Format, then use Tools: Theme Organizer to apply the 

Theme in the future. 

12.9.2.1 Theme Organizer 

  Use the Theme Organizer (Tools: Theme Organizer) to organize and apply Themes to graphs. With this 
dialog box you can apply a graph Theme simultaneously to multiple graphs in the Origin project file. 

To combine multiple Themes in the Theme Organizer dialog box:  

1. Press the CTRL key while selecting multiple Themes, then right-click and choose Combine from the 

shortcut menu. The shortcut menu in the tool provides an option for editing a Theme, allowing the user to 

add/delete properties from an existing Theme. 
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• If you right-click on a graph Theme and save it as your System Theme in the 

Theme Organizer, then each time you plot a new graph, the System Theme will 

be applied regardless of the settings that were saved with the graph template.  

• If you don't want a System Theme to be applied automatically to the graph, choose 

File: Save Template As and make sure the Apply System Theme to Override 

check box is cleared. 

• You can load a graph Theme in the Export Graph dialog and the Theme will be 

applied to the exported image file. 

12.10 Topics for Further Reading 

• Customizing Graph Page Elements 

• Customizing Graph Layer Elements 

• Customizing Plot Elements 

• The Tools: Options: Axis tab Settings 

• The Tools: Options: Graph tab Settings 

• Graph Axes 

• Controlling the Graph Axis Display Range 

http://www.originlab.com/doc/Origin-Help/ThemeRef-System
http://www.originlab.com/doc/Origin-Help/Customize-Page-Element
http://www.originlab.com/doc/Origin-Help/Customize-Layer-Element
http://www.originlab.com/doc/Origin-Help/Customize-Plot-Element
http://www.originlab.com/doc/Origin-Help/Options-Dialog-Axis-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-Graph-Tab
http://www.originlab.com/doc/Origin-Help/GraphAxes
http://www.originlab.com/doc/Origin-Help/Axis-DisplayRange-Control
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• Adding Text and Drawing Objects 

• Hiding Labels, Data and Layers 

• Creating Graphs from Graph Templates 

• System Themes 

http://www.originlab.com/doc/Origin-Help/AddText-DrawObject
http://www.originlab.com/doc/Origin-Help/Labels-Data-Layer-Hide
http://www.originlab.com/doc/Origin-Help/Plot-Graph-Template
http://www.originlab.com/doc/Origin-Help/ThemeRef-System
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13 Graphical Exploration of Data 

 

 

 

Origin includes a number of tools for graphically exploring your data, including tools for magnifying and 
zooming, reading XY coordinate values, and drawing and deleting data points.  
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With Origin 2016, Origin began releasing add-on tools called Apps. Many new exploratory 
and analysis-related tools have been added to OriginLab's File Exchange since that time. In 
Origin 2018, you can browse, download, or update installed Apps directly from your Origin 
software, using the new App Center. 

To open the App Center, click on the Add Apps icon in the Apps Gallery docked to the right 
side of the Origin workspace.  

 

For more information, see Apps for Origin. 

13.1 Zooming, Panning and Rescaling 

     

This section discusses the use of toolbar tools, and keyboard and menu commands that change the view of 
your 2D graph. We have split these tools and commands into two groups:  

• Page-level zoom and panning operations that do not change axis scales. 

• Axis rescale operations which zoom and pan the graph by changing axis From and To values. 

 

Page level zoom and panning treat the graph page as a whole. You can read the current 
zoom level in the Zoom dropdown list of the Standard toolbar. Page level zoom and 
pan will not affect the printout or export of the graph, while axis rescaling tools (such 

as  and ) change axis scales and will affect the printout and export of the 
graph.  

 

http://www.originlab.com/fileexchange/index.aspx
http://www.originlab.com/doc/User-Guide/Apps
http://www.originlab.com/doc/Origin-Help/AxesRef-Scale
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13.1.1 Page-level Zoom and Pan 

Action  Button  Shortcut Key  Menu  Notes  

Zoom-Panning: Zoom 
and pan the graph page.   

A +  
+/- keys 
(zoom) 

or 
arrow keys 

(pan)  
 

Place cursor on the graph 
page and press ...  

• "A" or button and +/- 

keys or mouse wheel to 

zoom in or out.  

• "A" or button and arrow 

keys to pan horizontally 

or vertically. 

• Press "A" and hover on 

an active window. The 

Pointer tool  

changes to .  

Stepped Zoom-Pan†: 
Zoom graph in or out, by 
increment.  

 

 

CTRL + I 
CTRL + M  

View:Zoom 
In and 

View:Zoom 
Out  

• Stepped zoom. 

• CTRL+I activates zoom 

in; click on the graph to 

establish the focal point.  

• CTRL+M zooms out; 

clicking on graph not 

needed. 

Whole Page: Show the 
whole graph page.  

 

CTRL + W 
View: 
Whole 
Page  

• Reset the view of the 

page after using the 

Zoom-Panning tool. 

Zoom All: All objects in 
the window are shown.  --  --  View: Zoom 

All  

• Can be used to locate 

"lost" objects lying 

outside the graph page. 

†Notes:These are older tools and methods that have been deprecated. Toolbar buttons are not shown by 
default. To add them to the workspace, use the Customize Toolbars dialog box (View: Toolbars > Graph 
button group).  
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13.1.2 Axis Rescaling 

Action  Button  Shortcut Key  Menu  Notes  

Rescale: Rescale and 
pan the graph in both X 
and Y dimensions.   

--  --  

• Scroll to rescale X.  

• SHIFT + scroll to rescale 

Y. 

• Drag with the left mouse 

button to pan (will 

rescale both X and Y).  

• Select the Pointer tool 

to exit Rescale mode. 

Rescale the graph in the 
X dimension.  --  

Z + scroll 
wheel 

or 
Z + 
+/- 
keys  

--  

• Rescale the graph in the 

X dimension without 

limits.  

Rescale X: Rescale the 
graph in the X 
dimension.   

--  --  

• Rescales (Resets) X to 

full X range + some 

padding factor. 

Pan the graph in the X 
dimension.  --  

X + scroll 
wheel 

or 
X + 
+/- 
keys  

--  

• Rescales X.  

• Does not rescale Y. 

Rescale the graph in the 
Y dimension.  --  

SHIFT + Z + 
scroll wheel 

or 
SHIFT 
+ Z + 
+/- 
keys  

--  

• Rescale the graph in the 

Y dimension without 

limits. 

Rescale Y: Rescale the 
graph in the Y 
dimension.   

--  --  

• Rescales (Resets) Y to 

full Y range + some 

padding factor. 
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Action  Button  Shortcut Key  Menu  Notes  

Pan the graph in the Y 
dimension.  --  

SHIFT + X 
+ scroll 
wheel 

or 
SHIFT 
+ X + 
+/- 
keys  

--  

• Rescales Y.  

• Does not rescale X. 

Rescale XY: Rescale 
the graph in both X and 
Y dimensions.   

-- --  

• Rescales (Resets) X and 

Y to full range + some 

padding factor. 

Rescale Z: Rescale the 
graph in the Z 
dimension.   

-- --  

• Rescales (Resets) Z to 

full range + some 

padding factor. 

Scale In/Scale Out: 
Rescale the graph in X 
and Y dimensions.  

and 

 
--  --  

• Select Scale In button, 

then drag out 

rectangle(s) to define 

axis scale range desired.  

• Reset by clicking on the 

Scale Out button (no 

need to drag) several 

times.  

• Rescales both X and Y. 

• Press ESC (or select 

another tool) to quit 

magnifying mode†.  

Rescale: Rescale the 
graph in the all 
dimensions.   

CTRL + R  
Graph: 

Rescale to 
Show All  

• Rescales (Resets) all 

axes to display all data 

in the layer (+ some 

padding factor). 

 

† Note that pressing ESC to quit the Scale In tool  is new behavior for 2018. 
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If you do not see a toolbar button, it may be turned off. To add or remove buttons from a 
toolbar, see The Customize Toolbar Dialog Box.  

 

Origin 9.1 SR0 introduced the @nrm system variable to modify rescale behavior 
when using the Rescale tool or associated shortcut keys:  

@nrm = 0: From/To values on the Scale tab of the Axis dialog box will change 
when Rescale is set to Manual. This is established behavior.  

@nrm = 1: From/To values will not change when Rescale is set to Manual. 
This is new behavior.  

Modify the current behavior by opening the Script Window (Window: Script 
Window), typing @nrm = <value>, then pressing ENTER.  

 

Note:  

• Since Origin 2017, we have renamed Manual rescaling to Fixed rescaling. And several advanced 

selections, one-side fixed rescaling, have been available under this Rescale drop-down list.  

• When using the older Scale In tool you are prompted to override Manual rescaling. However, 

when @nrm=1 you cannot override the Axis dialog box Rescale setting. 

13.2  Rotation of 3D openGL Graphs 

You can interactively rotate your 3D graphs for purposes of data exploration. When you click on an empty 
portion of a 3D graph, a floating toolbar displays. You can use the floating buttons to rotate the graph; or you 
can use your keyboard and mouse.  

Hot Key  Menu/Action  Context  

Rotate 3D graphs with the 3D floating buttons  

X + Arrow key  Rotate the 3D graph around the X 
axis.  

With graph layer active and with 
Rotate button selected in the 3D 
floating button group. 
 

 

Y + Arrow key  Rotate the 3D graph around the Y 
axis.  

Z + Arrow key  Rotate the 3D graph around the Z 
axis.  

Q + Arrow key  Rotate the 3D graph in screen.  

http://www.originlab.com/doc/Origin-Help/CustomToolbar-Dialog
http://www.originlab.com/doc/Origin-Help/AxesRef-Scale
http://www.originlab.com/doc/Origin-Help/AxesRef-Scale
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Hot Key  Menu/Action  Context  

W + Arrow key  Rotate the 3D graph around any 
axes.  

Rotate 3D graphs using the mouse  

R + Mouse  Drag to rotate the 3D graph in an 
arbitrary direction.  

Press "R" before pressing other 
keys. 
 
Hovering on a 3D graph while 
pressing "R" changes the Pointer 

tool  to a . Press other 
keys, as needed, and drag with your 
mouse.  

R + Ctrl + Mouse  Rotate the 3D graph around the X 
axis.  

R + Shift + Mouse  Rotate the 3D graph around the Y 
axis.  

R + Ctrl + Shift + Mouse  Rotate the 3D graph around the Z 
axis.  

13.3 Reading Coordinate Values and Distances 

 Origin provides several tools to aid in labeling and graphical exploration of your data plots. Most of these tools 
are available from the Tools toolbar (View: Toolbars). There is a related tool -- Vertical Cursor -- available 
from the Gadgets menu.  

13.3.1 The Annotation Tool 

Use the Annotation tool to label a data point. The tool works with most Line + Symbol and Column/Bar plots. 
Choose from several standard data point labels or create your own custom label using LabTalk script.  

To annotate a data point:  

1. Click the Annotation button  on the Tools toolbar and move the cursor to the desired data point. The 

cursor and the Status Bar will display the current label form. 

 
2. Use the TAB to toggle between the following standard annotation forms: (X coordinate value, Y coordinate 

value); (X coordinate value, Y coordinate value)[index number]; X coordinate value; Y coordinate value; 

index number (row number); or Custom (see Tutorial, next). 

3. When you've selected your label form, double-click to add a label to the data point. 
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Tutorial: Customizing the Annotation String  

The annotation string can be customized by combining literal characters with the X and 
Y coordinate values:  

1. Start with a graph of your data  

2. Open the Script Window (Window:Script Window) and type the following 

command, then press Enter:  

system.annotation.customlabel$="X value: $(x,.2), Y 

value: $(y,*5) 

3. Click the Annotation button , hover on your graph, then press the Tab key 

several times to cycle through the annotation choices until the custom string 

format specified above is displayed in the Status Bar. The cursor will display the 

word "Custom". 

4. Start double-clicking on data points to add the custom annotation string. The X 

values will be displayed with two decimal places and the Y values will be displayed 

with 5 significant digits.  

Note: Please view more information on string formatting in the Programming help file:  

Help: Programming: LabTalk > Language Reference > Object Reference > Alphabetical 
Listing of Objects > String  

 

Press the ALT key and drag a label. Point to another data point using the Data Cursor 
and the label will now read the new data point.  

 

Switch to the Pointer  and drag to re-position overlapping labels. A leader line is 
automatically added.  

13.3.2 The Screen Reader tool 

The simplest data exploration tool is the Screen Reader . The Screen Reader works with the Data 
Display window to dynamically display the XY coordinates of the cursor on the graph page. The Data Display 
window opens automatically when you select the Screen Reader tool from the Tools toolbar.  

http://www.originlab.com/doc/LabTalk/ref/String-obj
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You can alter basic properties of the Data Display window by right-clicking on the window title bar or by right-
clicking inside the window.  

To use the Screen Reader:  

1. Click the Screen Reader button  on the Tools toolbar. This opens the Data Display tool.  

2. Click on a location in the graph page to read its X,Y, and Z coordinates (ternary and contour only). 

Coordinate values show in the Data Display tool.  

3. To increase cross-hair size, press the space bar.  

4. Click the Pointer button  on the Tools toolbar to exit screen reading mode. 

13.3.3 The Data Reader Tool 

Like the Screen Reader, the Data Reader tool is used to read information associated with a data point in your 
plot. However, because it works in concert with the customizable Data Info Window, it is potentially more 
powerful. Reported information can include XY(Z) coordinate values, plus metadata and even images 
describing the data point.  

The Data Reader  tool is grouped with one related tool -- the Data Cursor  tool. Only one of them 
will display at a time. To select a hidden tool, click on the small arrow in the lower-right corner of the button 
and select a tool from the shortcut menu.  

To use the Data Reader tool:  

1. Click the Data Reader  button on the Tools toolbar. This opens the Data Info window.  

2. Click on a data point to read its X,Y (and Z, if they exist) coordinates. Coordinate values display in the 

Data Info window (and Data Display window).  

3. To move the cross-hair to the next data point along the data plot, use the LEFT and RIGHT arrow keys or 

click on the data point using your mouse. If you have multiple plots in a layer, use UP and DOWN arrow 

keys to move it to a data point on another plot or user mouse to click it.  

4. To change the vertical and horizontal cross hair size, click on a point and press the spacebar to adjust. 

5. Click the Pointer button  on the Tools toolbar or Esc key to exit the Data Reader tool. 

 

 

You can turn off both types of tooltips, simultaneously, by running @PT=0; in the Script 
Window. To re-enable, run the corresponding command:  

@PT=1; //Enable showing tooltips for 2D graph 

@PT=2; //Enable showing tooltips for 3D OpenGL graph 

http://www.originlab.com/doc/Origin-Help/Data-Info-Tool
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@PT=3; //Enable showing tooltips for both 2D graph and 3D OpenGL 

graph 

13.3.4 The Data Cursor Tool 

  The Data Cursor tool -- grouped on the Tools toolbar with the Data Reader tool -- allows you to place one 
or more cursors on a data plot and (using the Data Info window) read the cursor coordinates or measure the 
X and Y distance between two cursors, or the distance between a cursor and a point selected with the Data 
Reader.  

 

Tutorial: Using the Cursor Tool to Measure Relative Distance  

1. Import the file Samples\Spectroscopy\Sample Pulses.dat and create a line plot. 

2. Click and select the Data Cursor button from the Tools toolbar.  

 

3. Double-click on one of the peaks or click once on a data point and press 

ENTER, to add a cursor object.  

 

4. Repeat to place a second cursor object on another peak.  

5. Double click in Data Info. window to open Data Info. Report Settings dialog. If 

this window is not visible, select the View: Show Data Info menu item to open 
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the Data Info. window. 

6. Switch to the Columns tab and then right-click in the gray area to the right of the 

columns and choose Add Column. 

7. In the new column that is added, click on the source row of new column, and select 

Relative (Cursor2 - Cursor1) from the drop-down, and then press OK to close 

the dialog. 

8. Now you can drag and move the cursor objects and the third column in the Data 

Info window will display the X and Y distances between the two cursors. 

 

 

13.3.5 The Data Info Window 

     The Data Info window opens when you choose either the Data Reader , the Annotation or the 

Data Cursor tools . At first glance, the Data Info window seems to duplicate the functionality of the Data 
Display tool (reading XY coordinates in the graph).  

 

However, the Data Info window is customizable and ultimately, more powerful than the Data Display window. 
In addition to numerical data, you can display other classes of data -- metadata and images -- associated with 
a particular data point.  
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To customize the display of the Data Info window, right-click on the Data Info window and choose 
Preferences... from the shortcut menu; or simply double-click on the Data Info window. Use the controls in 
the Data Info Report Settings dialog box to customize the display of the Data Info window:  

 

• The Title tab is used to specify how the report title is displayed in the upper left corner of the Data Info 

window.  

• The Rows tab is used to specify which columns in the data worksheet are shown in the Data Info window.  

• The Columns tab allows control over what displays in the Data Info window. In addition to the data 

groups that are chosen in the Rows tab, the user can choose to show additional information such as the 

Long Name, Short Name, Units, and data contained in individual cells.  

• The Display tab contains options for customizing the display properties of the Data Info window. 

• At the top of the dialog, there is a Dialog Theme control. The Data Info window customizations can be 

saved to the graph, layer and even plot level so that every time you use the Data Reader, Cursor, or 

Annotation tools on an applicable graph, layer or plot, your customized Data Info window will display; Or 

you can save customizations as a Theme file for later use. 

 
For more information on customizing the Data Info window, see:  

• The Data Info Window. 

• Tutorial: The Data Reader Tool (discussion on customizing the Data Info window). 

http://www.originlab.com/doc/Origin-Help/Data-Info-Tool
http://www.originlab.com/doc/Tutorials/DataReader
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13.3.6 Gadgets 

    Origin provides several Gadgets for data exploration and analysis. These gadgets are accessible from the 
Gadgets menu when a graph window is active. Three gadgets in particular are suitable for data exploration:  

• Vertical Cursor 

• Statistics 

• Cluster (OriginPro) 

The Vertical Cursor gadget is especially useful for reading XY coordinate values for data points in stacked 
panel plots or multi-plot graphs, where plots share a common X scale.  

To open the Vertical Cursor:  

1. With a graph window active, choose Gadgets: Vertical Cursor... from the main menu. This opens the 

Vertical Cursor dialog box. 

Using the controls in this Gadget's dialog box, you can add data labels to the graph, increase or decrease label 
font size, hide labels, etc.  

 

 

The Statistics gadget returns basic statistics on data points falling inside a rectangular region-of-interest 
(ROI) on the graph.   

• Display basic statistics for data inside the ROI. 

http://www.originlab.com/doc/Origin-Help/Gadget-VerticalCursor
http://www.originlab.com/doc/Origin-Help/Gadget-Statistics
http://www.originlab.com/doc/Origin-Help/Gadget-Cluster
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• Display mean and nth Standard Deviation lines inside the ROI. 

• Update results dynamically as ROI is moved or resized. 

 

 

The Cluster gadget (available in OriginPro) provides the following features:  

• Display basic statistics for data inside a region of interest (ROI). 

• Switch between rectangular or elliptical ROI. 

• View statistics for points inside and outside of the ROI. 

• Edit, copy, mask, delete or group data points. 

• Update results dynamically as ROI is moved/re-sized. 

• Output results to a worksheet. 

 

For 2018, when you use the Cluster gadget to define a category (points within a ROI on a 
plot), you can apply a differentiating color to points within the ROI. 
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Note: To learn more about these gadgets, see:  

Help: Origin: Origin Help > Gadgets  

http://www.originlab.com/doc/Origin-Help/Gadgets
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13.4 Topics for Further Reading 

• Gadgets 

• The Data Analysis chapter of this User Guide 

• The Cluster Gadget (OriginPro) 

• The Vertical Cursor Gadget 

• The Digitizer 

• The Statistics Gadget 

• Masking Data 

• Data Filtering 

• Drawing or Deleting Data Points in the Graph 

• List of Origin Built-in Toolbars and Buttons 

http://www.originlab.com/doc/Origin-Help/Gadgets
http://www.originlab.com/doc/User-Guide/Data-Analysis
http://www.originlab.com/doc/Origin-Help/Gadget-Cluster
http://www.originlab.com/doc/Origin-Help/Gadget-VerticalCursor
http://www.originlab.com/doc/Origin-Help/Tool-Digitizer
http://www.originlab.com/doc/Origin-Help/Gadget-Statistics
http://www.originlab.com/doc/User-Guide/Data-Analysis
http://www.originlab.com/doc/Origin-Help/Wks-DataFilter
http://www.originlab.com/doc/User-Guide/Data-Analysis
http://www.originlab.com/doc/User-Guide/Toolbars
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14 Gadgets 

Gadgets provide a quick and easy way to perform exploratory analysis on plotted data. The concept is simple: 
While each Gadget has a specific purpose, each is built around applying a set of customizable analysis 
operations to a range of plotted data defined by a movable, resizable, region-of-interest (ROI) object.  

You can drag to modify the ROI at any time, then change your analysis options and recalculate results by 
clicking the arrow button in the upper-right corner of the ROI and choosing one of the menu options. For 
general access to Gadget formatting and analysis options, choose Preferences at the bottom of the context 
menu. Use the Preferences Dialog Theme box to save a group of Gadget settings to a Theme file.  

Multiple Gadgets are supported on a graph. You can distinguish ROIs by giving each a different color. Click on 
an ROI object to bring it forward. When an ROI is selected, you can use the TAB key to switch the ROI.  

                 

 

 

Origin 2016 introduced add-on tools called Apps. Since being introduced, many new 
exploratory and analysis-related tools have been added to OriginLab's File Exchange 
and more tools are being released all the time. Please visit the File Exchange to review 
available tools.  

http://www.originlab.com/fileexchange/index.aspx
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14.1 Origin Gadgets 

The Gadgets main menu is available when a graph window is active. There are 14 gadgets available in Origin:  

Cluster Gadget†  View statistics on points inside/outside a rectangular or elliptical ROI (OriginPro 
Only).  

Differentiate Gadget  Calculate and plot the nth-order derivative of selected data.  

FFT Gadget  View FFT spectrum of selected data.  

Integration Gadget  Calculate the area under a curve, or between two curves.  

2D Integration Gadget  Calculate the 2D integration for a contour or image graph created from matrix or 
XYZ worksheet data (OriginPro Only).  

Interpolate Gadget  Perform linear, spline, b-spline or Akima spline interpolation of selected data.  

Intersect Gadget  Calculate the intersection points of two or more data plots.  

Quick Fit Gadget  Perform linear, polynomial, or nonlinear fitting of selected data.  

Quick Peaks Gadget  Locate peaks, and compute area and other peak properties.  

Quick Sigmoidal Fit 
Gadget  Perform Sigmoidal fit of selected data.  

Rise Time Gadget  Analyzes rise/fall time for the step-like signal (OriginPro Only).  

Statistics Gadget  Compute and display simple descriptive statistics of selected data on the graph.  

Vertical Cursor Gadget  Read and tag X, Y coordinate values for data plots across multiple graphs that 
share the same X axis.  

Image/Contour Profile  Analyze the image or contour from matrix data and generate profiles.  
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Note: To learn more about these gadgets, see:  

Help: Origin: Origin Help > Gadgets  

Help: Origin: Origin Help >Matrix Books Matrix Sheets and Matrix Objects > Viewing and 
Profiling Matrix Data  

 

† For 2018, when you use the Cluster gadget to graphically define a category (within 
an ROI), you can apply a differentiating color to points within the ROI. 

 

Tutorial: Using the Integrate Gadget to Output Results to a Worksheet  

1. With a new workbook active, import the file Peaks on Exponential Baseline.dat 

located in the Samples\Spectroscopy subfolder under the Origin installation folder. 

2. Create a line plot of the data in column B. 

3. With the graph active, go to the main menu and click Gadgets: Integrate.... 

4. In the dialog box that opens, click the Baseline tab and select Straight Line from 

the Mode drop-down list. 

5. Click the Output tab, and under the Output Quantities to node, select Append to 

Worksheet and clear the other check boxes. 

6. Expand the Quantities node, select None from the Dataset Identifier drop-down 

list and enable Beginning X and Ending X. 

7. Press OK to close the dialog box. The Region-of-Interest (ROI) rectangle object is 

added to the graph. 

8. Resize and move the ROI object to cover just the first peak in the data plot, then 

press the arrow button located at the top-right of the ROI and select New Output. 

This will write the parameters for the first peak to a worksheet. 

9. Drag and move the ROI to cover the second peak, and repeat the steps above to 

generate output for the second peak. 

10. Press the arrow button again and this time select Go to Report Worksheet. A 

worksheet with the integration results will open. 

http://www.originlab.com/doc/Origin-Help/Gadgets
http://www.originlab.com/doc/Origin-Help/View-Profile-MatData
http://www.originlab.com/doc/Origin-Help/View-Profile-MatData
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Click the arrow button in the top right corner of the ROI and you can opt to output 
results for all curves in the current layer (New Output for all Curves (N)) or for all 
layers of the graph page (New Output for All Layers (L)) or press the corresponding 
N or L hotkey. This allows for batch analysis of multiple curves in a graph.  

14.2 Topics for Further Reading 

• Gadgets 

• The Image/Contour Profile tool 

• Tutorial: Using Multiple Gadgets 

• Tutorials for Individual Gadgets 

• Peak Analyzer 

• Digitizer 

http://www.originlab.com/doc/Origin-Help/Gadgets
http://www.originlab.com/doc/Origin-Help/View-Profile-MatData
http://www.originlab.com/doc/Tutorials/Using-Multiple-Gadgets
http://www.originlab.com/doc/Tutorials/Gadgets
http://www.originlab.com/doc/Origin-Help/PeakAnalyzer
http://www.originlab.com/doc/Origin-Help/Tool-Digitizer
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15 Data Analysis 

15.1 Introduction 

Origin contains powerful tools for all of your analytic needs, including peak analysis, curve fitting, statistics, 
and signal processing. The output of one operation can be used as input for another, allowing for a chain of 
operations and their associated results to be updated. You can easily update results when input data or 
analysis parameters are changed and avoid the trouble of repeating the procedure from the beginning.  

The following sections cover (1) delineating the data that you wish to analyze and (2) the Origin and OriginPro 
tools available for analyzing that data. Please refer to the How to Handle Repetitive Tasks chapter of this User 
Guide for more information on Analysis Templates, Dialog Themes and other time-saving features.  

 

Origin 2016 introduced add-on tools called Apps. Since being introduced, many new 
exploratory and analysis-related tools have been added to OriginLab's File Exchange 
and more tools are being released all the time. Please visit the File Exchange to review 
available tools.  

15.2 Selecting Data 

Origin's analysis can be performance from workbook or graph windows. By default analysis will be on done on 
highlighted data in worksheet or active plot in graph. You may want to restrict your analysis to a subset of the 
data; say, a certain range of rows or columns in a worksheet, or a certain X range in a graph.  

You can either do the data selection (with methods mentioned below) before opening an analysis dialog or 
after opening the dialog. Most of Origin's X-Function based analysis tools have a Input Data branch with 
standard range selection control that you'll want to become familiar with (we explain the control, below).  

15.2.1 Selecting Data in the Worksheet 

When you highlight a range of worksheet data, then open one of X-Function based dialog boxes -- that would 
include nearly all of those that open from the Analysis or Statistics menus -- you will see your range 
selection already entered into the dialog box Input Data branch. Most will find that selecting worksheet data 
prior to opening an Analysis or Statistics dialog box, is the easiest way to specify which data you wish to 
analyze. 

 

http://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
http://www.originlab.com/fileexchange/index.aspx
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If you open one of the X-Function dialog boxes without pre-selecting your data, the first thing you should do 
after openning a dialog is to select data in Input Data branch: 

 

1. Click the range selection control next to Input Data. The dialog box will roll up. 

2. Go to worksheet and highlight your worksheet data, then click the button at the right end of the 

rolled up dialog box. The Input Data branch will now show the selected range. 

Note that you do not have to select entire datasets (columns). You can select a portion of your worksheet data 
and analyses will be confined to that selected subset of your data. Also if the analysis supports multiple 
datasets, you could support multiple ranges such as multiple Y columns or Y ranges. If the analysis only 
supports one dataset, though you could select multiple ranges, only the 1st range will be picked in analysis.  
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Note:  

• The Input Data branch has a hierarchical structure. If the analysis supports multiple datasets, you can 

add multiple ranges under Input Data and they will show as Range 1, Range 2, etc., each with its 

corresponding X, Y, Error and Row controls.  

• Mousing over each level will show a tooltip of where the data on that level is from (i.e. book, sheet and 

column). 

• Rows control under each range node lets you set range by row index or X value. If you want to apply the 

same row range to all ranges under Input Data, click the arrow button to the right of the range node and 

choose Apply Row Range to All. 

• Depending on where you are in the Input Data hierarchy, range selection button may have some 

limitations. E.g. if you click range selection control next to Y, though you could select multiple columns in 

a worksheet, only the 1st column is accepted.  

• Click the arrow button to the right of the range selection control will show more selection options, such as 

pick a column there to do quick data selection.  

• Depending on which level you are in, the selection options when clicking the arrow button may vary, such 

as clicking the "arrow" button next to Input Data, you will see a Select Columns... menu, which opens 

Column Browser to select multiple columns even from different worksheets.  

 

Use List Datasets drop-down list to filter which sheets you want to pick from. The top panel list can be sorted 
by clicking any of the column headings, making it easy to select, for example, all columns that share the same 
LName or Comments. Then click Add button to add the column to your selection list in bottom panel. To 
modify the data input range of any dataset, click the range button to the right of any dataset added to the 
bottom panel and edit the From and To values.  
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15.2.2 Selecting Data in the Graph 

  When a graph window is active and you select one of the Analysis menu tools, the default behavior is for the 
analysis dialog box to open showing the selected range of the active dataset as your Input Data (note that 
analysis dialogs include an Input Data node that allows adjustments -- adding more datasets with the 
interactive range selector button, changing a data range, etc.).  

The active dataset is the one that shows in the data list (bottom of the Data menu) with a check mark next to 
it. Note that this analysis dialog box behavior applies even to plot groups. You can force an Analysis dialog 
box to register a particular data range by clicking on another of the data plots listed at the bottom of the Data 
menu.  

 

Alternately, you can graphically set the range for your analysis by selecting one or more plots in the graph 
window:  

• If your data plots are not part of a plot group, you can click once on the intended plot before opening an 

Analysis dialog box and this will set the Input Data range to the selected plot. 

• If your data plots are part of a plot group, click once on any of the plots in the group to set Input Range 

to all plots in the group; or click a second time on any plot to restrict analysis to the selected plot (note 

that this does not switch the active dataset). Alternately, you can pre-select multiple plots using the 

Regional Data Selector (see below). 

 

You can indicate the active dataset by placing a red rectangle around the plot's legend 
entry. To turn this feature on or off:  

• Click on your graph window, select Format: Page Properties..., click on the 

Legends/Titles tab and enable or clear the Indicate Active Dataset box.  

• Right-click on the graph and choose Legend, then select/deselect Indicate Active 

Dataset. 

• Right-click on the graph and choose Legend: Update Legend and enable or clear 

the Indicate Active Dataset box. 

http://www.originlab.com/doc/User-Guide/Graphing
http://www.originlab.com/doc/User-Guide/Graphing
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15.2.3 Selecting a Subset of Your Data Graphically 

You can graphically select a range of data using the Regional Data Selector tool:   

1. With a graph window active, click and hold the Regional Data Selector button  on the Tools toolbar, 

and then choose Selection on Active Plot or Selection on All Plots. 

2. Drag out a rectangle or freehand object to select an area of the plot(s). Press Space to toggle between 

rectangle and freehand modes . 

 

When you make your selection, data markers appear on the graph, delineating the selected range(s). You can 
work with graphically selected data using Origin's analysis tools (e.g., Linear Fit), but note that some analysis 
dialog boxes do not work on multiple data ranges. The smoothing dialog box, for example, (Analysis: Signal 
Processing: Smooth...) will only smooth data in the active dataset or a single, selected plot.  

 

Tutorial: Linear Regression on Partial X Range  

1. Import the file \Samples\Curve Fitting\Exponential Decay.dat into a new 

workbook. 

2. Select all Y columns and create a line plot. 

3. Click and hold the Regional Data Selector button on the Tools toolbar, and then 

choose the Selection on All Plots button . 

4. Drag out a rectangle to select the tail-end of the three curves between values of 

approximately 0.6 and 1.0 along the X axis. 

5. Use the Analysis:Fitting:Linear Fit menu to open the Linear Fit dialog.  

6. Input Data branch is filled with three ranges. Mouse over Input Data branch will 

show tooltip which shows 1X,1Y, ...3X and 3Y.  

7. If you want to change the data selection, click the arrow button in Input Data 

and choose Reselect All Data from Graph. The dialog will roll up. Drag out a 

rectangle in graph again to make your selection and then click the  button at 

the right end of the rolled up dialog box. The new data selection will show in Input 

Data branch. 

8. Accept default Linear Fit settings and press OK to close the dialog. Linear fitting 

will be performed on all three curves over the selected range. 
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In addition to the data selection and masking methods discussed in this section, Origin 

includes data filtering and data reduction tools. Please visit the linked pages for details. 

15.2.4 Editing a Data Marker 

To edit a data marker:   

• To modify a data range, right click a data marker and choose Edit or double-click on data marker. The red 

marker changes to dark color with arrows on both ends and cursor changes into a target. Drag start or 

end marker to a new position or use one of the keyboard shortcuts listed below and modify the data 

range. To escape edit mode, double-click on the marker or press Enter key.  

• There are other options when right click data marker such as delete marker, delete data, etc.. 

 

http://www.originlab.com/doc/Origin-Help/Wks-DataFilter
http://www.originlab.com/doc/Origin-Help/Wks-DataReduction
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Note: If you have used the Regional Data Selector tool to place markers on multiple plots (Selection on 
All Plots), be aware that moving markers will affect the data range of the active plot only; the ranges of 

other selected plots will not follow that of the active plot. This is a limitation of the Regional Data Selector.  

 
Alternately, you can use these keyboard shortcuts to select and edit data markers:  

1. Select data markers using these keys ...  

Hot Key  Action  

s  Select the first pair of data markers on the graph (those marked with "1").  

Tab  Select the next pair of data markers (not in edit mode) or the other data 
marker of the pair (in marker edit mode).  

Home  Return to the first data marker.  

End  Go to the last data marker.  

2. ... then activate and edit the data marker using these key combinations:  

Hot Key  Action  

Enter  Activate the selected data marker for editing. (Press Enter again to exit 
data selection mode.)  

Arrow  Move the active data marker exactly one data point.  

Ctrl/Shift + Arrow  Move the active data marker multiple data points.  

Delete  Delete the the active data marker.  

15.2.5 Difference between Data Markers and Analysis Markers 

   

• Data Markers define a sub-range that you select using the Data Selector tool.  

If you want to remove the data markers from a graph, you can select Data: Clear Data Markers from 

the main menu, or click the Clear Data Markers  button on the Markers and Locks toolbar. 
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• When the analysis routine is completed, Data Markers are replaced with Analysis Markers. By default, 

Analysis Markers will not show if the analysis is done on the entire dataset. If performed on a subrange, 

Analysis Markers will show at the beginning and end of that subrange. To modify the data range and rerun 

your analysis, you must right-click an analysis marker and choose Change Parameters.... Change the 

Input Data range and rerun the analysis. 
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Note:  

1. If you set Recalculate to None in the analysis dialog box, then no analysis markers are 

generated. 

2. Data markers and analysis markers are not exported when you choose File: Export Graphs. 

3. To select the exact same range again for another analysis, click the green lock and choose Plot 

Input Data with Data Markers to create a new graph and do analysis on it. 

4. There is a Markers and Locks toolbar to control analysis markers and locks, such as Marker 

Hide Show  to toggle analysis markers on or off, etc. There is also Data: Analysis Marker 

menu and context menus when right click on analysis marker, green lock, in graph layer to control 

analysis markers. 

15.3 Data Masking 

Masking is another tool that you can use when you want to analyze only a subset of your data, or when you 
have spurious data points that you do not want included in your analysis. Mask or unmask will trigger 
recalculation.  

You can mask data points in either your worksheet or your graph. When data exist in both the worksheet and 
the graph, masking data in one will mask the corresponding data in the other.  

Note that there are two toolbars with masking buttons: the Tools toolbar and the Mask toolbar. The masking 
tools on the Tools toolbar work only with graphs. The tools on the Mask toolbar work with worksheets or 
graphs.  

15.3.1 Masking Data in Worksheets 

Masking of worksheet data excludes masked data from analysis operations. When plotted, masked data points 
display in the mask color.    

Action  Toolbar 
Button  Shortcut Command  Notes  

Mask data  
 

Mask: Range  
Mask the selected data range. 
Masked data will display in the mask 
color.  

Unmask data  
 

Mask: Clear Range  

Unmask the selected data range. 
Unmasked points are included in 
analysis operations and plot 
"normally".  

Change mask 
color   

Mask: Change Color  Change the mask color of the 
masked data range.  

Disable masking  
 

Mask: Disable Masking  Toggle the mask on or off for all 
masked data in the worksheet.  

http://www.originlab.com/doc/Origin-Help/AnalyDialog-Recalculate
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15.3.2 Masking Data in Graphs 

 With your graph window active:  

1. Choose Data: Mask Data Points from the main menu or click the Mask Points on Active Plot button or 

Mask Points on All Plots button on the Tools toolbar. This activates the Regional Mask Tool.  

2. To mask a single point, double click on the point.  

3. To mask a region of points, similar to Regional Data Selector, press the space bar to toggle among 

masking by row index, rectangular region or by freehand region. then draw a rectangle or freehand region 

to mask data in that region. 

Note that the cursor changes as you:  

• Press space bar to toggle masking data points by row index number, rectangular region or freehand 

region. 

• Choose the Mask Points on the Active Plot  tool vs. the Mask Points on All Plots of Active 

Layer  tool (Tools toolbar). 

Mask Points 
on Active Plot  

Mask Points on All 
Plots of Active 

Layer  
Purpose  

 
 

Mask data points by row index number. All data points between 
the lowest and highest selected index numbers are masked 
regardless of whether they lie inside your rectangle.  

 

 

Mask data points by rectangular region. Only the data points inside 
the rectangle that you drag out, will be masked.  

 

 

Mask data points by freehand region. Only the data points inside 
the region that you drag out, will be masked.  

To remove the mask from data points in the graph window:  

1. Choose either the Unmask Points on the Active Plot  tool or the Unmask Points on All Plots of 

Active Layer  tool on the Tools toolbar.  

2. Use the space bar, as needed, to choose points by index, rectangular region or by freehand region, then 

drag to unmask your data points. 
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There are some useful buttons on Mask toolbar such as  

• Change mask color button to avoid using same color as data plot as mask color. 

• Hide/Show masked points to hide masked points on the screen, printout and 

exported graph. 

• Disable/Enable Masking  button to quickly toggle the mask on or off without 

removing the masked points. 

15.4 Drawing or Moving, or Deleting Data Points in the Graph 

  This collection of tools and menu-driven operations is helpful in exploring certain "what if" scenarios, or to 
quickly generate some data for purposes such as testing a fitting function. These procedures work only with 2D 
scatter plots.  

1. Activate the graph window. 

2. Click on the Draw Data Tool . 

3. Make sure that the correct graph layer is active and place the cursor on the graph.  

4. Double-click to create data points. The Data Display tool opens (if not already open) and displays the X 

and Y values for each created data point. 

5. When you have finished adding data points, click on another tool (on the Tools toolbar) to exit drawing 

mode.  

When you use the Draw Data tool, you simultaneously create a hidden worksheet named Drawn (worksheets 
are automatically enumerated, with n = 1, 2, 3, 4, etc.).  

15.4.1 Opening the hidden Drawn Worksheet 

Right-click on the data plot and select Go to Drawn from the shortcut menu or in Plot Details dialog, with data 
plot selected on left panel, click the Workbook button.  

A Drawn workbook will appear with A(X) and B(Y) columns with coordinate values of your drawn data plot.  

15.4.2 Deleting a Data Point 

You can delete individual data points from your graph:  

1. Select Data: Remove Bad Data Points.  

2. Double-click on the data point, or click to select the data point and press ENTER key.  

3. Click Arrow button on Tools toolbar or press ESC key to exit the Remove Bad Data Points mode. 

The data point is deleted from both the data plot and the worksheet cell. In the worksheet, only the data cell 
for the Y value will be cleared and shown as missing value.  
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15.4.3 Moving a Data Point 

You can move individual data points in the graph. Understand that when you do this, you are changing the plot 
and the underlying data:  

1. Select Data: Move Data Points (you'll be warned that you are about to change your data). 

2. Click on the point you want to move (change X and Y coordinates). Place crosshairs on the point and drag; 

or use the arrow keys.  

3. Click the Pointer button  on the Tools toolbar or press ESC to exit the Move Data Points mode. The 

data point is moved in the plot and the X and Y coordinates are changed in the worksheet cell.  

15.5 Mathematics 

Origin provides a number of mathematics tools to perform basic calculations, interpolation, and area or volume 
calculations.  

15.5.1 Basic Math 

 Tool Name  Description  Menu Entry  

• Simple Column 

Math/Simple Curve Math 

• Normalize 

Columns/Curves 

• Average Multiple Curves 

• Differentiate 

• Perform basic calculations on 

worksheet columns or XY data 

plots 
Analysis:Mathematics 
(workbook, graph)  

• Differentiate Gadget 
• Perform differentiation over a 

region of interest in a graph  Gadgets:Differentiate... 
(graph)  

• Set Column Values 
• Use formulae to set/transform 

worksheet column values Analysis:Mathematics 
(workbook)  

• Inverse 
• Generate pseudo inverse of a 

matrix Analysis:Mathematics 
(matrix)  

• Median Filter 

• Special Filter 

• Custom Filter 

• Apply median/special/custom 

filter to a matrix Analysis:Mathematics 
(matrix)  
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15.5.2 Interpolation 

  

Tool Name  Description  Menu Entry  

• Interpolate Gadget 
• Perform interpolation over a 

region of interest Gadgets:Interpolate... 
(graph)  

• Interpolate/Extrapolate 

• XYZ Trace 

Interpolation(3D Graph)  

• Trace Interpolation(2D 

Graph) 

• Perform 

interpolation/extrapolation on a 

group of XY data. 

• Perform periodic interpolation 

on XYZ worksheet data 

• Perform interpolation on cycle 

or periodic curves 

Analysis:Mathematics 
(workbook, graph)  

• Interpolate/Extrapolate Y 

from X 

• 3D Interpolation  

• Perform 

interpolation/extrapolation on a 

group of XY data to find Y at 

given X values. 

• Perform interpolation with a 3D 

function on XYZ dataset.  

Analysis:Mathematics 
(workbook)  

• 2D 

Interpolate/Extrapolate 

• Perform 2D 

interpolation/extrapolation for a 

matrix 
Analysis:Mathematics 
(matrix, graph from matrix)  
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15.5.3 Area/Volume Calculation 

  

Tool Name  Description  Menu Entry  

• Integrate Gadget 
• Perform integration over a 

region of interest in a 2D Graph Gadgets:Integrate... (graph)  

• Integrate(2D Graph) 

• Polygon Area(2D Graph) 

• XYZ Surface Area (3D 

Graph) (Pro Only) 

• Perform integration on input 

data 

• Calculate the area of enclosed 

plot regions 

• Calculate the area of the XYZ 

surface  

Analysis:Mathematics 
(workbook, graph)  

• 2D Volume Integrate (Pro 

Only) 

• Matrix Surface Area (Pro 

Only) 

• Calculate the volume beneath 

the matrix surface from zero 

plane 

• Calculate the area of the matrix 

surface 

Analysis:Mathematics 
(matrix, 3D graph from matrix)  

15.6 Curve Fitting 

15.6.1 Linear and Polynomial Fit 

 Linear and polynomial fitting can be performed on worksheet data or data plots in a graph. The menu entries 
of these tools are listed in the table below. All are available for both workbook or plotted data.  

Tool Name  Menu Entry  

• Linear Fit Analysis:Fitting:Linear Fit 
or 
Gadgets:Quick Fit (graph)  

• Fit Linear with X Error (Pro Only) 
Analysis:Fitting:Fit Linear with X Error  

• Multiple Linear Regression 
Analysis:Fitting:Multiple Linear Regression  
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Tool Name  Menu Entry  

• Polynomial Regression Analysis:Fitting:Polynomial Fit 
or 
Gadgets:Quick Fit (graph)  

15.6.2 Nonlinear Curve Fit 

  You can perform nonlinear curve fitting using one of many built-in fitting functions, or you can create a user-
defined fitting function. OriginPro supports implicit function fitting, surface fitting, and fit comparison. Some 
tools are available only in OriginPro.  

The table below summarizes available nonlinear curve fitting tools:  

Tool Name  Features  Menu Entry  

• Quick Fit Gadget 

• Fit a region of interest in a 

graph interactively 

• Fit with built-in or user-defined 

fitting functions 

• Fit one or multiple datasets 

Gadgets:Quick Fit (graph) 
or 
Gadgets:Quick Sigmoidal 
Fit (graph)  

• Nonlinear Curve Fitting 

• Fit with built-in or user-defined 

fitting functions 

• Fit one or multiple datasets 

• Compare fit, multiple 

parameter sets 

• Global fit with parameter 

sharing 

• Global fit, parameter sharing 

with multiple functions (Pro 

Only) 

• Fit with replicas 

• Advanced options including 

bounds, constraints, fit control 

Analysis:Fitting:Nonlinear 
Curve Fit (workbook, graph)  

• Implicit Curve Fitting (Pro 

Only) 

• Fit with implicit functions 

• Orthogonal Distance Regression 

(ODR) algorithm 

Analysis:Fitting:Nonlinear 
Implicit Curve Fit (workbook, 
graph)  
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Tool Name  Features  Menu Entry  

• Surface Fit (Pro Only) 
• Fit data from a matrix or 

worksheet XYZ columns 

Analysis:Fitting:Nonlinear 
Surface Fit (workbook, graph) 
or 
Analysis:Nonlinear Matrix 
Fit (matrix)  

• Fitting Function Builder 
• Create or edit user-defined 

fitting functions Tools:Fitting Function 
Builder  

• Fitting Function Organizer 

• Manage fitting functions by 

categories 

• Move or share functions 

between categories 

Tools:Fitting Function 
Organizer  

• Simulate 

• Simulate a curve from a given 

function 

• Simulate a surface from a given 

function (Pro Only) 

Analysis:Fitting:Simulate 
Curve 
or 
Analysis:Fitting:Simulate 
Surface  

• Fit Comparison (Pro Only) 

• Compare fit results from two 

datasets using one function 

function 

• Compare fitting results for one 

dataset using two fitting 

functions 

Analysis:Fitting:Compare 
Datasets 
or 
Analysis:Fitting:Compare 
Models (workbook, graph)  

• Fit and Rank Functions 

(Pro Only) 

• Compare fit results of two or 

more functions for a single 

dataset 
Analysis:Fitting:Rank 
Models (workbook, graph)  



Data Analysis 

195 

15.7 Peak Analysis 

 Origin provides several tools for peak analysis. With these tools, you can define and subtract baselines, find 
peaks, integrate peaks, and fit peaks. Some tools are available only in OriginPro.  

The table below summarizes various tools available for peak analysis:  

Tool Name  Features  Menu Entry  

• Quick Peaks Gadget 

• Perform peak analysis over a 

region of interest  

• Create baseline 

• Subtract baseline 

• Find peaks 

• Integrate peaks 

• Fit peaks 

Gadget:Quick Peaks (graph)  

• Multiple Peak Fit 
• Pick multiple peaks 

• Fit peaks 
Analysis:Peaks and 
Baseline:Multiple Peak Fit 
(graph, workbook)  

• Peak Analyzer 

• Create baseline 

• Subtract baseline 

• Find peaks 

• Integrate peaks 

• Fit multi-peak datasets (Pro 

Only) 

• Fit baseline (Pro Only) 

• Find hidden peaks  

• Compute many peak 

characteristics (Pro Only) 

Analysis:Peaks and 
Baseline:Peak Analyzer  
(graph, workbook)  

• Batch Peak Analysis 

• Use a theme file created using 

Peak Analyzer tool 

• Perform batch peak analysis on 

multiple datasets 

Analysis:Peaks and 
Baseline:Batch Peak 
Analysis Using Theme 
(graph, workbook)  
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15.8 Signal Processing 

Origin provides signal processing tools for many tasks, including producing signal transforms, 
smoothing/filtering, and correlation on 1D and 2D signals. Advanced tools are available in OriginPro.  

You may refer to the tables below for the signal processing tools and their menu entry.  

15.8.1 Signal Transforms 

 Tools  Menu Entry  

• FFT Gadget 
Gadgets:FFT... (graph)  

• Fast Fourier Transform (FFT) 

• Inverse Fast Fourier Transform 

(IFFT) 
Analysis:Signal Processing:FFT 
(workbook)  

• 2D FFT (Pro Only) 

• 2D IFFT (Pro Only) Analysis:Signal Processing:FFT (matrix)  

• Short-time Fourier Transform 

(STFT) (Pro Only) Analysis:Signal Processing:STFT 
(workbook)  

• Hilbert Transform (Pro Only) Analysis:Signal Processing:Hilbert 
Transform (workbook)  

• Image Profiling Plot>2D:Profile:Image Profile(matrix, 
worksheet, XYZ data)  

15.8.2 Filtering 

    

Tools  Menu Entry  

• FFT Filter Analysis:Signal Processing:FFT Filters 
(workbook)  

• 2D FFT Filter (Pro Only) Analysis:Signal Processing:2D FFT 
Filters (matrix)  
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Tools  Menu Entry  

• IIR Filter Design (Pro Only) Analysis:Signal Processing:IIR Filter 
(workbook)  

15.8.3 Smoothing 

   

Tools  Menu Entry  

• Smooth Analysis:Signal Processing:Smooth 
(workbook, matrix)  

15.8.4 Correlation 

  

Tools  Menu Entry  

• Correlation Analysis:Signal Processing:Correlation 
(workbook)  

• 2D Correlation (Pro Only) Analysis:Signal Processing:2D 
Correlation (matrix)  

15.8.5 Convolution 

  

Tools  Menu Entry  

• Convolution Analysis:Signal 
Processing:Convolution (workbook)  
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15.8.6 Wavelet Analysis (Pro Only) 

  

Tools  Menu Entry  

• Continuous Wavelet Transform 

• Discrete Wavelet Transform 

(Decomposition) 

• Inverse Discrete Wavelet 

Transform (Reconstruction) 

• Multi-Scale Wavelet 

Decomposition 

• Smoothing 

• Noise Removal 

Analysis:Signal Processing:Wavelet 
Analysis (workbook)  

• 2D Wavelet Decomposition 

• 2D Wavelet Reconstruction Analysis:Signal Processing:Wavelet 
Analysis (matrix)  

15.8.7 Other Advanced Tools (Pro Only) 

     

Tools  Menu Entry  

• Rise Time Gadget 
Gadget:Rise Time (graph)  

• Decimation Analysis:Signal Processing:Decimation 
(workbook)  

• Coherence Analysis:Signal Processing:Coherence 
(workbook)  

• Envelope Curves Analysis:Signal Processing:Envelope 
(workbook)  
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15.9 Image Processing 

 Origin provides a collection of tools for basic image processing. These tools are accessible from the Image 
menu when a matrix book is active. The tools are organized in the following sub-menus:  

• Image:Adjustments 

• Image:Arithmetic Transforms 

• Image:Conversion 

• Image:Geometric Transforms 

• Image:Spatial Filters 

15.10 Topics for Further Reading 

• Analysis Dialog Boxes: Specifying Your Input Data 

• Outputting Analysis Results 

• Recalculation of Analysis Results 

• Generating Analysis Report Sheets 

• Performing Math Operations on Datasets 

• Linear/Polynomial Regression 

• Nonlinear Curve Fitting 

• Peak Analysis using Origin 

• Signal Processing 

• Image Processing and Analysis 

http://www.originlab.com/doc/Origin-Help/AnalyDialog-SpecifyInput
http://www.originlab.com/doc/Origin-Help/AnalyDialog-OutputResult
http://www.originlab.com/doc/Origin-Help/AnalyDialog-Recalculate
http://www.originlab.com/doc/Origin-Help/Analysis-Rep-Wks-Cols
http://www.originlab.com/doc/Origin-Help/Mathematics
http://www.originlab.com/doc/Origin-Help/Linear-Polynomial-Regression
http://www.originlab.com/doc/Origin-Help/Nonlinear-Curve-Fit
http://www.originlab.com/doc/Origin-Help/PeakAnalysis
http://www.originlab.com/doc/Origin-Help/Signal-Processing
http://www.originlab.com/doc/Origin-Help/Image-Processing-Analysis
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16 Statistics 

16.1 Basic Statistics 

Origin provides several tools and methods to compute basic statistics on data from either the worksheet or 
from a graph.    

 

Origin 2016 introduced add-on tools called Apps. Since being introduced, many new 
exploratory and analysis-related tools have been added to OriginLab's File Exchange 
and more tools are being released all the time.To see what is available, point to the 
Add Apps button in the Apps Gallery" to the right-side of your workspace and 
double-click. In the App Center dialog that opens, you will find New and Popular 
Apps. In this dialog, you can download new Apps or update existing Apps. 

16.1.1 Basic Statistics on Worksheet 

Descriptive Statistics  Menu entry with worksheet active  

• Statistics on Columns 

• Statistics on Rows Statistics:Descriptive Statistics  

• Cross Tabulation (Pro Only) 
Statistics:Descriptive Statistics  

Frequencies/Counts   

• Frequency Counts 

• 2D Frequency Counts/Binning 

• Discrete Frequency 
Statistics:Descriptive Statistics  

Distribution   

• Normality Test 

• Distribution Fit (Pro Only) Statistics:Descriptive Statistics  

Relationship   

• Correlation Coefficient (Pro Only) 

• Partial Correlation Coefficient (Pro Only) Statistics:Descriptive Statistics  
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Basic Statistics on Worksheets (continued) 

Detecting Outliers   

• Grubbs Test 

• Dixon's Q-test Statistics:Descriptive Statistics  

16.1.2 Descriptive Statistics on Graph 

Origin provides a couple of gadgets to explore and summarize data plotted in graphs.  

Descriptive Statistics  Menu entry with graph active  

• Cluster Gadget (Pro Only) 
Gadgets:Cluster...  

• Statistics Gadget 
Gadgets:Statistics...  

16.1.3 Statistics on Selected Range 

Origin provides some quick ways to obtain basic statistics on a selected range of worksheet cells, or data 
plot(s) in a graph.  

16.1.3.1 Status Bar 

 Select a range of cells in a worksheet. Note that the selection can include cells from one or more columns, and 
you can use the CTRL key to select non-contiguous groups of cells.   

Basic statistics (average, sum, count, min, max) for your selected data will be displayed in the status bar. 
Right click on the status bar to customize what quantities to display.  
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16.1.3.2 Command or Script Window 

Statistics, Report to Script/Command Window  

1. Select a range of cells in a worksheet, or click and select a group of data plots or an individual data plot in 

a graph.  

2. Open the Command Window or the Script Window from the Windows menu, and type one of these 

commands, then press ENTER: 

stats 

moments 

quantiles 

With the Command Window, the results are typed out below the command line. With the Script Window, you 
will need to issue an additional command to return your results: 

stats; 

stats.=; 
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Note: For more information, please refer to the:  

Help: X-Function > X-Function Reference > Statistics  

 

16.2 Statistical Graphs 

 Origin provides numerous statistical graph types. All graphs can be easily customized and saved as a template 
for repeat use. View the Graphing and Customizing Graphs chapters of this guide for more information.  

Graph Type  Menu Entry  

Box Charts: Box, Interval Plot, Marginal Box Charts, Bar 
Charts, Box Overlap, Box Normal, Bar Overlap, Bar Normal, 
Scatter Interval, Double-Y Box. 

 Double-Y Box now available. 

 

Plot > 2D: Box...  

Box Charts, Grouped: Grouped Box Charts - Indexed Data, 
Grouped Box Charts - Raw Data.  Plot > 2D: Group Plot...  

Histograms: Histogram, Histogram + Probabilities, Stacked 
Histograms, Marginal Histograms, Histogram + Distribution, 
Histogram + Label.  

Plot > 2D: Histogram...  

2D Kernel Density  Plot > 2D: 2D Kernel 
Density  

Probability: Probability Plot, Q-Q Plot.  Plot > 2D: Probability...  

Pareto: Pareto Chart - Binned Data, Pareto Chart - Raw 
Data.  Plot > 2D: Pareto...  

Scatter Matrix  Plot > 2D: Scatter Matrix  

QC (X-bar R) Chart  Plot > 2D: QC (X-bar R 
Chart)  

Trellis Plot  Plot > 2D: Trellis  

http://www.originlab.com/doc/X-Function/ref/Statistics
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The following statistical graphs are only available within the Plots branch of the statistical analysis dialogs.  

Graph Type  Menu Entry  

• Means Plot 

• Means Comparison Plot 

Statistics: ANOVA: One-Way ANOVA, Two-Way ANOVA 
 
Statistics: ANOVA: One-Way Repeated Measure ANOVA 
(Pro Only)  

• Survival Curve  

• One Minus Survival Curve 

• Hazard Curve 

• Log Survival Curve 

Statistics: Survival Analysis: Kaplan-Meier Estimator (Pro 
Only)  

• Scree Plot 

• Component Plot Statistics: Multivariate Analysis: Principal Component 
Analysis (Pro Only)  

• Dendrogram  Statistics: Multivariate Analysis: Hierarchical Cluster 
Analysis (Pro Only)  

• Classification Summary Plot  

• Classification Fit Plot  

• Canonical Score Plot 
Statistics: Multivariate Analysis: Discriminant Analysis 
(Pro Only)  

• ROC Curve 
Statistics: ROC Curve (Pro Only)  
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16.3 Comparing One, Two or More Groups 

Origin provides parametric and non-parametric tests to compare one, two, three or more groups.  

16.3.1 Parametric Hypothesis Tests 

 Feature  Menu Entry  

• One-Sample t-Test 

• Two-Sample t-Test 

• Pair-Sample t-Test 

• One-Sample Test for Variance (Pro Only) 

• Two-Sample Test for Variance (Pro Only) 

Statistics: Hypothesis Testing  

• One-Sample Proportion Test (Pro Only) 

• Two-Sample Proportion Test (Pro Only) Statistics: Hypothesis Testing  

• Two-Sample t-Test on Rows (Pro Only) 

• Pair-Sample t-Test on Rows (Pro Only) Statistics: Hypothesis Testing  

16.3.2 ANOVA 

  

Feature  Menu Entry  

• One-Way ANOVA 

• Two-Way ANOVA 

• Three-Way ANOVA 

• One-Way Repeated-Measures ANOVA (Pro Only) 

• Two-Way Repeated-Measures ANOVA (Pro Only) 

(Supports both Balanced and Unbalanced data) 

Statistics: ANOVA  
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16.3.3 Non-parametric Tests 

 These non-parametric tests are available only in OriginPro  

Feature  Menu Entry  

• One-Sample Wilcoxon Signed Rank Test 

• Paired-Sample Wilcoxon Signed Rank Test 

• Paired-Sample Sign Test 

• Mann-Whitney Test 

• Two-Sample Kolmogorov-Smirnov Test 

• Kruskal-Wallis ANOVA 

• Moods Median Test 

• Friedman ANOVA 

Statistics:Nonparametric Tests  

 

Notes:  

Multiple nonparametric tests can be run simultaneously. (Accessible from the 

Statistics:Nonparametric Tests menu ) Available options are:  

• (NPH) K Independent Samples: Kruskal-Wallis ANOVA and Mood's Median Test 

• (NPH) Paired Samples: Paired-Sample Wilcoxon Signed Rank Test and Paired-Sample Sign Test 

• (NPH) Two Independent Samples: Mann-Whitney Test and Two-Sample Kolmogorov-Smirnov 

Test 
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16.4 Advanced Statistics 

Several additional tools are available in OriginPro.  

16.4.1 Multivariate Analysis 

 Origin offers several multivariate analysis methods to help you simplify, classify, or make predictions from 
your data.  

Feature  Menu Entry  

• Principal Component Analysis 

• K-Means Cluster 

• Hierarchical Cluster 

• Discriminant Analysis 

• Canonical Discriminant Analysis 

• Partial Least Squares 

Statistics:Multivariate Analysis  

 

Notes: Canonical Discriminant Analysis is integrated with Discriminant Analysis. It is accessible from the 
Statistics:Multivariate Analysis:Discriminant Analysis: Canonical Discriminant Analysis(System) 

menu.  

16.4.2 Survival Analysis 

 OriginPro includes widely used survival tests to quantify survivorship in a population.  

Feature  Menu Entry  

• Kaplan-Meier Product-limit Estimator 

• Comparing Survival Curves 

• Cox Proportional Hazards Model 

• Weibull Fit Model 

Statistics:Survival Analysis  

Notes: Comparing Survival Curves is accessible in the Kaplan-Meier Product-limit Estimator 
feature.  

16.4.3 Power and Sample Size 

Statistics, Power and Sample Size Origin provides eight types of power and sample size analysis, useful in 
designing experiments. Origin can compute the power of the experiment for a given sample size and can also 
compute the required sample size for given power values.  
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Feature  Menu Entry  

• One-Proportion Test 

• Two-Proportion Test 

• One-Sample t-Test 

• Two-Sample t-Test 

• Paired-Sample t-Test 

• One-Variance Test 

• Two-Variance Test 

• One-Way ANOVA 

Statistics: Power and Sample Size  

16.4.4 ROC Curve 

 ROC Curve analysis is useful in determining if an incident has occurred, or in comparing the accuracy of two 
methods that are used to discriminate between diseased and healthy cases.  

Feature  Menu Entry  

• ROC Curve 
Statistics: ROC Curve  

16.5 Topics for Further Reading 

• Statistics on Worksheet Columns 

• Statistics on Worksheet Rows 

• Descriptive Statistics 

• Statistics Charts, General 

• Appendix: Statistical Graph Types by Template 

• Normality Testing 

• Distribution Fit  

• Parametric Hypothesis Testing 

• ANOVA 

• Nonparametric Tests 

• Multivariate Analysis 

• Survival Analysis 

• ROC Curves 

• Power and Sample Size Tests 

• LabTalk Supported X-Functions: Statistics 

http://www.originlab.com/doc/Origin-Help/Statistics-on-Columns
http://www.originlab.com/doc/Origin-Help/Statistics-on-Rows
http://www.originlab.com/doc/Origin-Help/Descriptive-Statistics
http://www.originlab.com/doc/Origin-Help/Statistics-Chart
http://www.originlab.com/doc/Origin-Help/Statistical-Graph
http://www.originlab.com/doc/Origin-Help/Normality-Test
http://www.originlab.com/doc/Origin-Help/Distribution-Fit
http://www.originlab.com/doc/Origin-Help/Hypothesis-Testing
http://www.originlab.com/doc/Origin-Help/ANOVA
http://www.originlab.com/doc/Origin-Help/NonPara-Test
http://www.originlab.com/doc/Origin-Help/Multivariate-Analysis
http://www.originlab.com/doc/Origin-Help/Survival-Analysis
http://www.originlab.com/doc/Origin-Help/ROC-Curve
http://www.originlab.com/doc/Origin-Help/Power-Sample-Size
http://www.originlab.com/doc/LabTalk/guide/LT-Supported-XFs
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17 How to Handle Repetitive Tasks 

   

 

17.1 Recalculation 

 All Analysis and most data processing dialog boxes in Origin include a Recalculate  control. This control allows 
you to tie the output of the operation to the source data such that any changes to the source data can trigger 
an update of the output. This allows you to analyze multiple datasets by, for instance, serial import of a new 
data file to replace existing data. This feature is also the basis for creating Analysis Templates. The Analysis 
Template concept is explained below.     

 

 
Three options are available for the Recalculate control:  

None  

• No lock is displayed in the output.  

• Changes to the input data will not result in an update of the output. 

Auto  

• An auto green lock is displayed in the output columns and graphs that contain plots 

of the output data.  

• The output will be automatically updated when input data is changed. 

• You can also recall the dialog to make changes to the analysis settings. 

http://www.originlab.com/doc/Origin-Help/AnalyDialog-Recalculate


Origin User Guide 

212 

Manual  

• A manual green lock is dispalyed in output columns and graphs that contain plots of 

the output data.  

• The lock will turn yellow in color when input data is changed. You can manually 

trigger an update for each operation, or for all such pending operations in the project.  

• You can also recall the dialog to make changes to the analysis settings. 

 

 

A left-click on the lock displays a menu that provides multiple options including 
changing analysis parameters, opening source data sheet, switching to result sheets, 
and controlling the status of the operation such as switching from manual update to 
auto update.  

17.2 Dialog Themes 

  Settings in analysis dialogs and most other data processing dialogs can be saved as a Dialog Theme file. 
Once saved, these Theme files containing your custom settings can be recalled as needed. Multiple theme files 
can be saved from a dialog, allowing for easy repeat analysis of datasets that may each require different 
settings.  

Last used dialog box settings are automatically saved as a <last used> Theme. Origin also allows you to save 
your custom settings as the <default> Theme. The default Theme, last used Theme, and any named Theme 
that you have saved, can all be accessed from the theme fly-out menu that opens from the dialog box. These 
same Themes are also available from the main menu item associated with the analysis dialog box. 

 

Dialog Themes are managed with the Theme Organizer tool, available from the Tools menu.  
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Tutorial: Saving and Re-using a Dialog Theme  

1. Import the file Linear Fit.dat from the Samples\Curve Fitting\ subfolder. 

2. Highlight column B and select Analysis: Fitting: Linear Fit... 

3. In the Linear Fit dialog that opens, check the Fix Intercept checkbox (under Fit 

Options) and set the Fix Intercept at edit box to 0. 

4. Click the button next to the Dialog Theme control and select Save as .... In 

the Theme Name box, enter Zero Intercept and press OK. Press OK again to 

close the Linear Fit dialog box and perform the analysis. FitLinear1 and 

FitLinearCurve1 result sheets are added to the workbook.  

5. Return to the source data and highlight column C. Select Analysis: Fitting: 

Linear Fit from the menu. You will see a fly-out menu with multiple Theme options 

including the Zero Intercept Theme you saved in the previous step. 

6. Select your saved Theme. The analysis is automatically performed on Column C 

using the settings saved in the Theme. Note that the dialog box does not open.  

 

• Hold the SHIFT key while clicking on your Theme in the main menu and the 

associated dialog box will open with settings from the selected Theme loaded into 

the dialog box. 

• The default theme Origin shipped for an analysis is called System Default. click 

the fly-out menu in analysis dialog and choose System Default to load it.  

• Click the fly-out menu in analysis dialog and choose Delete to delete themes you 

have created, including customized <default> theme.  

• The customized <default> themes for all analysis dialogs are saved in Defaults.xml 

under User Files folder. Delete it will restore system default settings of all analysis 

dialogs.  

17.3 Project and Workbook Templates 

   

17.3.1 The Project as Template 

The Origin project file can be used as a template for carrying out repetitive graphing and analysis tasks. Create 
the desired graphs and/or analysis results from data in your workbook(s) and save the project. You then 
simply replace the workbook data, to automatically update graphs and results. When saving the project, you 
have the following options:  

1. Use the File: Save Project without Data menu item. This will clear all data before saving the project. 

2. Use the File: Duplicate Project without Data menu item. This will create a copy of the existing project 

where all the data will be cleared before saving.  
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You can, of course, save the current project with data, but the above two options may prove useful when 
working with very large datasets as they will reduce project file size.  

17.3.2 The Workbook as Template 

You can save a workbook as a template for repetitive graphing and/or analysis tasks. The workbook can 
contain worksheets with data, floating or embedded graphs and notes windows.   

If the workbook contains analysis operations, the File: Save Workbook as Analysis Template... menu 
command can be used to save the workbook. All data columns that are used in the analysis operations in the 
workbook will be cleared before saving. Data that are not associated with analysis operations will not be 
cleared. Workbooks saved in this manner can be accessed quickly from File: Recent Books on the main 
menu.   

 

Tutorial: Creating an Analysis Template  

1. Start with a new workbook and import the file Samples\Curve 

Fitting\Sensor01.dat. 

2. Select column B and use the Analysis: Fitting: Linear Fit and open the Linear 

Fit dialog. 

3. Change the Recalculate drop-down to Auto. 

4. Check the Fix Intercept check box and enter 0 in the Fix Intercept at edit box.  

5. Click OK to close the dialog and perform the linear regression. 

6. Switch to the FitLinear1 report sheet to view results including plots of the best-fit 

line and residuals. 

7. Now switch back to the original data sheet and import the file Samples\Curve 

Fitting\Sensor02.dat. The analysis results will be automatically updated with this 

new data. You can continue to use the workbook for other data. Or right click the 

workbook title and choose Duplicate without Data to create a new workbook 

with linear fitting operation saved in it. Then import new data in new workbook and 

thus save a project with multiple such workbooks if desired. 

8. With the workbook active, select the menu File: Save Workbook as Analysis 

Template..., and in the dialog that opens, give a name such as Linear Fit of 

Sensor Data and click Save. 

9. Choose File: Recent Books menu item and select the template that was saved in 

the previous step. The workbook will open and the data sheet will be empty. 

10. Import the file Samples\Curve Fitting\Sensor3.dat into the empty data sheet 

(1st sheet). The analysis results will update upon import of the new data. 

The workbook template can even contain custom report sheets and a summary sheet. Thus, you can create an 
individual report for each file. The advantage of the workbook-as-template method is that the Batch 
Processing tool can be used to process multiple files or datasets and create a final summary report for all files 
that are processed as part of the batch analysis. View the Batch Plotting and Batch Analysis sections of this 
chapter for examples of using the workbook as a template when handling repetitive tasks.  

17.4 Batch Plotting 

 Origin provides several methods for batch plotting of graphs from multiple datasets or files. The following two 
sections outline how to create multiple graphs from (1) data that is already in worksheets, and (2) multiple 

http://www.originlab.com/doc/Origin-Help/Batch-Processing
http://www.originlab.com/doc/Origin-Help/Batch-Processing
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data files. In addition to these two procedures, batch plotting can also be performed programmatically using 
LabTalk script or Origin C.  

17.4.1 Duplicating Graphs with Data from Other Books/Sheets/Columns 

If you have several workbooks, worksheets or columns with similar data structure as you the data used to plot 
the graph, you can have Origin clone that graph via Window: Duplicate (Batch Plotting) menu with new 
data. There are two cases:  

• If you have plotted a graph with a single dataset and customized it, and want to clone the graph with 

other data in the same worksheet: Choose Window: Duplicate (Batch Plotting): Duplicate with New 

Columns. Pick other data (columns) that you want to plot. Each column will be plotted as a new graph.  

• If you have plotted a graph with data in one worksheet or workbook and customized the graph, and you 

want to clone the graph with other worksheets or workbooks with a similar data structure: Choose 

Window: Duplicate (Batch Plotting): Duplicate with New Sheets/Duplicate with New Books. 

Origin will list all worksheets or workbooks with a similar data structure. Pick the worksheet or workbook 

you want to plot from. Each worksheet or workbook will be plotted as a new graph. 

 

Tutorial: Duplicating a graph with data from other books/sheets  

1. Press the New Project button on the Standard toolbar. 

2. Press the Import Wizard button on the same toolbar. This opens the Import 

Wizard dialog box. 

3. Click the browse button to the right of the File box. Browse to the Import and 

Export folder and select the files S15-125-03.dat, S21-235-07.dat, and S32-

014-04.dat. Click Add File(s), then press OK. In the Import Wizard dialog box, 

press Finish. The files are imported into three separate workbooks. 

4. Drag and select all three Y columns in one of the workbooks, then select the menu 

item Plot>2D: Multi-Y: 3Ys Y-YY to create a graph with multiple Y axes and one 

shared X axis. Make any desired customizations to the graph. 

5. Right-click on the title bar of the graph window then select Duplicate (Batch 

Plotting): Duplicate with New Books... or Duplicate (Batch Plotting): 

Duplicate with New Sheets... shortcut menu.  

6. In the dialog box that opens select the other two workbooks/worksheets then press 

OK to close the dialog. Two more graphs are created with data from the other two 

workbooks/worksheets.  

17.4.2 The Workbook as a Template for Processing Multiple Files 

If you want to plot graphs from many data files but don't want to import all files to workbooks before plotting, 
you can import one file, create the desired graph(s) based on that data, then add the graph(s) to your 
workbook and save the workbook as a template. Using this template you can process multiple files, creating a 
workbook for each file and its corresponding graph.  
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Tutorial: Creating graphs from multiple data files  

1. With a new workbook active, choose File: Import Single ASCII and import the 

file Sensor01.dat from the Samples\Curve Fitting subfolder of the Origin 

installation folder. 

2. Highlight column B and create a line+symbol graph of the data. 

3. Double click on the X axis to open the Axis dialog. Make sure Scale tab is active. 

Select both Horizontal and Vertical on the left panel and set Rescale to be 

Auto. This is to make sure graph scale will update automatically based on data. 

4. In the workbook, right-click on the worksheet tab and select Add Graph as Sheet, 

then select the graph created above. This will add a new workbook sheet 

containing an embedded graph. 

5. Switch to the data sheet, double-click on the tab rename the sheet as Data. 

6. Select the Worksheet: Clear Worksheet menu item to clear the data in this 

sheet. Note that this step is optional. Clearing the data will reduce the size of the 

template saved in the next step. Note that you should clear only the data sheet, 

and not the other sheets such as those with embedded graphs. 

7. Select the File: Save Window As... menu item, assign a name such as Sensor 

Data and Graph and press Save. 

8. Now we can use this template to process multiple files. Select the File: Batch 

Processing... menu item. 

9. In the dialog box that opens set the Batch Processing Mode to Load Analysis 

Template, then set the Analysis Template control to point to your saved 

template. 

10. Set Data Source to Import from Files and select the three files Sensor01.dat, 

Sensor02.dat, and Sensor03.dat from the Samples\Curve Fitting subfolder. 

11. Set the Data Sheet to Data and set Result Sheet to <none>.  

12. Press OK to close the dialog box. You should get three workbooks with the data 

imported into the first sheet and the graphs updated in the 2nd sheet. To further 

edit any of the graphs, double-click on the graph to pop up an editable page. 

 

If processing of your data requires some custom import settings, you can save those 
settings to the data sheet from the Import dialog box (Save to <Sheet>, available 
from the Dialog Theme menu). Settings thus saved to the sheet will be used for 
import when batch processing of multiple files using the workbook as a template.  

17.5 Batch Analysis 

Origin provides several ways to perform batch analysis of multiple files, data columns, or data plots.  

17.5.1 Analyzing Multiple Datasets in Dialogs 

Some analysis dialog boxes, for instance Linear Fit and Nonlinear Fit, support analysis of multiple datasets. 
Report sheets created by these dialog boxes include a summary table listing the parameter values for each 
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dataset and other pertinent results such as goodness-of-fit indicators. The summary table can be copied to an 
external sheet for further processing.  

 

Tutorial: Fitting Multiple Datasets  

1. Open a new workbook and import the file Samples\Curve Fitting\Multiple 

Gaussians.dat from the Origin installation folder. 

2. Set the Long Names of the four Y columns as Peak 1, Peak 2, Peak 3 and Peak 4. 

3. Select all four Y columns, and use the Analysis: Fitting: Nonlinear Curve Fit... menu 

item to open the NLFit dialog box. 

4. Select Gauss from the Function drop-down list, then press the Fit button to perform 

fitting and close the dialog box. 

5. Switch to the FitNL1 report sheet. You will see a table named Summary which lists 

the fit parameters and fit statistics for each dataset. 

 

 

In the NLFit report sheet, click on the downward-pointing arrow button next to the 
table named Summary and select Create Copy as New Sheet. This will create a copy 
of the table in which all cells are linked to the report. Any updates/changes to the fit 
will automatically update the values in this copied sheet. This sheet can then be used to 
plot or to perform secondary analysis on the fit parameters.  

17.5.2 Using Gadgets for Analyzing Multiple Curves 

 Origin includes several gadgets for performing interactive analysis on plotted data. Gadgets perform a range 
of functions such as selecting a data range of interest, switching from one dataset to another, and setting 
various preferences specific to the analysis being carried out.  

Most gadgets offer an option to perform the analysis on all data plots in the current layer, or all data plots in 
the graph page. This allows for performing repetitive analysis on multiple datasets using the same settings, 
and generating a table of results across all datasets.  

 

  

Tutorial: Using the Integrate Gadget to Integrate Multiple Curves  

1. Open the project "Samples\Spectroscopy\Absorbance Spectra.opj". 

2. With the graph window active, choose Gadgets: Integrate..." from the main menu.  

3. In the dialog that opens, click the Baseline tab and set the Mode drop-down to 

Straight Line. 

4. Click the Output tab, expand the Output Quantities to node, and check Append to 

Worksheet. Press OK to close the dialog box. 

5. A region of interest (ROI) object is placed on the graph. If necessary, click on the ROI 

and resize this object to cover the entire data range plotted in the graph. The integrated 
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area will be displayed as a shaded region. 

6. Click the arrow button at the top right of the ROI object, then choose Change Data 

from the context menu and switch to another plot in the layer. Check that the current 

baseline setting works for other curves in the layer. 

7. Click the arrow button , select New Output for All Curves (N) or directly press N 

key. Integration is performed on all curves.  

8. Click the arrow button again and select Go to Report Worksheet. Expand the 

report worksheet to view the integration results from all curves. 

 

17.5.3 Batch Analysis Using an Analysis Template 

    The Batch Processing tool allows you to process multiple files or datasets using an Analysis Template. 
Simply perform the analysis on one of the files, include all desired results and report sheets in one workbook, 
and save that workbook as an Analysis Template. The tool then uses the Template to process multiple 
files/datasets. You have the option to retain one workbook for each file/dataset, and additionally, to create a 
summary table with select analysis parameters and other metadata that you have pre-configured in your 
analysis template.  
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Tutorial: Batch Analysis of Multiple Files using an Analysis Template  

1. From the main menu, choose File: Batch Processing.... This opens the Batch 

Processing dialog box. 

2. Set Batch Processing Mode to Load Analysis Template. 

3. Press the browse button to the right of the Analysis Template box and select the 

file Sensor Analysis.OGW located in the Samples\Batch Processing subfolder 

under your Origin installation folder. This Analysis Template contains multiple sheets 

set up for linear regression analysis, reporting, and summary tables. 

4. Set Data Source to Import From Files, then press the browse button to the 

right of the File List and select the files Sensor01.dat, Sensor02.dat and 

Sensor03.dat from the Samples\Curve Fitting subfolder under your Origin 

installation folder. 

5. Set Dataset Identifier to File Name, Data Sheet to Data, and Result Sheet to 

Result, thus selecting the appropriate sheets in the Template. 

6. Uncheck Delete Intermediate Workbook. 

7. Click OK to close the dialog box. The three files are processed. You will find three 

books with the data, analysis results, and report for each file, and a fourth book 

containing the summary table of analysis results from all files. 
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Saving the initial workbook as an Analysis Template is optional. You can simply save 
the Origin project (.opj) and next time replace the data in your workbook to update all 
results and graphs. The Batch Processing tool also has an option to repeatedly import 
files into the active window, allowing you to simply re-use an existing book within a 
project (which contains all desired analysis and graphs) as an on-the-fly template for 
the batch analysis.  

 

You can batch generate analysis reports using a custom MS Word template, with the 
option of outputting a PDF file for each report. For more information, see this tutorial.  

17.6 Repeating Analysis on Other Datasets or Data Plots 

For some analysis operations, you can perform the analysis on one dataset or data plot and then repeat the 
analysis for all other data. This feature is available via a special shortcut menu entry, when you click on the 
lock associated with the operation. In worksheet columns or reports, clicking the lock will show the menu 
command Repeat this for All Y columns. Selecting this will repeat the analysis on all other Y columns in the 
source data sheet. In a graph, clicking the lock will show the menu command Repeat this for All Plots. 

http://www.originlab.com/doc/Tutorials/BatchProcess-WordTemplate
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Selecting this will repeat the analysis for all other data plots in the graph page, even if the plots are in different 
layers.  

This is particularly useful for such analysis dialog boxes as smoothing, or interpolation, etc. that support 
input of only one dataset. As long as the data are contained in one worksheet or plotted in one graph, the 
analysis can be repeated on all other datasets.  

 

Tutorial: Smoothing Multiple Columns in a Worksheet  

1. Import the file Samples\Curve Fitting\Multiple Gaussians.dat into an empty 

workbook. 

2. Select column B, then click the menu Analysis: Signal Processing: smooth and 

open the dialog box. 

3. Accept the defaults and press OK to perform smoothing. A new column will be 

added with the smoothed data. 

4. Click on the lock in the output column and select Repeat this for All Y 

columns. Three more columns of smoothed data with same settings will be 

generated from the data in columns C thru E. 

17.7 Repeating Analysis Using Data Filters 

 Large multi-column datasets can be quickly reduced by applying filter conditions to one or more columns. This 
Data Filter feature can also be used in conjunction with the colcopy (column copy) X-Function to produce 
multiple graphs from the same source data using different filtering conditions. The filtered data can also be 
analyzed, allowing you to compare graphs and analysis results across multiple filter conditions.  

Selected columns from the source data sheet can be copied to create child sheets where the filter condition 
stays synchronized with the parent sheet, or is locked to the child sheet. When the source data sheet is 
updated, all child sheets, associated graphs and analysis results will automatically update using their 
respective filter conditions. Additionally, the filter condition of a particular child sheet can be pushed back to 
the parent sheet at any time.  

The image below displays the source workbook with data for several makes of automobiles. Two books were 
created with a subset of columns and a data filter to restrict the data to a particular make of automobile. 
Linear regression analysis of the filtered data was performed, allowing comparison of the results across the 
two filters.  

http://www.originlab.com/doc/Origin-Help/Wks-DataFilter
http://www.originlab.com/doc/Origin-Help/copy-columns
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Tutorial: Locking a Filter Condition on Copied Columns  

1. Import the file Samples\Statistics\Automobile.dat 

2. Click on the Make column, then right-click and select Filter: Add or Remove 

Filter context menu. 

3. Click on the filter icon that was added to the column, and uncheck all makes 

other than Honda (Choose Select All to clear all and then select Honda). Click OK. 

4. Hold down the CTRL key and click and select the Make, Power and Engine 

Displacement columns. Next, right-click and select the Copy Columns to... 

context menu. 

5. Accept defaults in the dialog that opens, and click Ok to copy the columns. A new 

worksheet will be added to the workbook. 

6. Click and hold the tab of the new worksheet and drag it to an empty spot in the 

Origin workspace to create a separate workbook. 

7. Click on any of the locks in the columns of this copied sheet, and select 

Worksheet Filters: Lock. The filter conditions will be locked to this sheet. If you 

change the filter condition in the original data sheet, this copied sheet will not be 

affected.  
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8. You can modify the filter condition to Toyota and use Copy Columns to to create 

another worksheet. Plot Power vs Engine Replacement, and do linear fit from such 

new worksheet to compare between different automobile makes. 

17.8 Automating Tasks Using Programming 

  

In addition to the above mentioned methods for automating tasks  using the interface, graphing and analysis 
features can also be accessed programmatically from either the LabTalk scripting language or from Origin C. 
Access to Graph Themes and templates, and Analysis Templates can be programmed. You can set up some of 
the procedure manually by first creating the templates using the graphical user interface, and then write your 
code to call the templates as needed.  

You can get a broad look at what programming options are available in Origin by browsing the Programming 
Chapter of this User Guide. More in-depth programming-related information is linked to from that chapter.  

17.9 Topics for Further Reading 

• Recalculation of Analysis Results on Data or Parameter Change 

• Saving Analysis Dialog Settings as a Theme 

• The Theme Organizer, Dialog Themes 

• Analysis Templates 

• Batch Processing and Analysis Templates 

• Copy and Paste Operations 

• Using Data Filters to Obtain Different Views of Your Data 

• Analysis Report Sheets and Columns 

• Tutorials: Batch Processing 

• Video: Batch Processing 

• Tutorial: Combine Quick Peaks Gadget with Peak Analyzer 

http://www.originlab.com/doc/Origin-Help/AnalyDialog-Recalculate
http://www.originlab.com/doc/Origin-Help/Dialog-Theme
http://www.originlab.com/doc/Origin-Help/ThemeRef-ThemeOrganizer
http://www.originlab.com/doc/Origin-Help/Analysis-Templates
http://www.originlab.com/doc/Origin-Help/Batch-Processing
http://www.originlab.com/doc/Origin-Help/Copy-Paste-Oper
http://www.originlab.com/doc/Origin-Help/Wks-DataFilter
http://www.originlab.com/doc/Origin-Help/Analysis-Rep-Wks-Cols
http://www.originlab.com/doc/Tutorials/Batch-Processing
http://originlab.com/index.aspx?go=Support/VideoTutorials&ss=chm&pid=1559
http://www.originlab.com/doc/Tutorials/Combine-QuickPeakGadget-PA
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18 Publishing and Export 

 

 

 

Origin 2018 adds a significant improvement to copy/paste and image export of Origin 
graphs. Normally, when you click Edit: Copy Page or Edit: Copy Graph as Picture; 
or you export a graph to an image file (File: Export Graphs), the margins of your 
copied or exported graph are determined by the Margin Control in Copy Page 
Settings group of Tools: Options (Copy actions) or the Export Settings branch of 
Export Graphs (Export actions). In Origin 2018, you can interactively modify the 
default margins using the Export Margin Offsets Dialog Box. 

http://www.originlab.com/doc/Origin-Help/Options-Dialog-Page-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-Page-Tab
http://www.originlab.com/doc/Origin-Help/Export-Margin_Offsets
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18.1 Copying and Pasting Graphs to Other Applications 

   There are two ways you can include Origin graphs in another application's files (e.g. Microsoft Word): as a 
Picture, or as an Origin Graph Object.  

1. Click on your Origin graph to activate it, then ...  

o To copy the graph as a picture, choose Edit: Copy Graph as Picture. 

o To copy the graph as an editable graph object, choose Edit: Copy Page. 

2. In your target application choose Paste or press CTRL+V. 

 
When you paste as a picture, the graph is inserted as an image. In MS Word, for instance, double-clicking on 
the image launches Word's picture-editing tools, but this method does not allow for further graph edits in your 
Origin software.  

When you paste as a graph object, you can later double-click on the object in the target application to launch a 
new instance of Origin. The graph, and any associated data sheets, will be available for editing. After editing, 
use Origin's File: Exit and Return to... menu item to update the embedded object, close Origin and return to 
the host application.  

 

There are important settings in the Options dialog (Tools: Options) that determine 
how the graph page is copied or exported. These settings determine, among other 
things, the amount of white space that is included with your copied or exported graph. 
Please see the Copy Page Settings and also the Export Margin Offset dialog box.  

Note: For more information, please refer to the:  

Help: Origin: Origin Help > Exporting and Publishing Graphs > Pasting or Embedding Graphs 
in Other Applications  

18.2 Organizing Your Graphs for Presentation or Export 

If your Origin project file contains a large number of graphs that you plan to export or use in an Origin slide 
show, you can make things easier by adding shortcuts to your graphs to a Project Explorer Favorites folder 
and arranging them there:  

• Right-click on a window and choose Add Shortcuts to Favorites. This will add a shortcut to each graph 

window, to a new Favorites subfolder (visible in Project Explorer). 

• When sending graphs to PowerPoint or creating an Origin slideshow, you can (1) set slide order in the 

corresponding dialog box or (2) set slide order following this procedure. 

http://www.originlab.com/doc/Origin-Help/Options-Dialog-Page-Tab
http://www.originlab.com/doc/Origin-Help/Export-Margin_Offsets
http://www.originlab.com/doc/Origin-Help/Paste-Embed-OLE
http://www.originlab.com/doc/Origin-Help/Paste-Embed-OLE
http://www.originlab.com/doc/Origin-Help/Project-Explorer
http://www.originlab.com/doc/Origin-Help/Project-Explorer
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18.3 Exporting Graphs and Layout Pages to an Image File 

  To export a graph or a layout page as an image file, select the menu File:Export Graphs. This will open the 
expGraph dialog box which offers several options to control the export.  

Origin supports 15 export file formats:  

Raster Formats  BMP, GIF, JPG, PCX, PNG, TGA, PSD, TIF;  

Vector Formats  CGM, DXF, EPS, EMF, PDF, WMF  

The expGraph dialog offers options for customizing the output size by scaling the height or width of the page, 
various settings that are specific to the chosen file format, options for naming the output file, and options to 
perform batch exporting of multiple pages. Customized settings can be saved as a Theme file for repeat use. 
The last used settings are available from the File: Recent Exports menu item.  

Note: For more information, please refer to the:  

Help: Origin: Origin Help > Exporting and Publishing Graphs > Exporting Your Graph or 
Layout Page to an Image File  

 

Exporting to raster formats such as TIFF and specifying a high resolution (e.g. 600 DPI 
or above) can produce a very large output file size, depending on the page size. To 
reduce the file size, consider reducing the size of the page before export. Consult with 
your publisher to determine the actual width of a print column in your journal.  

18.4 Sending Graphs to PowerPoint 

  You can send a batch of Origin graphs to PowerPoint as either pictures or as embedded objects that can be 
further edited in your Origin software (double-click on the graph in PowerPoint to launch an instance of Origin).  

Click the Send Graphs to PowerPoint button  on the Standard toolbar or right click in Project Explorer 
and select Send Graphs to PowerPoint... from the shortcut menu. This opens a dialog with controls for 
specifying how your graphs are sent to PowerPoint.  

• Select multiple graphs in Project Explorer before opening the dialog, and only the selected graphs will be 

sent to PowerPoint by default. 

• Choose the Specified option in the Select Graph(s) drop-down list to remove graphs you don't want to 

send, and change graph order. 

• Besides showing the window name or window path as a slide title, you can also specify a custom string 

that incorporates metadata properties in the slide title. 

• When sending graphs to an existing PowerPoint file or template, set Slide Mode as Start New to create a 

new slide for extra graph page, using a specified "starting slide." 

http://www.originlab.com/doc/Origin-Help/ExpGraph-to-Image
http://www.originlab.com/doc/Origin-Help/ExpGraph-to-Image
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18.5 Slide Show of Graphs 

  Origin has a built-in slideshow utility for viewing or presenting your graphs. The slide show can be started in 
two ways:  

• Right-click on any folder in Project Explorer and select Slide Show of Graphs...  

or  

• Click the Slide Show of Graphs button  on the Standard toolbar.  

A dialog box opens offering options to set slide order, slide cycle time, whether to include graphs in sub 
folders, etc. The dialog also lists shortcut keys for use during the slide show (e.g. G = go to the actual graph 
window of the currently displayed slide).  

 

Tutorial: Slide Show of Graphs  

1. Use the File: Open Sample Projects: 2D and Contour Graphs menu to open 

the sample project. 

2. Click on the Slide Show of Graphs button in the Standard Toolbar. 

3. Accept default settings in the dialog that opens, and press OK to start the slide 

show. 

4. You can use the up/down arrow keys or the mouse wheel to flip thru the slides.  

18.6 Creating Movies 

    Origin provides a Video Builder tool, accessible from the Open Video Builder button  on the 
Standard Toolbar. This tool can be used to manually capture a series of graph windows, and write one frame 
at a time to a video (.AVI) file.  

Videos can be created using LabTalk script or Origin C code, by programmatically computing or updating data 
and then writing out the graph as a frame in the video, at each step during the computation.  

Note: For more information, please refer to the:  

Help: Origin: Origin Help > Exporting and Publishing Graphs > Creating Graph Animation  

 

For specific examples of programmatically created movies, including Origin Projects and 
code, please visit www.originlab.com/animation.  

http://www.originlab.com/doc/Origin-Help/Graph-Animation
http://www.originlab.com/animation
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18.7 Exporting Worksheets and Matrices 

18.7.1 Exporting Worksheets 

  With a worksheet active, the File: Export menu item provides the following options:  

• ASCII, NI TDM (TDM, TDMS), and Sound (WAV)  

This option is available only for sheets containing data columns, and is not available when report sheets 

such as those created by the Nonlinear Fitting tool are active. The exported file will contain only data 

from the worksheet columns. Floating or embedded graphs placed in the worksheet will be ignored. 

• As Multipage PDF File  

This option is available only on sheets with data columns, and not for report sheets. Use the View: 

Page Break Preview Lines menu item to view the vertical and horizontal page break lines that 

determine which columns and rows will be included in each page of the export. Floating or embedded 

graphs placed in the worksheet will be included in the exported image. 

• As Image File  

This option is available on both data and report sheets. In the dialog that opens, you can select whether 

to export the entire sheet, visible area, or selection. Image file formats including PDF are supported. 

Floating or embedded graphs placed in the worksheet will be included in the exported image. 

• As PDF File†  

This option is available for both data and report sheets. In the dialog that opens, you can opt for 

exporting the entire sheet, the visible area, or a selection. Floating or embedded graphs are included in 

the exported PDF.  

 

† The PDF export option was previously included with the As Image File menu option 
but was not obvious to users so in 2018, it is now a separate Export menu entry. 

 

When creating a custom report from a worksheet that combines data, numeric results 
and graphs, the best option is to export the entire sheet as a PDF file, or export the 
sheet as a multi-page PDF file.  
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18.7.2 Exporting a Matrix 

  Origin matrix data can be exported in these two formats:  

• ASCII  

This will create an ASCII file of the data contained in the active matrix object. 

• Image  

This option will export the image view of the active matrix object, as a raster file. 

Note: For more information, please refer to the:  

Help: Origin: Origin Help > Importing and Exporting Data > Exporting Worksheets and 
Matrices  

18.8 Topics for Further Reading 

• The Tools:Options Page Settings 

• Pasting or Embedding Graphs in Other Applications 

• Exporting Your Graph or Layout Page to an Image File 

• Which Image Format Should I Choose? 

• The Export Graph Dialog Box 

• Send Graphs to PowerPoint 

• Send Graphs to PowerPoint Dialog Box Settings 

• View Graphs as a Slide Show 

• The Slide Show of Graphs Dialog Box Settings 

• Creating Graph Animations 

• Printing Graphs, Layout Pages and Analytical Results 

• The Print Dialog Box 

• The Print Options Dialog Box 

• Copying and Pasting Graphs inside Origin 

• Inserting Graphs and Images into Worksheet Cells 

• Tutorial: Creating a Custom Report Sheet 

• Using the Layout Page Window 

• Creating a Master Page Layout for Graphs 

http://www.originlab.com/doc/Origin-Help/Export-Wks-Mat
http://www.originlab.com/doc/Origin-Help/Export-Wks-Mat
http://www.originlab.com/doc/Origin-Help/Options-Dialog-Page-Tab
http://www.originlab.com/doc/Origin-Help/Paste-Embed-OLE
http://www.originlab.com/doc/Origin-Help/ExpGraph-to-Image
http://www.originlab.com/doc/Origin-Help/ExpGraph-Format-Comprison
http://www.originlab.com/doc/Origin-Help/ExpGraph-Dailog
http://www.originlab.com/doc/Origin-Help/Project-Explorer
http://www.originlab.com/doc/X-Function/ref/pef_pptslide
http://www.originlab.com/doc/Origin-Help/Project-Explorer
http://www.originlab.com/doc/X-Function/ref/pef_slideshow
http://www.originlab.com/doc/Origin-Help/Graph-Animation
http://www.originlab.com/doc/Origin-Help/Print-Graph-Layout-AnalyResult
http://www.originlab.com/doc/Origin-Help/Print-Dialog
http://www.originlab.com/doc/Origin-Help/Print-Option-Dialog
http://www.originlab.com/doc/Origin-Help/CopyPaste-Graph
http://www.originlab.com/doc/Origin-Help/InsObject-to-WksCell
http://www.originlab.com/doc/Tutorials/Create-Custom-Report
http://www.originlab.com/doc/Origin-Help/ExpGraph-Layout-Window
http://www.originlab.com/doc/Origin-Help/Master-Page-Layout
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19 Apps for Origin 

Origin 2016 introduced Origin Apps -- tools that you could easily add to your Origin installation by dropping 
them onto your Origin workspace. This ever-expanding collection of add-on tools is extending Origin's already-
powerful graphing and analysis capabilities.  

Because an App is a self-contained easily-distributed tool aimed at solving a particular problem, it can be 
developed and deployed quickly, sidestepping the need to wait for a new Origin product release. In addition, 
an App can be developed by anyone with a basic knowledge of programming in Origin, making it attractive as 
a means to create and distribute tools for your company or user-community.  

As of the fall of 2017, most Apps can be downloaded for free. Note that some Apps require OriginPro; this will 

be denoted in the App description by the  symbol.  

19.1 Where Do I Find Apps? 

Apps are listed on the OriginLab File Exchange. While you can download Apps from the File Exchange using 
your web browser, it easier to obtain and manage your Apps from your Origin software.  

 

Origin 2018 introduces the App Center. The App Center provides "one stop" App 
maintenance: Browse and download new and popular Apps, search for Apps, update 
existing Apps, request an App or submit an App via the OriginLab website. To open the 
App Center, click the Add Apps button that appears on all tabs of the Apps Gallery.  

 

Apps will appear in the App Center with one of three icons next to them: 

• Those with an Up-to-date Version icon beside them will be installed 

and up-to-date. 

• Those with a clickable Download and Install icon beside them are 

not installed. Click this icon to install. 

• Those with an Update icon beside them have an available update that 

you can install. Click this icon to update. 

• New and Popular tab for a quick look at what's available. Downloads and 

direct updates available. 

• Search tab to find Apps by Category and Minimum Version. Downloads 

and direct updates available. 

• Updates tab notifications when an App update is available. Listed 

improvements and direct updates available. 

http://www.originlab.com/doc/APP/App-Development
http://www.originlab.com/fileExchange/
http://originlab.com/fileexchange/index.aspx
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Alternately...  

• From the main menu in Origin, choose Tools: Apps on File Exchange to see lists of Recently 

Added/Updated and Popular Apps. Installed Apps are shown in these lists. Click on an App to go to the 

App download page. 

19.2 How Do I Install Apps? 

If you install your Apps using the Download and Install button in the App Center dialog, you don't need to 
do anything else. The App is automatically downloaded and installed. When App updates become available, 
you can use the App Center's Update button to update an installed App.  

If your workstation does not have internet access...  

If your workstation does not have internet access, you will need to find a computer that does, then download 
the App from the OriginLab File Exchange to a thumb-drive and bring it back to your workstation.  

1. On the internet-connected computer, open a browser window and browse to 

originlab.com/fileExchange. 

2. Browse the list of Apps, go to the App's description and download page, then click the Download File 

button and copy the file to your thumb-drive. 

3. Return to your workstation, plug in your thumb-drive and run Origin. Open Windows Explorer, browse to 

your thumb-drive and once you locate the App (it will have a .opx file extension), drag the App file to an 

empty portion of the OriginLab workspace. Make sure you are not running Origin as administrator or drag-

and-drop operations will fail. The App will be installed and the App icon will appear in the Apps Gallery, 

docked to the right side of your Origin workspace.  

If you have questions, click the How to Install link below the Download File button on the File Exchange 
App description and download page.  

 

19.3 How Do I Run an App? 

• Upon installation, an App icon is placed in the Apps Gallery, docked to the right side of the Origin 

workspace.  

• App operations may be window-specific. If the App is dimmed (grayed out), the active window cannot be 

operated on by the App. Check the required window type (hover on the dimmed App icon in the Apps 

Gallery). 

• If the Origin window type (worksheet, graph, etc.) is matched to the App, you can launch the App by 

double-clicking on it in the Apps Gallery. 

• If you prefer to launch the App from a toolbar button, open the Customize (Toolbars) dialog box (View: 

Toolbars), click the Button Groups tab, locate the App's toolbar button and drag the button to the 

OriginLab workspace or to an existing toolbar. Close the dialog box. 

http://originlab.com/fileexchange/index.aspx
http://www.originlab.com/doc/User-Guide/Origin-Interface


Apps for Origin 

233 

• Specific usage information is available on the description and download page for each App. 

19.4 Managing Your Apps 

Use the features of the Apps Gallery to manage your Apps:  

• To add or update your Apps, click the Add Apps button in the Apps Gallery. 

 

• Organize your Apps by adding tabs to the Gallery. Right-click in an empty portion of the Gallery and 

choose New Tab, then double-click on the default tab name and give the tab a useful name. 
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• App-specific actions are performed by right-clicking directly on the App icon and choosing from the 

shortcut menu. 

 

• Show in Folder: Opens the user's \AppData\Local\OriginLab\Apps\ folder to the App 

installation folder. 

• Uninstall: Uninstalls the selected App. 

• Open the File Exchange Page: Opens the App's description and download page on the 

OriginLab File Exchange. 

• Send Feedback...: Opens a Rate App dialog box to provide feedback. 

• Show All: Shows Apps from all Gallery tabs on the active tab. 

• Refresh: Refreshes the tab view. 

• Tab Views: Place or remove the checkmark beside the App to determine on which tab(s) 

the App shows. 
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19.5 Will I be Notified When Updates are Available? 

Several things will indicate when an App update is available:  

• A red dot will appear next to the App icon in your Apps Gallery (docked to the right side of your 

workspace).  

 

• In the App Center, the App will appear with an "update" icon beside it.  

 

• The App Center Updates tab will show a red dot with a number indicating how many App updates are 

available. The tab will list updated Apps and allow you to apply updates for individual Apps or all 

Apps.  

 

• The App will appear in the Tools menu lists with an asterisk (*) in front of the App name.  

 

 
To update an App:  

• Click the Update icon that appears next to the App in the App Center. 

• Right-click on the App in the Apps Gallery and choose Download and Install Update 

• Click the Update All Compatible button that appears on the Updates tab in the App Center. 

 

You can verify the version of an installed App by hovering on the App in your Apps 
Gallery.  
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19.6 How Do I Uninstall an App? 

Uninstalling an App is easy. Right-click on the App icon in the Apps Gallery and choose Uninstall from the 
shortcut menu.  

 

19.7 Can I Request an App? 

As previously mentioned, Apps can be developed by anyone with Origin programming knowledge. However, if 
you do not program but you find that you need some particular functionality that is not currently a part of the 
Origin product, you can request an App through the OriginLab website. OriginLab is continually building and 
posting new Apps to the File Exchange.  

1. To request an App, open the App Center and click the Request App button. This opens a web page on 

www.originlab.com. 

2. Verify that the Your Reason for Contacting Us drop down is set to Request an App. 

3. Fill out the remaining required fields and click the Submit Inquiry button at the bottom of the form. 
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20 Programming in Origin 

 

 

As you gain experience with Origin, you may want to access Origin features programmatically, add your own 
custom routines and tools, or communicate with Origin from other applications. This chapter outlines basic 
programming options available in Origin. For more detailed information, see the following Origin programming-
related resources:  

• Programming documentation including guides, language references, and examples are available from the 

Help menu in the product.  

• Online programming documentation is available at www.originlab.com/doc.  

• You can typically locate online programming pages by performing a web search from your browser using 

phrases such as: labtalk importing , originc interpolate, or labview origin send data. 

• An Origin Programming Forum can be found at www.originlab.com/forum. 

• Sample files for LabTalk, Python, COM Server and Client, etc. can be found in the \Samples folder of your 

Origin software. 
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20.1  LabTalk 

   LabTalk is a scripting language that provides access to most of Origin's functionality. With LabTalk you can 
access and change properties of Origin objects such as worksheets, columns, graph layers, and data plots. 
LabTalk script can include calls to X-Functions to perform advanced data processing and analysis.  

There are many options for executing your LabTalk scripts. Multiple lines of script can be organized as sections 
in a file, and those individual sections can be executed from the user-interface at the command prompt in the 
Script Window or Command Window; from buttons added to worksheets and graphs; from included or 
custom-made toolbar buttons; or from custom menu commands.  

 

The following "mini-tutorial" will demonstrate adding a button object to a worksheet, 
associating a short LabTalk script with the button, then using the button to execute the 
script and perform a basic statistical calculation while writing the results to the 
worksheet.  

1. Run Origin and start a new project by clicking the New Project button on the 

Standard toolbar. 

2. Click File: Import: Single ASCII and browse to the file \Samples\Graphing\Box 

Chart.dat. Select the file and click Open. The file is imported into the active 

worksheet window.  

3. With the worksheet window active, click Format: Worksheet. In the Worksheet 

Properties dialog, click the Size tab and set Gap from Top to 25, then click OK. 

A gap is added to worksheet window. 

4. Click the Text Tool on the Tools toolbar. Click inside the gap that you just added 

and type "Add Mean Label Row" into the text object. Click outside the text object to 

exit edit mode. 

5. Right-click on the text label and select Properties.... Choose Programming 

Control tab, set Script Run After to Button Up. Copy and paste the following 

script into the text box: 

wks.userParam1 = 1; 

wks.userParam1$ = "Mean"; 

for (int ii = 2; ii <= wks.ncols; ii++) 

{ 

 range rr = $(ii); 

 Col($(ii))[D1]$ = $(mean(rr),.2*); 

} 
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6. Click OK to apply settings and close the Text Object dialog box. Note that your 

text object now looks like a button. 

7. Click the button. Note that a new header row labelled "Mean" is added to the 

worksheet and the mean value of each column of data is written to the Mean row 

cell above the corresponding column. 

Note: For more information on LabTalk, Origin's built-in scripting language, please consult your 
product documentation at Help: Programming: LabTalk.  

Sample files can be found in the \Samples\LabTalk Script Examples folder of your Origin software.  

20.2  Python 

Origin provides an embedded Python environment so that you can run Python in Origin. Origin supports 
command line execution from the Script Window, or the running of .py files. To access Origin from Python, you 
can use the supplied PyOrigin module.  

The current embedded Python in Origin is version 3.3.5 and version 2.7.8 . 

Note: For more information on integrated usage of Origin and Python, refer to the LabTalk Scripting 

Guide: Help: Programming: LabTalk > LabTalk Scripting Guide > Working with Python.  

Sample files can be found in the \Samples\Python folder of your Origin software.  

20.3  R 

 Origin supports running R commands in the Origin environment. You can issue R commands in the Script 
Window or from the built-in R Console, or you can run .R files. All releases of R are supported.  

From Origin, you can connect with R in two ways:  

• R. Installed on your local computer.  

• Rserve. Installed on a remote PC. 

Note: For more information on integrating Origin and R, refer to the Origin Help file (R Console and 

Rserve Console) and the LabTalk Scripting Guide (Running R in Origin, R Objects, Rserve 
Objects).  

Sample files can be found in the \Samples\R folder of your Origin software.  

20.4  Origin C 

 Origin C is a full-featured high-level programming language based on the ANSI C programming language 
syntax. Origin C also supports a number of C++ features and a few C# features. Origin C provides access to 
all aspects of Origin including data import, data handling, graphing, analysis, and exporting. You can access 
Origin C functions from interface controls such as buttons, toolbars, and menu items, using LabTalk script.  

http://www.originlab.com/doc/LabTalk/guide
https://www.python.org/download/releases/3.3.5/
https://www.python.org/download/releases/2.7.8/
http://www.originlab.com/doc/LabTalk/guide/work-with-python
http://www.originlab.com/doc/Origin-Help/R-Server-dlg
http://www.originlab.com/doc/Origin-Help/R-Server-dlg
http://www.originlab.com/doc/Origin-Help/R-Server-dlg
http://www.originlab.com/doc/Origin-Help/R-Server-dlg
http://www.originlab.com/doc/LabTalk/guide/LT-Running-R
http://www.originlab.com/doc/LabTalk/ref/R-obj
http://www.originlab.com/doc/LabTalk/ref/Rserve-obj
http://www.originlab.com/doc/LabTalk/ref/Rserve-obj
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Origin C is organized as a set of functions with support for passing arguments. Origin C functions are compiled 
to object code and then loaded and executed inside of Origin. Origin C provides increased reliability and 
manageability for developing and debugging code of greater scope and complexity.  

Origin C also provides access to the NAG Numerical Library functions included in your Origin installation. 
NAG functions provide you with a large selection of algorithms for performing computations ranging from 
simple statistics and Fourier transforms to linear algebra and multivariate analysis.  

Note: For more information on Origin C, please refer to the Origin C documentation:  

Help: Programming: Origin C  

There you will find usage information, a language reference, developer notes, examples, etc.  

Sample files can be found in the \Samples\Origin C Examples folder of your Origin software.  

20.5  X-Function 

 An X-Function is a self-contained XML file that can be loaded in Origin as a special type of global function. 
Origin C is the language used to create X-Functions. X-Functions provide a way to expand the functionality of 
Origin by adding custom data processing features. Many of the built-in tools in Origin are based on X-
Functions. Once an X-Function has been created, it can be accessed from anywhere in the interface that allows 
for script execution, such as the script window, toolbar buttons, or custom menu items.  

Note: For more information on X-Functions, please refer to your product documentation that is 
installed with your software:  

Help: Programming: X-Function  

There, you will find information on creating and using X-Functions, a language reference, and tutorials.  

20.6  Automation Server 

  Origin can be used as an Automation Server. Client applications such as National Instruments™ 
LabVIEW™, Microsoft Excel, or custom VB/VC/C# applications can exchange data with Origin, and can also 
send commands to be executed within Origin.  

Note: For more information on Origin's Automation Server functionality, refer to the product 
documentation installed with your Origin software:  

Help: Programming: Automation Server.  

There you will find examples and language reference information. Sample files can be found in the 
\Samples\COM Server and Client folder of your Origin software.  

20.7  LabVIEW 

National Instruments™ LabVIEW™ is widely used for data collection. For example, many instrument and 
sensor vendors provide LabVIEW drivers for acquiring data. Once the data is collected, the end user will need 
to graph and analyze the data, and create reports for presentation. Origin provides powerful data analysis and 
graphing tools, including the Analysis Template feature, which allows for repeat analysis on newly acquired 
data. The ability to communicate between LabVIEW and Origin can thus greatly improve the efficiency of post-
acquisition analysis and presentation.  

http://www.originlab.com/doc/OriginC/guide
http://www.originlab.com/doc/X-Function/guide
http://www.originlab.com/doc/COM
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Origin ships with a collection of LabVIEW sub-VIs. LabVIEW users can simply incorporate these custom sub-VIs 
in their main LabVIEW application to communicate seamlessly with Origin.  

Note: For more information on Origin-LabVIEW connectivity, see the product documentation installed 
with your Origin software:  

Help: LabVIEW VI  

Examples and tutorials are provided.  

20.8  Orglab 

Orglab is a freely distributed component DLL for directly creating or reading Origin projects and other Origin 
data files. It is available as a free download. An Origin license is not required to use Orglab. Typical use of 
Orglab is for instrument manufacturers and other third-party vendors to allow their frontend software to 
output data as Origin files.  

The Orglab module is available for both 64-bit and 32-bit systems. To find out more about Orglab and 
to download the Orglab module, go to the Products > Orglab page of www.originlab.com.  

 

http://www.originlab.com/doc/
http://originlab.com/index.aspx?go=Products/Orglab
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21 Customizing Origin 

 

21.1 Customizing Default Settings 

21.1.1 Setting Preferences with the Options Dialog Box 

   The multi-tabbed Options dialog box has controls for Origin global settings pertaining to numeric display, 
file and system paths, text fonts, Origin program opening and closing behaviors, etc.  

To open the Options dialog box:  

• Choose Tools: Options (any Origin window is active)  

• If you are working with Excel in Origin choose Window: Origin Options (Excel workbook is active) 

 Controls For  

Axis Tab  

• Max number of ticks for numeric and date/time scales 

• Distances from the tick labels to tick marks, axis titles 

• Display of tick labels when using scientific notation 

Excel Tab  

• Use of default plot assignments 

• Scan datasets for legend text 

• Opening Excel files by drag-and-drop 

File Locations Tab  

• Set file paths to track last opened, last saved, last exported file 

• Set default path and file extension for importing different file types 

• Set file types in ASCII import dialogs. 

Graph Tab  

• Dash lines definitions, line to symbol gap, user-defined symbols, etc. 

• 2D graph anti-aliasing. 

• Enable in-place editing of linked and embedded graphs 

• Speed mode reminder watermark 

http://www.originlab.com/doc/Origin-Help/Options-Dialog-Axis-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-Excel-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-FileLocation-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-Graph-Tab
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 Controls For  

Miscellaneous Tab  

• Printing options 

• Default templates for ASCII import 

• Custom date/time formats 

• Footnote size ratio for report sheet 

• Use of dataset names in the Origin workspace 

Numeric Format 
Tab  

• Controls for displaying scientific notation 

• Controls for displayed digits in data and report sheets 

• Radians, degrees or gradians 

• Separators for decimal places 

Open/Close Tab  

• Default window closing behaviors 

• Project startup, backup and autosave options 

Page Tab  
• Control of page size for exported graphs 

Text Fonts Tab  

• Default fonts for text objects 

• WYSIWYG and in-place editing mode behaviors 

• Size and positioning of superscripts/subscripts 

System Path Tab  

• Change the location of the users files, autosave and group folders 

• Locations of important Origin system folders 

21.1.2 System Variables Dialog 

 System variables are internal Origin settings that allow for the fine-tuning of a wide range of Origin behaviors. 
Origin's Set Systems Variables dialog box (Tools: System Variables...) can be used to view and set 
system variable values. In the dialog, there is a link named System Variables List which opens a web page 
with a list of all system variables, the default value, and description.  

To customize a particular system variable:  

1. Type the system variable name in the first column, without the @ symbol. For example, if you wanted to 

make a global change to the Recalculate mode of analysis dialog boxes, type: DAM 

2. Click on the 2nd column to view the current value, and type in a new value. For example, with DAM, to set 

Recalculate to Auto, type the value: 1. 

3. Add optional comments in the third column and click OK to close dialog. 

http://www.originlab.com/doc/Origin-Help/Options-Dialog-Misc-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-NumFormat-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-NumFormat-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-OpenClose-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-Page-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-TextFont-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-SysPath-Tab
http://www.originlab.com/doc/LabTalk/ref/sys-var-list
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This modified value will be remembered and applied in every Origin session.  

You can quickly read or set the value of a writable system variable in the Script Window (Window: Script 
Window) by typing @systemVariable= as, for example ...  

@DAM=  

... then pressing ENTER, but note that typing in the Script Window sets the variable value for the current 
session only.  

21.1.3 3D OpenGL Settings Dialog 

  Origin uses OpenGL (Open Graphics Library) for rendering of 3D graphs. OpenGL provides enhanced 
performance including fast drawing, fast rotation and zoom, transparency, and lighting support.  

For optimum performance, your card should support OpenGL version 3.0 or higher. To check your hardware's 
support for OpenGL, run Origin and choose Tools: 3D Open GL Settings.... Look under OpenGL Info for 
information on graphics hardware and the supported version of OpenGL.  

If your graphics hardware is older, you may experience compatibility issues with things such as transparency 
settings and anti-aliasing. The controls under the Settings node in this dialog allow you do such things as 
disabling transparency. The dialog box also provides information on disabling OpenGL.  

For more information on OpenGL in Origin, see the links under "Topics for Further Reading" at the end of this 
chapter.  

21.2 Customizing Menus 

21.2.1 Custom Menu Organizer 

 If you have scripts that are frequently run, you can add them to the menu for quick access. With the Custom 
Menu Organizer you can...  

• Create up to 3 main menus and corresponding sub-menus 

• Assign LabTalk scripts and X-Functions to a menu item 

• Restrict menu item access to specific window types 

• Hide unused built-in menu items, streamlining your Origin workspace 

To open the Custom Menu Organizer, choose Tools: Custom Menu Organizer... from the main menu. Then 

press F1 or click the button in the upper-right hand corner of the dialog box for instructions.  

Once you create and save a new menu configuration (.omc) file, you can then select that configuration from 
the Format: Menu fly-out menu. Multiple configuration files can be created, allowing you to easily switch from 
one configuration to another. A Default configuration is also available in the fly-out, to revert to default menu 
settings. Configuration files can also be shared with colleagues.  

21.2.2 Displaying Bitmaps in Menus 

 You'll note that form some menu commands, a bitmap is displayed to the left of the menu entry. The bitmap 
indicates that there is an equivalent toolbar button.  

 
On some systems such as VirtualPC or Terminal Servers, such bitmaps may cause a long delay when opening 
menus. To turn off the display of menu command bitmaps:  

1. Select Tools: Options to open the Options dialog box.  

2. Select the Miscellaneous tab, clear Display Bitmaps in Menus, and click OK. 
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21.3 Customizing Toolbars and Buttons 

In addition to the standard Windows OS toolbar customizations, Origin provides some clever and easy-to-use 
tools for creating, programming and distributing custom toolbar buttons. If you or your staff are performing 
complex but repetitive Origin routines, you'll want to explore creating and sharing custom toolbars.     

21.3.1 Displaying, Hiding or Moving Toolbar buttons 

• Click the small down arrow at the end of any toolbar and select the Add or Remove Buttons context 

menu. Then select desired sub menu and check/uncheck to show/hide buttons. A Reset option is also 

available. 

• Press ALT key and drag a button to any new toolbar location. 

• Press ALT key and drag a button to blank Origin workspace to create a new toolbar. 

• Press ALT key and drag a button to any window till X shows, then release to delete the toolbar. 

21.3.2 Customizing Toolbar Button Appearance 

Use controls on the Options tab (View:Toolbars) to:  

• Show toolbar screen tips and shortcut keys on hover 

• Increase toolbar and toolbar button size 

• Toggle between "flat" or 3D toolbar buttons 

21.3.3 Displaying or Hiding a Toolbar 

• Double click the left/top end of any docked toolbar to undock. Double-click on title of floating toolbar to 

dock. 

• In floating mode, click X button to hide the toolbar. Drag it to any new location to reposition. Drag it to 

edge of the Origin workspace to dock.  

• In docked mode, drag the left/top end of a toolbar to reposition. 

• To show/hide multiple toolbars together, choose View: Toolbars... from the main menu. Use the check 

boxes on Toolbars tab to show/hide toolbars. Click the New button to add a new toolbar, then drag 

buttons from the Button Groups tab to add buttons on the new toolbar. 

• Use the Reset, Reset All buttons to reset toolbars. 

21.3.4 Creating New Toolbars with New Bitmap Images 

 Origin supports creating new toolbar buttons with Labtalk script, both built-in or user-defined script to run 
when click it. Choose View: Toolbars... and create new button group on Button Group tab.  

• Origin ships with three button groups starting with User Defined... with a bunch of bitmap images.  

• Click any button and click Settings... button to link .ogs (Script) file section with the button. 

• Drag the button to Origin workspace to create toolbar button.  
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• If you are feeling really creative, Origin allows you to define a new button group that uses your own 16 

color, 16 x 16 pixel bitmaps. 

• Export the button group as an .OPX file and share it with others. The person who gets the OPX can drag 

and drop the OPX file onto Origin workspace to install the toolbar.  

Note: To learn more about creating and exporting user-defined toolbars, see:  

Help: Origin: Origin Help > Customization and Automation > Customizing Toolbars  

21.3.5 Add a Custom Button to the Window Title Bar 

 Origin supports adding a system button to the left of the minimize button on the window title bar. A custom 
LabTalk script can then be associated with this button.  

Note: Please view the -tbb option of the LabTalk Page command in the Programming help file:  

Help: Programming: LabTalk > Language Reference > Command Reference > Alphabetical 
Listing of Commands > Page  

21.4 Customizing the Status Bar 

Origin uses the Status bar at the bottom of the Origin workspace to report software hints, statistics and other 
useful information depending upon current action, selection, window, etc.  

• Right-click on Status Bar to customize the display. 

• Press ALT and drag items along the Status Bar to reorder. 

21.5 Customizing the Origin Workspace 

Origin also supports customizing dockable windows such as the Project Explorer, Quick Help and Messages 
Log windows.  

• Right click on the window title bar to specify dock, hide, auto hide, and other settings. 

• When auto-hide is unchecked, double click to float the window. 

• Drag the window title to move or dock to a new location. 

• Arrange dockable windows as multiple tabs along the edge of the workspace to save screen space. 

• Choose View: Toolbars... from main menu. On the Toolbar tab:  

o The Reinitialize button resets menu, toolbar and dockable windows to default settings.  

o The Export button exports the current menu, toolbar and dockable window settings to an .OPX 

file. Drag and drop the OPX file onto another Origin installation to configure the workspace to 

match your customized settings. 
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In Origin 2018, clicking the Reinitialize button produces an attention message asking 
if you want to restore the workspace settings from your previous version or use the 
2018 system defaults. 

21.6 Templates and Themes 

   

The hierarchy of Origin objects such as graph pages, combined with extensive object properties, lends itself to 
the creation of custom settings for repeat use. You can save your custom settings either as templates or 
themes, described briefly in the following sections.  

Note: For detailed information please refer to Origin Help file, see:  

Help: Origin: Origin Help > Origin Basics > Origin Template Files (OTW, OTP, OTM)  

21.6.1 Templates 

The Origin template concept applies to graphs, workbooks, matrix books, and Analysis Templates™. Templates 
allow you to choose a set of properties or operations and save those for repeat use.  

For instance, Origin ships with over 100 built-in graph templates that are used to create Origin’s many science 
and engineering graph types. Using one of these as a starting point, you can create your own graph, adding 
more layers, setting scale or dimensional relationships between layers, modifying data plot properties, etc., 
and then save your customizations as a user-defined graph template (.otp) file by clicking File: Save 
Template as....  

You cannot overwrite built-in templates (graph or otherwise). If you customize a template, then choose Save 
Template as… and attempt to overwrite the built-in template (by saving the file with the same name), the 
custom template will be saved to your User Files Folder (UFF). This UFF copy then takes the place of the 
built-in template and this template will be used when clicking the corresponding menu command or toolbar 
button. To reconnect a built-in template with these menu commands or toolbar buttons, you will need to 
delete (or remove) the customized template from your UFF.  

An important subset of graph templates are what are called “cloneable” templates. These templates display a 
“sheep” icon next to the template name or preview image. Please note, when the sheep icon is blue, it 
indicates that this cloneable template is applicable for current active workbook/matrix; in opposite, the gray 
sheep icon means this template is not suitable for current data selection. For more information, see the section 
on cloneable templates in Graph Template Basics in your Origin Help file.  

http://www.originlab.com/doc/Origin-Help/UserFilesFolder
http://www.originlab.com/doc/Origin-Help/Graph-Template-Basics
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The template concept extends to workbooks and matrices, as well. You can save workbook or matrix book 
settings, such as the number of columns and sheets, column plot designations, fonts, colors, display formats, 
custom header rows, scripts associated with the sheet, or dimension and coordinate settings, to .otw 
(workbook template) or .otm (matrix template) files.  

Another important Origin template concept is the Analysis Template™. Save data operations -- even complex 
operations such as curve fitting with resulting custom report sheets -- to an analysis template (.ogw or .opj) 
for repeat analysis with similar data. Analysis templates are explained in more detail in the Batch Analysis 
section of How to Handle Repetitive Tasks chapter of this guide.  

21.6.2 Themes 

 An Origin Theme is a file containing a set of object properties or dialog settings. Thus for example, the 
customized settings of a graph window can be saved as a Theme, or the customized settings in an analysis 
dialog can be saved as a Theme.  

A Graph Theme could be as simple as an axis tick mark direction setting, or as extensive as a collection of 
multiple graph object properties.  

Themes allow you to quickly apply a new set of properties to an object, such as a graph. For example, you 
might apply a black-and-white Theme to a color graph in order to prepare it for publication. Or you might take 
the object properties of one graph and apply them to all the other graphs in the same project.  

Right click on plot, layer, object, etc. in graph or right click with nothing selected in graph and choose Copy 
Format context menu to copy format. Depending where you right click, the corresponding selection's format 
can be copied. Then right-click on corresponding selection or right click in target graph and click Paste 
Format to apply the copied settings to the target selection or graph. You can also choose Edit: Paste 
Format... to paste the Format to multiple target graphs.  

http://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
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The Theme Organizer dialog box is available from the Tools menu. Use this dialog to organize graph, 
worksheet, and dialog themes. 

With this dialog you can apply a graph theme to multiple graphs to have consistent look. To combine multiple 
graph themes in the Theme Organizer dialog, hold down Ctrl while selecting the Themes, and then right-click 
to access the Combine context menu. The context menu in the tool provides an option to edit a Theme, 
allowing the user to add/delete properties to an existing theme. Set a theme as system theme will apply it to 
future newly created graphs automatically if the graph template allows system theme to override.  
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The Theme concept extends to dialog box settings, as well. For instance, you can choose a particular suite of 
settings in the Linear Fit dialog box (Analysis:Fitting:Linear Fitting), and then save those settings to disk 
as a named Theme file. You can save multiple Theme files for a given dialog box and then recall them from the 
dialog, as needed. Saving multiple Themes for a dialog box allows you to customize your analysis routines 
from different experiments, when each requires using a specific (and unique) group of settings.  
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Dialog themes are explained in more detail in the How to Handle Repetitive Tasks chapter of this guide.  

21.7 Topics for Further Reading 

• The 3D openGL Settings Dialog Box 

• Creating Custom Menus 

• The Custom Menu Organizer 

• Analysis Themes 

• How to Manage Multiple Menu Configuration (.OMC) Files 

• Managing Collapsible Menus 

• The User Files Folder 

 

http://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
http://www.originlab.com/doc/Origin-Help/GraphRef-3DOpenGL-Dialog
http://www.originlab.com/doc/Origin-Help/Create-Custom-Menus
http://www.originlab.com/doc/Origin-Help/CustomMenuOrganizer-Dialog
http://www.originlab.com/doc/Tutorials/AnalysisThemes
http://www.originlab.com/doc/Origin-Help/Manage-Multi-OMCFile
http://www.originlab.com/doc/Quick-Help/collapsible-menu
http://www.originlab.com/doc/Origin-Help/UserFilesFolder
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22 Sharing Origin Files 

 

You may want to customize some aspect of your Origin installation and then share your customizations with 
other Origin users. Custom settings can be saved in many file types including graph templates (.otpu) and 
themes (.oth), analysis templates (.ogwu or .opju), dialog themes, curve fitting functions, import wizard 
filters, LabTalk script files (.ogs), and X-Functions.  

22.1 Drag and Drop Sharing 

 A quick and easy way to share a file with another user is simply to send it as an email attachment. The 
recipient can then drag and drop the file into the Origin workspace.  

Drag-and-drop is supported for most Origin file types. Origin project (.opju) and graph template (.otpu) files 
automatically open when dropped into the workspace. Other files are copied to the appropriate subfolders in 
the User Files Folder (UFF). For example, when you drop a fitting function (.fdf) file into the workspace, a 
dialog opens asking how you want to categorize the new fitting function.  

22.2 Sharing Files with Multiple Machines for Single Users 

If you are a single user and have installed Origin on multiple machines, you can share your custom settings 
across multiple installations. Set up the User Files Folder (UFF) on a shared location, such as a network drive, 
or even a USB flash drive, and use the same UFF path with each installation.  
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Note: For information on changing the UFF path, see:  

Help: Origin: Origin Help > Customization and Automation > Setting Your Preferences > The 
User Files Folder  

22.3 Sharing Files with Other Users in a Network 

 You can set up and use a group folder to share files among users. Multiple groups are allowed, and each 
group can have some power user(s) set as the group leader. The group leader can use the Group Folder 
Manager tool to publish custom files for sharing with other group members. When group member launches 
Origin, the published files will be copied to their Origin automatically and ready to use.  

Note: For information on group folders, see:  

Help: Origin: Origin Help > Sharing Your Origin Files with Others > Sharing Files with 
Multiple Clients > Group Folder Manager  

22.4 Packaging Files 

 Origin provides a Package Manager tool for packing multiple files into a single Origin Package (.opx) file. 
This is a convenient way to distribute custom applications that may contain multiple Origin files, such as 
templates, X-Functions, and LabTalk script files. The Package Manager includes options for running LabTalk 
scripts before and after installation.  

To access the Package Manager, click Tools, and then click Package Manager...  

To install an .opx file, simply drag and drop into the Origin workspace.  

Note: For information on packaging files, see:  

Help: Origin: Origin Help > Sharing Your Origin Files with Others > Packaging Multiple Files 
as OPX  

22.5 The Origin Viewer 

The Origin Viewer is a freely distributed, standalone application that allows viewing and copying of 
information contained in Origin project files and window (graph, worksheet, matrix) files on computers that do 
not have Origin installed.  

• The Origin Viewer is distributed as a single EXE file - no installation needed. 

• Project Explorer-like folder view with graph previews on hover, icon or details windows views, X-large icon 

view option. 

• Open a graph in a pop-up window for better viewing. 

• Supports viewing and rotating Origin's OpenGL 3D graphs. 

• Available in 32- and 64-bit versions. 

If you have Origin graphs or data that you wish to share with colleagues who are not currently using Origin, 
you might direct them to the Origin Viewer page (www.originlab.com/viewer) where they can find out more 
and download the EXE.  

http://www.originlab.com/doc/Origin-Help/UserFilesFolder
http://www.originlab.com/doc/Origin-Help/UserFilesFolder
http://www.originlab.com/doc/Origin-Help/FileShare-GroupFolder
http://www.originlab.com/doc/Origin-Help/FileShare-Pack-OPX
http://www.originlab.com/doc/Origin-Help/FileShare-Pack-OPX
http://www.originlab.com/viewer/
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22.6 Topics for Further Reading 

• The User Files Folder 

• Attaching Files to the Origin Project 

• Package Manager 

• Setting Up a Group Folder 

• Exporting Custom Button Groups 

• Exporting Toolbar Settings 

• Apps for Origin 

http://www.originlab.com/doc/Origin-Help/UserFilesFolder
http://www.originlab.com/doc/Origin-Help/FileShare-Append-to-OPJ
http://www.originlab.com/doc/Origin-Help/FileShare-PackageManager
http://www.originlab.com/doc/Origin-Help/FileShare-GroupFolder-Location
http://www.originlab.com/doc/Origin-Help/Export-Button-Group
http://www.originlab.com/doc/Origin-Help/Export-Toolbar-Setting
http://www.originlab.com/doc/User-Guide/Apps
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23 Origin Toolbars 

This is a list of Origin toolbars, and buttons by button group. Toolbars are shown in their default 
configurations. You will note that some buttons are missing from default toolbar configurations. This may be 
because a button has been deprecated (e.g. Open Excel), because it is duplicated on another toolbar, or 
simply because it is a lesser-used button.  

To add or remove buttons from a toolbar:  

1. Click View: Toolbars to open the Customize dialog box. 

2. Click on the Button Groups tab and drag desired buttons to a toolbar or to an empty portion of the 

workspace.  

3. To remove a button/toolbar, drag it from the toolbar back to the Buttons list or click the small "x" in the 

upper right-corner of the toolbar (removes entire toolbar from the workspace). 

Note also that some toolbar buttons have a small downward pointing arrow next to them. Clicking the tool 
displayed on these "split buttons" carries out the action associated with the displayed tool. Clicking the arrow 
beside it opens a menu, allowing you to pick another tool. A split button displays the tool that was last used.  

Finally, toolbar buttons will be inaccessible (dimmed) if the object that they act on is not active. For instance, 
the 3D-Rotation Toolbar is only available when a 3D graph is active.  

23.1 Standard 

 

Button  Description  Hotkey  Button  Description  Hotkey  

 

New Project  
  

New Folder  
 

 

New Workbook  
  

New Excel  
 

 

New Graph  
  

New Matrix  
 

 

New Function  
  

New 2D (Function) 
Plot   

 

New 2D Parametric 
(Function) Plot    

New 3D (Function) 
Plot   

 

New 3D Parametric 
(Function) Plot    

New Layout  
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Button  Description  Hotkey  Button  Description  Hotkey  

 

New Notes  
  

Digitize Image  
 

 

Open  Ctrl+O  
 

Open Template  
 

 

Open Excel  
  

Import Excel  Ctrl+E  

 

Save Project  Ctrl+S  
 

Save Template  
 

 

Recalculate Auto  
  

Recalculate Manual  
 

 

Import Wizard  Ctrl+3  
 

Import Single ASCII  Ctrl+K  

 

Import Multiple ASCII  
  

Batch Processing  
 

 

Zoom In and Out by 
Percentage    

Print  
 

 

Slide Show of Graphs  
  

Send Graphs to 
PowerPoint   

 

Open Video Builder  
  

Refresh  F5  

 

Duplicate  
  

Custom Routine  
 

 

Project Explorer  Alt + 1  
 

Object Manager  Alt + 
8  

 

Results Log  Alt + 2  
 

Command Window  Alt + 
3  

 

Code Builder  Alt + 4  
 

Add New Columns  
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23.2 Import 

 

Button  Description  Hotkey  Button  Description  Hotkey  

 

Import Wizard  
  

Import Single ASCII  
 

 

Import Multiple ASCII  
  

Import Excel  
 

 

Re-import no Dialog  CTRL + 
4  

 

Re-import with Dialog  
 

 

Clone Import  
  

Batch Processing  
 

23.3 Edit 

 

Button  Description  Hotkey  Button  Description  Hotkey  

 

Cut  Ctrl+X  
 

Copy  Ctrl+C  

 

Paste  Ctrl+V  
 

Undo  Ctrl+Z  
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23.4 Graph 

 

Button  Description  Hotkey  Button  Description  Hotkey  

 

Enable/Disable Anti-
Aliasing    

Rescale  Ctrl+R  

 

Rescale X  
  

Rescale Y  
 

 

Rescale XY  
  

Rescale Z  
 

 

Exchange the X and Y 
axes    

Enable/Disable Speed 
Mode   

 

Extract to Layers  
  

Extract to Graphs  
 

 

Merge  
  

Duplicate with New Book  
 

 

Duplicate with New 
Sheet    

Duplicate with New 
Columns   

 

Add Bottom-X Left-Y 
Layer    

Add Top-X Layer  
 

 

Add Right-Y Layer  
  

Add Top-X Right-Y Layer  
 

 

Add Inset Graph  
  

Add Inset Graph With 
Data   

 

Zoom In  
  

Zoom Out  
 

 

Whole Page  
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23.5 2D Graphs 

 

Note that a few plot types do not have a toolbar button. The most complete list of 
Origin plot types is found on the Plot menu.  

 

Button  Description  Button  Description  

 

Line  
 

Horizontal Step  

 

Vertical Step  
 

Spline Connected  

 

Scatter  
 

Scatter Central  

 

Column Scatter  
 

Y Error  

 

X Y Error  
 

Vertical Drop Line  

 

Bubble  
 

Color Mapped  

 

Bubble + Color Mapped  
 

Line + Symbol  

 

Line Series  
 

2 Point Segment  

 

3 Point Segment  
 

Column  

 

Column + Label  
 

Grouped Column-Indexed Data  

 

Bar  
 

Stacked Column  
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Button  Description  Button  Description  

 

Stacked Bar  
 

100% Stacked Column  

 

100% Stacked Bar  
 

Floating Column  

 

Floating Bar  
 

3D Color Pie Chart  

 

2D B&W Pie Chart  
 

Double Y Axis  

 

3Ys Y-YY  
 

3Ys Y-Y-Y  

 

4Ys Y-YYY  
 

4Ys YY-YY  

 

Multiple Y Axes  
 

Stacked Lines By Y Offsets  

 

Waterfall  
 

Waterfall Y: Color Mapping  

 

Waterfall Z: Color Mapping  
 

3D Waterfall  

 

3D Waterfall Y: Color Mapping  
 

3D Waterfall Z: Color Mapping  

 

Vertical 2 Panel  
 

Horizontal 2 Panel  

 

4 Panel  
 

9 Panel  

 

Stack  
 

Multiple Panels by Label  

 

Trellis Plot  
 

Box Chart  



Origin Toolbars 

263 

Button  Description  Button  Description  

 

Grouped Box Charts-Indexed 
Data   

Grouped Box Charts-Raw Data  

 

Interval Plot  
 

Histogram  

 

Histogram + Probabilities  
 

Stacked Histograms  

 

Marginal Histograms  
 

Marginal Boxes  

 

2D Kernel Density  
 

QC(X-bar R) Chart  

 

Pareto Chart-Binned Data  
 

Pareto Chart-Raw Data  

 

Scatter Matrix  
 

Probability Plot  

 

Q-Q Plot  
 

Area  

 

Stack Area  
 

Fill Area  

 

Zoom  
 

Polar theta(X) r(Y)  

 

Polar r(X) theta(Y)  
 

Wind Rose-Binned Data  

 

Wind Rose-Raw Data  
 

Ternary  

 

Piper  
 

Smith Chart  

 

Radar  
 

Vector XYAM  
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Button  Description  Button  Description  

 

Vector XYXY  
 

High-Low-Close  

 

Japanese Candlestick  
 

OHLC Bar Chart  

 

OHLC-Volume  
 

Line (Stock)  

 

Template Library    

23.6 Add Object to Graph 

 

Button  Description  Hotkey  Button  Description  Hotkey  

 

Add Color Scale  
  

Reconstruct Legend  Ctrl+L  

 

Add Asterisk Bracket  
  

Add XY Scale  
 

 

Date & Time  
  

Project Path  
 

 

New Link Table  
  

Add Bubble Scale  
 

23.7 3D and Contour Graph 

 

Button  Description  Button  Description  

 

3D Scatter Plot  
 

3D Trajectory  
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Button  Description  Button  Description  

 

3D Scatter + Error Bar  
 

3D Vector XYZ XYZ  

 

3D Vector XYZ dXdYdZ  
 

3D Bars  

 

3D Stacked Bars  
 

3D 100% Stacked Bars  

 

XYY 3D Bars  
 

XYY 3D Stacked Bars  

 

XYY 3D 100% Stacked Bars  
 

3D Ribbons  

 

3D Walls  
 

3D Waterfall  

 

3D Waterfall Y: Color Mapping  
 

3D Waterfall Z: Color Mapping  

 

3D Color Fill Surface  
 

Multiple Color Fill Surfaces  

 

3D X Constant with Base  
 

3D Y Constant with Base  

 

3D Colormap Surface  
 

Multiple Colormap Surfaces  

 

3D Color Fill Surface with Error 
Bar   

3D Colormap Surface with Error 
Bar  

 

3D Wire Frame  
 

3D Wire Surface  

 

3D Colormap Surface with 
Projection   

3D Ternary Colormap Surface  

 

Contour - Color fill  
 

Contour - B/W Lines + Labels  
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Button  Description  Button  Description  

 

Gray Scale Map  
 

Contour Profiles  

 

Polar Contour theta(X) r(Y)  
 

Polar Contour r(X) theta(Y)  

 

Ternary Contour  
 

Image Plot  

 

Image Profiles  
 

Heat Map  

23.8 3D Rotation 

 

Button  Description  Button  Description  

 

Rotate counterclockwise  
 

Rotate clockwise  

 

Tilt left  
 

Tilt right  

 

Tilt down  
 

Tilt up  

 

Increase perspective  
 

Decrease perspective  

 

Fit frame to layer  
 

Reset Rotation  

 

Reset  
 

Rotate on any direction  

 

Rotation Angle    
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23.9 Worksheet Data 

 

Button  Description  Hotkey  Button  Description  Hotkey  

 

Statistics on Column(s)  
  

Statistics on Row(s)  
 

 

Sort  
  

Set Column Values  Ctrl+Q  

 

Set All Column Values  Ctrl+F5  
 

Row number  
 

 

Uniform random 
numbers    

Normal random 
numbers   

 

Add/Remove Data 
Filter    

Enable/Disable Data 
Filter   

 

Reapply Data Filter  
    

23.10 Column 

 

Button  Description  Button  Description  

 

Set as X  
 

Set as Y  

 

Set as Z  
 

Set as Y Error Bars  

 

Set as Labels  
 

Set as Disregard  

 

Set as Grouping  
 

Set as Subject  
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Button  Description  Button  Description  

 

Move to First  
 

Move Left  

 

Move Right  
 

Move to Last  

 

Swap Columns    

23.11 Layout 

 

Button  Description  Button  Description  

 

Add Graph  
 

Add Worksheet  

23.12 Mask 

 

Button  Description  Button  Description  

 

Mask Range  
 

Unmask Range  

 

Change mask color  
 

Hide/Show masked points  

 

Swap mask  
 

Disable/Enable masking  
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23.13 Tools 

 

Button  Description  Hotkey  Button  Description  Hotkey  

 

Pointer  
  

Scale In  
 

 

Scale Out  
  

Screen Reader  
 

 

Reader  
  

Annotation  
 

 

Data Cursor  
  

Data Selector  
 

 

Selection on Active 
Plot    

Selection on All 
Plots   

 

Mask Points on 
Active Plot    

Mask Points on All 
Plots   

 

Unmask Points on 
Active Plot    

Unmask Points on 
All Plots   

 

Draw Data  
  

Text Tool  
 

 

Arrow Tool  
  

Curved Arrow Tool  
 

 

Line Tool  
  

Polyline Tool  
 

 

Freehand Draw 
Tool    

Rectangle Tool  
 

 

Circle Tool  
  

Polygon Tool  
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Button  Description  Hotkey  Button  Description  Hotkey  

 

Region Tool  
  

Zoom-Panning Tool  Hold 
"A"  

 

Insert Equation  
  

Insert Word Object  
 

 

Insert Excel Object  
  

Insert Object  
 

 

Rescale Tool  Hold "Z": Zoom; 
Hold "X": Pan  

 

Rotate Tool  Hold 
"R"  

 

Insert Graph  
  

Insert Worksheet  
 

23.14 Object Edit 

 

Button  Description  Button  Description  

 

Left  
 

Right  

 

Top  
 

Bottom  

 

Vertical  
 

Horizontal  

 

Uniform Width  
 

Uniform Height  

 

Group  
 

Ungroup  

 

Distribute Selected Layers/Graphic 
Objects 

Evenly in Vertical Dimension   

Distribute Selected Layers/Graphic 
Objects 

Evenly in Horizontal Dimension  
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Button  Description  Button  Description  

 

Front  
 

Back  

 

Forward  
 

Backward  

 

Front(data)  
 

Back(data)  

23.15 Arrow 

 

Button  Description  Button  Description  

 

Horizontal Alignment  
 

Vertical Alignment  

 

Widen Head  
 

Narrow Head  

 

Lengthen Head  
 

Shorten Head  

23.16 Style 

 

Button  Description  Hotkey  Button  Description  Hotkey  

 

Fill Color  
  

Line/Border Color  
 

 

Lighting Control Dialog  
  

Palette  
 

 

Line/Border Style  
 

 

Line/Border Width  
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Button  Description  Hotkey  Button  Description  Hotkey  

 

Fill Pattern  
 

 

Fill Pattern Width  
 

 

Pattern Color  
  

Clear Borders  
 

 

Left Border  
  

Top Border  
 

 

Right Border  
  

Bottom Border  
 

 

Frame Borders  
  

Inside Horizontal 
Borders   

 

Inside Vertical Borders  
  

Inside Horiz and Vert 
Borders   

 

All Horizontal Borders  
  

All Vertical Borders  
 

 

All Borders  
  

Merge cells  Ctrl+R  

23.17 Format 

 

Button  Descriptio
n  Hotkey  Button  Description  Hotkey  

 

Font  
 

 

Font size  
 

 

Bold  Ctrl+"B"  
 

Italic  Ctrl+"I"  

 

Underlin
e  Ctrl+"U"  

 

Superscript  Ctrl+"+"  
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Button  Descriptio
n  Hotkey  Button  Description  Hotkey  

 

Subscrip
t  Ctrl+"="  

 

SuperSubscri
pt  Ctrl+"-"  

 

Increase 
Font  

Ctrl+">"  

Ctrl+Shift+
"."  

 

Decrease 
Font  

Ctrl+"<"  

Ctrl+Shift+
","  

 

Greek  Ctrl+"G"  
 

Left  
 

 

Center 
Horizont

al    

Right  
 

 

Top  
  

Center 
Vertical   

 

Bottom  
  

Font Color  
 

23.18 Auto Update 

 

Button  Description  

 

Block Auto Update  

23.19 Database Access 

 

Button  Description  Button  Description  

 

Open SQL Editor  
 

Open Query Builder  



Origin User Guide 

274 

Button  Description  Button  Description  

 

Load ODQ File  
 

Preview Import  

 

Import data  
 

Remove SQL  

23.20 Markers & Locks 

 

Button  Description  Hotkey  Button  Description  Hotkey  

 

Add Data Markers  Ctrl+Alt+M  
 

Clear Data Markers  Ctrl+Alt+N  

 

Marker Size  
  

Marker Hide Show  
 

 

Lock Positions  
    



 

275 

Index 
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2D Integration ................................................ 175 

3 

32- and 64-bit ................................................ 3, 4 

3D Graphing, Hardware Compatibility ......... 243, 245 

3D Surface Fitting ............................................. 13 

A 

AB? ........................................................... 43, 49 

ABF ........................................................... 43, 49 

Active Dataset ......................................... 179, 182 

Active Layer ..................................................... 93 

Add Plot to Layer........................................93, 105 

Analysis Markers ...................................... 179, 185 

Analysis Reports ...................................... 211, 218 

Analysis Templates ................ 53, 76, 211, 214, 218 

Analysis Themes ...................................... 243, 249 

Animating Graphs .................................... 225, 228 

Annotation Tool........................................ 159, 165 

ANOVA .................................................... 201, 206 

Apps for Origin................................................ 231 

Apps Gallery ............................................... 23, 31 

ASCII Data ....................................................... 43 

ASCII Data, Import to Graph .......................93, 107 

Auto Recalculate ............................................. 211 

Automating Origin .................................... 211, 223 

Automation Server, Origin as ............................ 237 

Axis Dialog Box ................................ 129, 132, 137 

B 

Batch Plotting .......................................... 211, 214 

Batch Processing ............................................. 211 

BDF ........................................................... 43, 49 

Binary 2D Array, Import ............................... 43, 49 

Binary Data ................................................ 43, 46 

BRUKER OPUS ................................................ 49 

Buttons, Adding Programmable to Origin Windows243, 247 

C 

CDF ........................................................... 43, 49 

CGM ........................................................... 43, 49 

Child Windows .................................................. 23 

Clipboard Data, Importing ............................ 43, 47 

Code Builder ............................................... 23, 37 

Collapsible Menus ........................................ 23, 25 

Column Label Rows, Worksheet ..................... 53, 58 

Column Plot Designations ........................... 93, 104 

Column Properties Dialog Box ............................ 53 

Column Values, Setting ................................ 53, 65 

Columns, Naming ........................................ 53, 54 

Command Window ....................................... 23, 34 

Concurrent Network ........................................ 3, 5 

Consulting ......................................................... 9 

Contour Profile ................................................ 175 

Convolution ............................................ 179, 197 

Coordinate Values, Reading/Annotating .............. 175 

Coordinates, Reading/Labeling .................. 159, 171 

Copy/Paste Graphs .................................. 225, 226 

CSV Files .................................................... 43, 46 

Curve Fit, Linear and Polynomial ................ 179, 192 

Curve Fit, Nonlinear ................................. 179, 193 

Curve Fitting ................................................... 175 

Custom Menu Organizer ........................... 243, 245 

Customizing Graphs ......................................... 129 

Customizing Menus .......................................... 243 

Customizing Origin ........................................... 243 

Customizing Origin, Global Settings ................... 243 

Customizing Toolbars and Buttons ............. 243, 246 

D 

DAT ........................................................... 43, 49 

Data Analysis .................................................. 179 

Data Cursor Tool ..................................... 159, 168 

Data Display ........................................... 159, 167 
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Data Filters for Repetitive Tasks ................. 211, 221 

Data Info Window .................................... 159, 169 

Data Markers ................................... 179, 184, 185 

Data Points, Deleting ................................ 179, 189 

Data Points, Drawing ................................ 179, 189 

Data Range ...................................................... 93 

Data Reader ............................................ 159, 167 

Data Reduction, Graphs ..............................93, 111 

Data Reduction, Worksheets ......................... 53, 75 

Datasets, Creating....................................... 53, 64 

DCF ........................................................... 43, 49 

Deactivate License .......................................... 3, 7 

Derivatives, Plot .............................................. 175 

Descriptive Statistics ................................ 175, 201 

Developer Kit .................................................. 237 

Dialog Box Themes ........................... 211, 212, 243 

Differentiation ................................................. 175 

Digitizing Scatter Plots ................................. 43, 50 

Drag and Drop Plotting ...............................93, 106 

Drag-and-Drop Origin File Sharing.............. 253, 254 

Drag-and-Drop, Importing by ....................... 43, 49 

DX ............................................................ 43, 49 

DX1 ........................................................... 43, 49 

E 

EarthProbe ................................................. 43, 49 

EDF ........................................................... 43, 49 

Embed Graphs, 3rd Party Applications ........ 225, 226 

Embed Graphs, Origin Templates ............... 211, 214 

EPA ........................................................... 43, 49 

ETAS INCA ................................................. 43, 49 

Excel ................. 23, 33, 43, 48, 129, 237, 240, 243 

Exporting a Matrix .................................... 225, 230 

Exporting Graphs/Layout Pages ................. 225, 227 

Exporting Worksheets ............................... 225, 229 

F 

Famos ....................................................... 43, 49 

FAQs ................................................................. 9 

FFT ................................................. 175, 179, 196 

File Types, Origin .............................................. 41 

Filtering, Signal Processing ....................... 179, 196 

FLEXnet ......................................................... 3, 5 

Full Menus .................................................. 23, 25 

Function Plots, 2D and 3D ............................. 93, 97 

G 

Gadgets......................... 13, 15, 159, 171, 175, 211 

Graph Gallery ................................................ 9, 11 

Graph Layer ................................................ 93, 99 

Graph Layer Frame ...................................... 93, 99 

Graph Page ................................................. 93, 99 

Graph Types ............................................. 93, 113 

Graphical Exploration of Data ............................ 159 

Graphical Exploration Tools, Annotation ...... 159, 169 

Graphical Exploration Tools, Data Cursor .... 159, 169 

Graphical Exploration Tools, Data Info Window159, 169 

Graphical Exploration Tools, Data Reader.... 159, 169 

Graphing ......................................................... 93 

Graphing Matrix Data ................................... 93, 96 

Graphing Virtual Matrix Data .............................. 93 

Graphing Worksheet Data .................................. 93 

Graphing, Functions ..................................... 93, 97 

Graphs, Add Data by Drag and Drop ................... 93 

Graphs, Add Plot to Layer .................................. 93 

Graphs, Adding or Removing Plots ............... 93, 105 

Graphs, Adding Text & Drawing Objects ..... 129, 144 

Graphs, Animating ................................... 225, 228 

Graphs, Cloning with New Data ................. 211, 215 

Graphs, Copy/Paste Format ........ 129, 156, 243, 249 

Graphs, Copy/Paste or Embedding ............. 225, 226 

Graphs, Creating .............................................. 93 

Graphs, Customizing Axes .......... 129, 132, 137, 139 

Graphs, Customizing Data Points ............... 129, 136 

Graphs, Customizing Grouped Plots ........... 129, 135 

Graphs, Direct ASCII Import .............................. 93 

Graphs, Distance Between Two Points ........ 159, 168 
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Graphs, Embed in Worksheets ...................... 53, 76 

Graphs, Exporting ........................................... 225 

Graphs, Extract to Graphs ......................... 129, 149 

Graphs, Extract to Layers .......................... 129, 149 

Graphs, Function ......................................... 93, 97 

Graphs, Grouping Plots ...................................... 93 

Graphs, Insert Equation ............................ 129, 145 

Graphs, Inset .................................... 129, 154–52 

Graphs, Labeling a Data Point .................... 129, 145 

Graphs, Layer Contents Dialog Box...............93, 106 

Graphs, Layer Customizations .................... 129, 133 

Graphs, Legend Customization ........... 129, 132, 139 

Graphs, Linking Axis Scales ....................... 129, 150 

Graphs, Listed by Type ....................... 93, 114, 124 

Graphs, Magnifying ......................................... 159 

Graphs, Merge ................................. 129, 132, 149 

Graphs, Panning ...................................... 159, 160 

Graphs, Plot Details .......................... 129, 132, 133 

Graphs, Reading Coordinate Values ............ 159, 165 

Graphs, Reorder Layers ............................ 129, 151 

Graphs, Rescaling ........................................... 159 

Graphs, Save Format as Theme ................. 129, 133 

Graphs, Saving Custom Templates ............. 129, 133 

Graphs, Scaling Objects ............................ 129, 147 

Graphs, Send to PowerPoint ...................... 225, 227 

Graphs, Slide Show .................................. 225, 228 

Graphs, Speed Mode...................................93, 111 

Graphs, Template Library .......................... 129, 133 

Graphs, Templates ................................... 129, 154 

Graphs, Theme Organizer.......................... 129, 156 

Graphs, Themes ................... 129, 156–55, 243, 249 

Graphs, Zooming ............................................ 159 

Group Folder Manager .............................. 253, 254 

Grouping Plots ...........................................93, 109 

H 

H5 ............................................................. 43, 49 

HDF5 .................................................... 43, 48, 49 

HE ............................................................. 43, 49 

HEKA ......................................................... 43, 49 

Help Files, Quick Help ................................... 23, 37 

Help Files, Updating ............................................ 9 

Hiding Worksheet Columns ........................... 53, 74 

Hints, Software ........................................... 23, 35 

How to Handle Repetitive Tasks ......................... 211 

HPF ............................................................ 43, 49 

HYP ............................................................ 43, 49 

I 

IBW ........................................................... 43, 49 

IgorPro ....................................................... 43, 49 

Image Processing ......................... 13, 15, 179, 199 

Image Profile .................................................. 175 

Image, Import............................................. 43, 49 

Images, Matrix ............................................ 79, 81 

Import Data ..................................................... 43 

Import Wizard ............................................. 43, 45 

Importing, Filter Files (OIF)................................ 41 

imzML ........................................................ 43, 49 

Inset Graph ....................................... 129, 154–52 

Installing and Updating Origin .............................. 3 

Installing Origin .................................................. 3 

Integration ..................................................... 175 

Interpolation ................................................... 175 

Introduction ....................................................... 1 

ISF ................................................................. 49 

J 

JCAMP ........................................................ 43, 48 

JCAMP-DX ................................................... 43, 49 

JCM ........................................................... 43, 49 

JDX ............................................................ 43, 49 

JNB ............................................................ 43, 49 

K 

KaleidaGraph .............................................. 43, 49 

L 

LabTalk .................................................. 237, 238 
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LabVIEW ........................................................ 237 

LabVIEW™ .............................................. 237, 240 

Layer Contents Dialog Box .................. 93, 106, 110 

Layer Icon, Graph ....................................... 93, 99 

Layers, Graph ............................................. 93, 99 
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